Preventing toll fraud

"Toll fraud" is the unauthorized use of your telecommunications system by an unauthorized party (for example, anyone who is not a corporate employee, agent, subcontractor, or person working on your company's behalf). Be aware that there may be a risk of toll fraud associated with your system and that, if toll fraud occurs, it can result in substantial additional charges for your telecommunications services.

Avaya fraud intervention

If you suspect that you are being victimized by toll fraud and you need technical assistance or support, call Technical Service Center Toll Fraud Intervention Hotline at +1-800-643-2353 for the United States and Canada. For additional support telephone numbers, see the Avaya Web site:

http://www.avaya.com/support

Providing telecommunications security

Telecommunications security (of voice, data, and video communications) is the prevention of any type of intrusion to (that is, either unauthorized or malicious access to or use of) your company's telecommunications equipment by some party.

Your company's "telecommunications equipment" includes both this Avaya product and any other voice/data/video equipment that could be accessed via this Avaya product (that is, "networked equipment").

An "outside party" is anyone who is not a corporate employee, agent, subcontractor, or person working on your company's behalf. Whereas, a "malicious party" is anyone (including someone who may be otherwise authorized) who accesses your telecommunications equipment with either malicious or mischievous intent.

Such intrusions may be either toll-through synchronous (time-multiplexed and/or circuit-based) or asynchronous (character-, message-, or packet-based) equipment or interfaces for reasons of:

- Use (of capabilities special to the accessed equipment)
- Theft (such as, of intellectual property, financial assets, or toll-facility access)
- Eavesdropping (privacy invasions to humans)
- Mischief (troubling, but apparently innocuous, tampering)
- Harm (such as harmful tampering, data loss or alteration, regardless of motive or intent)

Be aware that there may be a risk of unauthorized intrusions associated with your system and/or its networked equipment. Also realize that, if such an intrusion should occur, it could result in a variety of losses to your company (including, but not limited to, human and data privacy, intellectual property, material assets, financial resources, labor costs, and legal costs).

Your responsibility for your company's telecommunications security

The final responsibility for securing both this system and its networked equipment rests with you, an Avaya customer's system administrator, your telecommunications peers, and your managers. Base the fulfillment of your responsibility on acquired knowledge and resources from a variety of sources, including, but not limited to:

- Installation documents
- System administration documents
- Security documents
- Hardware/software-based security tools
- Shared information between you and your peers
- Telecommunications security experts

To prevent intrusions to your telecommunications equipment, you and your peers should carefully program and configure:

- Your Avaya-provided telecommunications systems and their interfaces
- Your Avaya-provided software applications, as well as their underlying hardware/software platforms and interfaces
- Any other equipment networked to your Avaya products.

Trademarks

Avaya is a trademark of Avaya Inc.

All non-Avaya trademarks are the property of their respective owners.
Contents

About this information product .................................................. 9

Chapter 1: Introduction ........................................................... 11
  What is Avaya IP Agent? ......................................................... 12
  New features for Avaya IP Agent, Release 5 ................................. 12
  Avaya IP Agent features ....................................................... 13
  Avaya IP Agent configurations ............................................... 17
  Road Warrior configuration (Voice-over-IP) ................................. 17
  Telecommuter configuration .................................................. 18
  IP Telephone configuration ................................................... 19
  CallMaster VI configuration (DCP connection) ............................ 19
  Avaya Telephone (IP and DCP) configuration ............................... 20
  Compatible telephone types for Avaya IP Agent ............................ 21
  Supported telephone types .................................................... 21
  Recommended telephone types ............................................... 24
  Network compatibility .......................................................... 25

Chapter 2: Installing Avaya IP Agent for PC-based configurations ..... 27
  Prerequisites ............................................................................. 28
  CD-ROM contents ..................................................................... 28
  Avaya communication server .................................................... 29
  Personal computer hardware ................................................... 30
  Personal computer software ..................................................... 31
  Voice-over-IP considerations ................................................... 33
  Troubleshooting Voice-over-IP .................................................. 34
  System descriptions for Voice-over-IP ........................................ 34
  Interactive installation ............................................................ 36
  Distributed installation information .......................................... 36
  Web-based installation information ......................................... 36
  Before you begin .................................................................... 37
  Installing Avaya IP Agent ......................................................... 37
  Silent installation ..................................................................... 43
  Before you begin ..................................................................... 43
  Command-line parameters ...................................................... 44
  Creating the silent installation response file ............................... 44
  Running a silent installation .................................................... 45
  Upgrades and reinstallation ...................................................... 47
## Chapter 5: Using enhanced configuration options

- Configuring the Emergency Call Handling Service ............................................. 91
- Administering the Avaya communication server for Emergency Call Handling .......... 92
- Administering Avaya IP Agent for Emergency Call Handling .............................. 93
- Configuring Avaya IP Agent for VPN configurations ........................................ 95
  - Steps .............................................................................................................. 95
- Installing the Quality of Service Packet Scheduler ............................................. 97
  - Before you begin .......................................................................................... 97
  - Steps for installing QoS for Windows 2000 ..................................................... 97
- Configuring Alternate Gatekeeper on Avaya communication servers ..................... 99
  - Alternate Gatekeeper configuration ................................................................ 99
- Configuring server load balancing across gatekeepers ........................................ 100
  - Load Balancing configuration ........................................................................ 100
  - Load Balancing documentation ...................................................................... 100

## Chapter 6: Running Avaya IP Agent

- Starting Avaya IP Agent ....................................................................................... 102
  - Steps for starting Avaya IP Agent .................................................................... 102
- Initializing IP Endpoint configurations ............................................................... 103
  - Steps .............................................................................................................. 103
- Initializing CallMaster VI configurations .......................................................... 112
- Registering with the Avaya communication server ............................................. 113
  - Before you begin .......................................................................................... 113
  - Setting default registration information ......................................................... 113
  - Steps for registering with an Avaya communication server ............................. 113
  - Registering while using a VPN ...................................................................... 115
- Logging in as an agent (EAS) ............................................................................ 117
  - Steps for logging in (EAS) ............................................................................. 117
- Logging in as an agent (non-EAS) .................................................................... 119
  - Before you begin .......................................................................................... 119
  - Steps for logging in (non-EAS) ...................................................................... 119
- Logging out of Avaya IP Agent .......................................................................... 121
  - Steps .............................................................................................................. 121
- Exiting Avaya IP Agent ...................................................................................... 122
  - Steps .............................................................................................................. 122
- Using alternate user interfaces ........................................................................... 123
  - AutoAnswer interface .................................................................................... 123
  - Mini interface ................................................................................................. 124
  - Titlebar interface ............................................................................................ 124
  - Selecting an alternate interface ....................................................................... 124
  - Accessing features .......................................................................................... 125
  - Returning to the main interface ...................................................................... 125
  - Removing alternate user interfaces .................................................................. 125
  -Renaming alternate user interfaces ................................................................... 125
Chapter 7: Avaya IP Agent basic operations ................................................. 127
  Selecting an agent work mode .............................................................. 128
  Definitions of agent work modes ......................................................... 128
  Changing work modes ............................................................................ 129
  Handling incoming calls ................................................................. 130
  Answering a call .................................................................................. 130
  Telecommuter (Auto-Answer) ................................................................. 131
  Road Warrior and CallMaster VI ............................................................ 132
  Road Warrior and CallMaster VI (Auto-Answer) ........................................ 132
  IP Telephone and Avaya Telephone ...................................................... 133
  Holding a call ....................................................................................... 134
  Using Manual Hold ............................................................................... 134
  Using Auto Hold .................................................................................. 134
  Reconnecting to a call on hold ............................................................ 134
  Releasing a call ................................................................................... 135
  Steps for releasing a call ....................................................................... 135
  Dropping a call .................................................................................... 136
  Transferring a call .............................................................................. 137
  Before you begin ................................................................................. 137
  Basic call transfer ............................................................................... 137
  Unsupervised call transfer .................................................................. 138
  Enhanced call transfer ......................................................................... 139
  Conferencing calls ............................................................................... 141
  Basic Conference .............................................................................. 141
  Enhanced Conference .......................................................................... 143
  Handling outgoing calls ....................................................................... 146
  Recent Calls list .................................................................................. 146
  Using the Phone Directory .................................................................. 147
  Administering and using Speed Dial ..................................................... 151
  Abbreviated Dial button ....................................................................... 153

Chapter 8: Agent Greetings ........................................................................ 155
  Creating agent greetings ...................................................................... 157
  Steps for creating an agent greeting ...................................................... 157
  Setting the active agent greeting ........................................................... 158
  Steps for setting an active agent greeting .............................................. 158
  Setting activation criteria for agent greetings ......................................... 159
  Steps for setting agent greeting activation criteria .................................. 159
  Deleting agent greetings ...................................................................... 160
  Steps for deleting an agent greeting ...................................................... 160

Chapter 9: Using VuStats ............................................................................ 161
  Configuring an extension for VuStats through the Avaya communication server ......................................................................................... 162
  Configuration ......................................................................................... 162
### Contents

#### Issue 1.1 August 2004

163

**Viewing a single set of VuStats information in Avaya IP Agent**

- **Before you begin**
- **Steps**

164

**Adjusting intervals for monitoring VuStats**

- **Before you begin**
- **Steps**

167

**Chapter 10: Using a Public Directory with Avaya IP Agent**

168

- **Defining a Public Directory service**
- **Steps for defining a Public Directory service**

170

- **Searching a Public Directory**
- **Steps for searching a Public Directory**

173

- **Selecting the fields to display and the order**
- **Steps for displaying Public Directory fields**

175

- **Identifying multiple telephone number fields**
- **Steps for identifying telephone number fields**

177

- **Deleting a Public Directory service**
- **Steps for deleting a Public Directory service**

179

**Chapter 11: Screen pops**

181

- **Creating a Windows application screen pop**
- **Steps for creating an application screen pop**

186

- **Creating a DDE screen pop**
- **Steps for creating a DDE screen pop**

191

- **Setting the active screen pop**
- **Steps for setting an active screen pop**

192

- **Modifying a screen pop**
- **Steps for modifying a screen pop**

193

- **Deleting a screen pop**
- **Steps for deleting a screen pop**

195

**Chapter 12: Dialog Reference**

196

- **Main window and menus**

204

- **Toolbars**

209

- **Information panels**

210

- **System Tray icon**

212

- **Avaya IP Agent option dialogs**

213

- **General Settings panel**

215

- **ACD Agent panel**

216

- **Call Handling panel**

217

- **Call History panel**

218

- **Call Information Display panel**

219

**Database Options panel**
About this information product

This document, Avaya IP Agent Installation and User Guide, includes information that you need to know in order to install and use Avaya IP Agent. It also provides information on Avaya IP Agent features, basic operation, and administrative tasks.

Reason for reissue
This is the first issue of this document for Avaya IP Agent R5.0.

Intended audience
This guide is intended for anyone who is installing or using Avaya IP Agent software and performing station administration on an Avaya DEFINITY R10 server, Avaya MultiVantage system, or Avaya Media Server using Avaya Communication Manager. It assumes that you are familiar with the following items:

- The personal computer on which Avaya IP Agent will be installed and run
- Standard Windows conventions and terminology
- Contact center configurations and operations

Conventions used
The following conventions are used in this document:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Boldface text</strong></td>
<td>Names of windows, dialog boxes, and keyboard keys; for example, the Name field is in the Properties dialog box.</td>
</tr>
<tr>
<td>Key + Key</td>
<td>Key combinations for which you must press and hold down one key and then press another key at the same time; for example, Ctrl+F4 means that you press the Ctrl key and the F4 key at the same time.</td>
</tr>
<tr>
<td><em>Italic text</em></td>
<td>Indicates references to other documents and for emphasis.</td>
</tr>
</tbody>
</table>
About this information product

Related documentation
The following documents can help you configure your Avaya communication server for use with Avaya IP Agent:

- DEFINITY Enterprise Communications System Administrator’s Guide
- Administrator’s Guide for Avaya MultiVantage Software
- Administrator’s Guide for Avaya Communication Manager

Ordering documentation
To order documents by telephone, contact Globalware Solutions through the following telephone numbers:

- Voice, within the United States: 1-800-457-1235
- Voice, international: 207 866 6701
- Fax, within the United States: 1-800-457-1764
- Fax, international: 207 626 7269

To order documents by mail, write to:

Globalware Solutions
200 Ward Hill Avenue
Haverhill, MA 01835
USA
Attention: Avaya Account Management
Chapter 1: Introduction

This chapter provides introductory and basic information about Avaya IP Agent. This chapter includes the following sections:

- **What is Avaya IP Agent?** on page 12
- **Avaya IP Agent configurations** on page 17
- **Compatible telephone types for Avaya IP Agent** on page 21
- **Network compatibility** on page 25
What is Avaya IP Agent?

Avaya IP Agent is a software application with advanced telephony features for agents in a contact center. Agents can use it to work in the following methods:

- On-site at the contact center
- On-site or off-site using Voice over Internet Protocol (VoIP)
- Off-site using analog connections over a Public Switched Telephone Network (PSTN)
- Through Windows Terminal Services.

The advanced telephony features are controlled by Avaya IP Agent through its direct communication with an Avaya communication server.

Agents who are not located at the contact center can connect to the Avaya communication server in the contact center and receive calls as if they were present at their contact center workstation. For example, if an agent cannot travel to the contact center because of transportation problems or weather conditions, the agent can still take calls by using Avaya IP Agent to connect to the Avaya communication server.

This section contains the following topics:

- New features for Avaya IP Agent, Release 5 on page 12
- Avaya IP Agent features on page 13

New features for Avaya IP Agent, Release 5

The following is a list of the new features for Avaya IP Agent:

- Silent installation - You can now create an installation script that allows you to install subsequent installations of Avaya IP Agent without user interaction. If you use a network management system, such as Microsoft SMS® or Hewlett-Packard OpenView®, you can combine the silent installation with the functionality of these products to distribute Avaya IP Agent.

- Windows Terminal Services compatibility - Those contact centers that use Windows Terminal Services can now use a special version of Avaya IP Agent to facilitate usage of the Telecommuter configuration in that environment.

- Avaya Telephone-IP configuration - Using this new configuration, agents can use Avaya IP Agent as a direct interface to their physical 4600-series IP telephones. While the Avaya Telephone-IP configuration is similar to the Telecommuter configuration, it cannot use a telephone number that is different from the extension. You need only one defined station on the Avaya communication server, instead of the two required by the Telecommuter configuration. This feature is available for those contact centers using Avaya Communication Manager 2.1 or later.
What is Avaya IP Agent?

- Avaya Telephone-DCP configuration - Using this new configuration, agents can use Avaya IP Agent as a direct interface to their physical Avaya 2400-series or 6400-series Digital Communication Protocol (DCP) telephone. While the Avaya Telephone-DCP configuration is similar to the Telecommuter configuration, it cannot use a telephone number that is different from the extension. However, with the Avaya Telephone-DCP configuration, you need only one defined station on your Avaya communication server, instead of the two required by the Telecommuter configuration. This feature is available for those contact centers using Avaya Communication Manager 2.0 or later.

- Media encryption - The Avaya iClarity IP Audio component of Avaya IP Agent now encrypts communication between itself and the Avaya communication server. This provides a new level of security in communications conducted over your contact center network.

- User-to-user information (UUI) screen pop enhancement - Using external applications, unique identifiers can be added to incoming calls. If your Avaya communication server has the correct features and configuration, these identifiers can be passed to Avaya IP Agent and used in screen pops for agents.

- Network-resident agent greetings - Agent greetings can now be stored on network drives.

- Agent greetings in the Telecommuter configuration - With the Avaya Switcher II headset, which connects to both a DCP telephone and a PC, contact centers using the Telecommuter configuration can now use agent greetings.

Avaya IP Agent features

The following lists provide the main features that are available in Avaya IP Agent:

Available configurations and supported communication servers

- Support of Avaya DEFINITY R10, MultiVantage, and Communication Manager systems.

- Road Warrior configuration (Voice-over-IP) - Agents can connect to the Avaya communication server by using their personal computer and an IP network connection. In this configuration, a telephone set is not necessary because all communication is performed through the sound card of the personal computer.

- Telecommuter configuration - Agents using an analog or Digital Communication Protocol (DCP) telephone can use the advanced call features provided by the Avaya communication server. For example, an agent working from home can use Avaya IP Agent and their home telephone to transfer calls, place calls on hold, change agent work mode, and do other call center activities.

- Avaya CallMaster VI configuration - Avaya IP Agent supports usage of Avaya CallMaster VI telephones. Sections of this document address configuration and usage of Avaya CallMaster VI telephones.
Introduction

- IP Telephone configuration - Agents using an IP telephone can use Avaya IP Agent in the same manner as with the Telecommuter configuration. Features that are assigned to the extension can be used through the Avaya IP Agent user interface. In this configuration, Avaya IP Agent logs in to the telephone itself.

- Avaya Telephone-DCP configuration - Agents using a Digital Communication Protocol (DCP) telephone in the contact center can use Avaya IP Agent to share control of the telephone and its features. This configuration, unlike the Telecommuter configuration, does not require the creation of a second station on the Avaya communication server. This configuration is supported with Avaya Communication Manager 2.1 or later.

- Avaya Telephone-IP configuration - Agents using an IP telephone in the contact center can use Avaya IP Agent to shared control of the IP telephone and its feature. In this configuration, Avaya IP Agent logs in to the communication server, not the telephone as in the IP Telephone configuration.

Call and contact center features

- VuStats support - Avaya IP Agent can display multiple lines of VuStats information in the VuStats dialog box. You can use VuStats information to assist in complete monitoring of the contact center.

- Agent greetings - Agents can record and configure multiple agent greetings based on such variables as login status, agent work mode, agent ID, prompted digits, Automatic Number Identification (ANI), or Vector Directory Number (VDN).

- Support for dynamic Quality of Service (QoS) - If the QoS parameters have not been configured on the PC for an IP Endpoint configuration, Avaya IP Agent downloads the QoS parameters configured on the Avaya communication server and configures the IP Endpoint. To use QoS on Windows 2000, you must install the QoS Packet Scheduler from the Windows 2000 installation. QoS is automatically installed by Avaya IP Agent on Windows XP.

- Emergency Call Handling Service (E911) - With this feature, agents using IP Endpoints can use numbers that connect to emergency services, such as 911 in the United States. Only those emergency services in the Public Safety Answering Point area where the Avaya communication server is located can be reached. Agents or extensions in remote locations should not use this feature for emergencies.

- External Number Formatting - For international users, Avaya IP Agent allows you to define how many digits are present in telephone numbers outside the contact center.

Contact management features

- Call history - Avaya IP Agent records a complete call history of incoming and outgoing calls, even for those calls that were missed because where the caller does not leave a voice message.

- Telephone directory - Avaya IP Agent provides a customizable telephone directory that lists physical addresses, multiple telephone numbers, speed-dial numbers, e-mail addresses, and notes for each contact.
• Search Public Directory - With this feature, agents have the ability to search through public or company information using the Lightweight Directory Access Protocol (LDAP).

• Screen Pops - Screen Pops can be initiated when a call is received or placed. Avaya IP Agent provides agents with the ability to display Web pages, start applications, or retrieve and display caller information from a database. Screen pops are created using the Screen Pops Wizard, which guides you through their creation. A screen pop can consist of any process or application that can be initiated through one of the commands in the following list:
  - Windows executable or registered file type activation
  - Dynamic Data Exchange (DDE) "Execute" or "Poke" commands

Usability features

• Clipboard dialing - Avaya IP Agent can be used to dial any number copied to the clipboard or, in most personal computer applications, used to dial a number that an agent highlights by right-clicking on the Avaya IP Agent icon in the System Tray.

• Enhanced Phone features - The Phone Features window includes adding, renaming, and deleting of folders.

• Enhanced System Tray icon - The Avaya IP Agent icon in the System Tray contains release, drop, hold, transfer, conference, and agent work mode functions.

• Automatic login - An agent can automatically log in to the Avaya communication server when Avaya IP Agent is started. Avaya IP Agent uses the login information from the previous login.

• Speed dialer - Agents can assign telephone numbers to function keys (F2 through F8).

• Voice message icon - When voice messages are present for the extension currently in use, an icon is displayed in the System Tray. When it has been configured, you can click on this icon to connect to your voice mail system.

• Alternate user interfaces - These interfaces can be used in place of the standard interface. These alternate interfaces use much less space on your desktop, and then can eliminate the problem of the previous Avaya IP Agent interface being hidden behind other applications or requiring too much space on the desktop.

Security and management features

• Feature deactivation - Administrators can deactivate Avaya IP Agent features that should not be configured or used by agents. The features that can be deactivated include Screen Pops, Screen Pop administration, Phone Directory, Public Search Directory, Call History, Phone Features configuration, Personal Phone Features, Program Options, and Agent Greeting selection.

• Configurable database location - You can change the location where the Avaya IP Agent database is stored. This database contains the telephone directory and the call history information.
Introduction

- Support for Virtual Private Networks (VPNs) - The Avaya iClarity IP Audio component supports substitution of SHIM-based IPSec client addresses for the local IP address within H.323 signalling messages.

- Alternate Gatekeeper - When an agent registers an IP Endpoint with an Avaya communication server, a C-LAN circuit pack IP address is sent by the server to the IP Endpoint. If registration is successful, the Avaya communication server sends back the IP addresses of all the C-LAN circuit packs in the network region. These addresses can be used if call signaling on the original C-LAN circuit pack fails.

- Support for server load balancing across gatekeepers - Registration and usage of Avaya communication servers can be distributed across multiple C-LAN circuit packs within a network region. This increases performance and reliability for all IP Endpoints.

- Application updates - This feature can be used to search for updates to Avaya IP Agent. During each start of Avaya IP Agent, the Uniform Resource Locator (URL) address specified is searched. If an update is found, it is installed. This feature saves time and effort for administrators because they do not need to visit each installation or create remote administration scripts through third-party applications.
Avaya IP Agent configurations

Avaya IP Agent supports the following configurations:

- Road Warrior configuration (Voice-over-IP) on page 17
- Telecommuter configuration on page 18
- IP Telephone configuration on page 19
- CallMaster VI configuration (DCP connection) on page 19
- Avaya Telephone (IP and DCP) configuration on page 20

Road Warrior configuration (Voice-over-IP)

Use the Road Warrior configuration in situations where an agent at a personal computer can make a dial-up or network connection to an Avaya communication server. This configuration does not use a telephone, which, obviously, is valuable when a telephone is not available. All of the features of the Avaya communication server are available to the agent through this type of connection. The single network connection between the personal computer running Avaya IP Agent and the Avaya communication server has two channels, one for signaling (data) and one for voice. Avaya IP Agent controls the data flow while the iClarity IP Audio (an H.323 V2-compliant audio application) handles voice communications. This type of configuration provides the best IP audio quality that is possible with your connection speeds, personal computer performance, and network setup. Agents make and receive calls through the Avaya IP Agent interface using a headset connected to the personal computer.

What you need to know about Road Warrior configuration

The following is a list of the Road Warrior configuration requirements and capabilities:

- Connection - One dial-up or network connection from the personal computer running Avaya IP Agent to the Avaya communication server
- Personal computer hardware
  - Sound card (full-duplex recommended)
  - Modem or network interface card for connectivity to the Avaya communication server
  - Universal Serial Bus (USB) headset (recommended)

Note:

For detailed information on supported hardware, see the listings for IP Softphone at http://support.avaya.com.
Introduction

- Telephone - Not supported in this configuration
- Voice quality - Dependent on the performance of the personal computer hardware, the amount of bandwidth available in the network connection, and network stability
- Agent greetings - Stored on the personal computer
- Avaya communication server connections - One user connection

**Note:** Voice-over-IP does not necessarily provide *toll-quality* audio.

---

**Telecommuter configuration**

Use the Telecommuter configuration in situations where a personal computer can make a dial-up or network connection to an Avaya communication server for the signaling (data) path and a voice path to a telephone sent through a Public Switched Telephone Network (PSTN) connection. The telephone can be an analog telephone, a cellular telephone, or an extension on a local or remote switch. This configuration provides toll-quality audio and full telephony functionality through Avaya IP Agent. Agents make and receive calls through the Avaya IP Agent interface, and the voice path is sent to the specified telephone.

**What you need to know about the Telecommuter configuration**

The following is a list of the Telecommuter configuration requirements and capabilities:

- Connection - One dial-up or network connection from the personal computer running Avaya IP Agent to the Avaya communication server and a telephone capable of receiving calls from the Avaya communication server
- Personal computer hardware - Modem or Network Interface Card (NIC) for connection to the Avaya communication server
- Telephone set - Any telephone capable of receiving calls from the Avaya communication server
- Voice Quality - High
- Agent Greetings - Supported only through the use of the Avaya Switcher II headset
- Avaya communication server connections - One user connection for signaling connection and one of the following:
  - For off-site use, one trunk connection
  - For on-site use, an additional user connection
IP Telephone configuration

The IP Telephone configuration is similar to that of the Telecommuter configuration. Through IP Agent, agents can control an IP telephone, use the features of the telephone through the IP Agent interface, and take advantage of the regular IP Agent features.

What you need to know about the IP Telephone configuration

The following is a list of the IP Telephone configuration requirements and capabilities:

- **Connection** - IP network connection for the IP telephone and a TCP/IP network connection for the personal computer
- **Personal computer hardware** - Network Interface Card (NIC) for connection to the Avaya communication server
- **Telephone set** - Any Avaya IP telephone that supports the Computer Telephony Integration (CTI) feature and is supported by your Avaya communication server
- **Voice Quality** - Dependent on the IP telephone, available network bandwidth, and network stability
- **Agent Greetings** - Not supported in this configuration
- **Avaya communication server connections** - One user connection

CallMaster VI configuration (DCP connection)

The Avaya CallMaster VI is a small telephone with eight buttons, two headset jacks, and DCP (Digital Communications Protocol) connectivity. This telephone is connected to a personal computer through a serial (RS-232) connection. This configuration is for use only inside the contact center in conjunction with CallMaster telephones. Connectivity for this configuration is provided through a DCP connection to the Avaya communication server and does not require a TCP/IP network connection.

What you need to know about the CallMaster VI configuration

The following list provides Avaya CallMaster VI configuration requirements and capabilities:

- **Connection** - DCP connection for the Avaya CallMaster VI telephone set and a serial (RS-232) connection between the Avaya CallMaster VI and the personal computer
- **Personal computer hardware** - Serial (RS-232) port
- **Telephone** - Avaya CallMaster VI
- **Voice quality** - High
Introduction

- Agent greetings - Stored on the Avaya CallMaster VI telephone set
- Avaya communication server connections - One user connection

---

Avaya Telephone (IP and DCP) configuration

The Avaya Telephone configuration allows you to use Avaya IP Agent as a direct interface to your extension. Unlike the Telecommuter configuration, you cannot use analog telephones or alternate extension numbers in this configuration. Also, there is no need to define a second extension on the Avaya communication server in this configuration. Another advantage of this configuration is that if the PC is not operational, the extension still functions normally without Avaya IP Agent. This configuration is useful for those environments where an agent is the only person assigned to an extension and never has the need to work from an off-site location.

What you need to know about the Avaya Telephone configuration

The following is a list of the Avaya Telephone configuration requirements and capabilities:

- Connection - One network connection from the personal computer running Avaya IP Agent to the Avaya Communication Manager system 2.0 (DCP), 2.1 (IP), or later and a DCP or IP telephone that is connected to the Avaya Communication Manager system
- Personal computer hardware - Network Interface Card (NIC) for connection to the Avaya communication server
- Telephone set - An Avaya 2400-series (DCP), 4600-series (IP), or 6400-series (DCP) telephone
- Voice Quality - High
- Agent greetings - Not supported in this configuration
- Avaya communication server connections - One user connection
Compatible telephone types for Avaya IP Agent

This section contains the following topics:

- **Supported telephone types** on page 21
- **Recommended telephone types** on page 24

## Supported telephone types

**Note:**
When you change telephone types for a station, you must restart Avaya IP Agent for the change to take effect.

The following table provides the telephone types that are available on the Avaya communication server and officially supported for use with IP Agent:

<table>
<thead>
<tr>
<th>Telephone model</th>
<th>Communication platform</th>
<th>Additional features</th>
</tr>
</thead>
<tbody>
<tr>
<td>CallMaster (602A1)</td>
<td>DCP</td>
<td>● 80-character (2x40) display</td>
</tr>
<tr>
<td>CallMaster II (603D1)</td>
<td>DCP</td>
<td>● 80-character (2x40) display</td>
</tr>
<tr>
<td>CallMaster III (603E1)</td>
<td>DCP</td>
<td>● 80-character (2x40) display</td>
</tr>
<tr>
<td>CallMaster IV (603F1)</td>
<td>DCP</td>
<td>● 80-character (2x40) display</td>
</tr>
<tr>
<td>CallMaster V (607A1)</td>
<td>DCP</td>
<td>● 48-character display</td>
</tr>
<tr>
<td>CallMaster VI (606A1)</td>
<td>DCP</td>
<td>● 80-character (2x40) display</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Expansion module available</td>
</tr>
<tr>
<td>2402</td>
<td>DCP</td>
<td>● 48-character display</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Compatible with Avaya Telephone-DCP configuration</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Supported with Avaya Communication Manager 2.1 or later</td>
</tr>
<tr>
<td>2420</td>
<td>DCP</td>
<td>● 203-character display</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Expansion module available</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Compatible with the Avaya Telephone-DCP configuration</td>
</tr>
</tbody>
</table>
### Introduction

<table>
<thead>
<tr>
<th>Telephone model</th>
<th>Communication platform</th>
<th>Additional features</th>
</tr>
</thead>
</table>
| 4602            | IP                     | ● 40-character display  
|                 |                        | ● To use this telephone, you must administer it on the Avaya communication server with the IP Telephone configuration. To register this telephone with Avaya Communication Manager 2.1 or later, select the **Control of Avaya Telephone (via the server)** configuration option. This telephone is not supported for Avaya Communication Manager 2.0 or earlier.  
|                 |                        | ● This telephone cannot be used in the IP Telephone configuration. |
| 4606            | IP                     | ● 32-character display  
|                 |                        | ● Use of this telephone with the Avaya Telephone-IP configuration requires Avaya Communication Manager 2.1 or later. |
| 4610            | IP                     | ● 168x80 pixel display  
|                 |                        | ● Supported only on Avaya Communication Manager 2.1 or later. |
| 4612            | IP                     | ● 48-character display  
|                 |                        | ● Use of this telephone with the Avaya Telephone-IP configuration requires Avaya Communication Manager 2.1 or later. |
| 4620            | IP                     | ● 168x132 pixel display  
|                 |                        | ● Expansion module available  
|                 |                        | ● Use of this telephone with the Avaya Telephone-IP configuration requires Avaya Communication Manager 2.1 or later. |
| 4624            | IP                     | ● 48-character display  
|                 |                        | ● Use of this telephone with the Avaya Telephone-IP configuration requires Avaya Communication Manager 2.1 or later. |
## Compatible telephone types for Avaya IP Agent

<table>
<thead>
<tr>
<th>Telephone model</th>
<th>Communication platform</th>
<th>Additional features</th>
</tr>
</thead>
</table>
| 4630            | IP                     | ● 320x240 pixel display  
                   |                        | ● Use of this telephone with the Avaya Telephone-IP configuration requires Avaya Communication Manager 2.1 or later. |
| 6402D           | DCP                    | ● 32-character (2x16) display |
| 6408D / 6408D+  | DCP                    | ● 48-character display  
                   |                        | ● Compatible with Avaya Telephone-DCP configuration |
| 6416D+          | DCP                    | ● 48-character display  
                   |                        | ● Expansion module available  
                   |                        | ● Compatible with Avaya Telephone-DCP configuration |
| 6424D+          | DCP                    | ● 48-character display  
                   |                        | ● Expansion module available  
                   |                        | ● Compatible with Avaya Telephone-DCP configuration |
| 8405D / 8405D+  | DCP                    | ● 48-character display  
                   |                        | ● This telephone cannot be used with the Avaya Telephone-DCP configuration. |
| 8410D           | DCP                    | ● 48-character display  
                   |                        | ● This telephone cannot be used with the Avaya Telephone-DCP configuration. |
| 8411D           | DCP                    | ● 48-character display  
                   |                        | ● For this telephone set, you must disable the data port, which is true for all softphones  
                   |                        | ● This telephone cannot be used with the Avaya Telephone-DCP configuration. |
| 8434D           | DCP                    | ● 80-character (2x40) display  
                   |                        | ● Expansion module available  
                   |                        | ● This telephone cannot be used with the Avaya Telephone-DCP configuration. |
Recommended telephone types

While Avaya IP Agent supports all of the telephone types listed in the previous table for the Road Warrior and Telecommuter configurations, the following types provide the most buttons and features, and an 80-character display:

- 606A1
- 8434D

Because of the greater number of characters used for display, these telephone types are better suited to handle VuStats or Prompted Digits information.

**Note:**
For the IP Telephone and Avaya Telephone configurations, these telephone types are only valid for use if these exact stations are in use at the location of the agent.
Network compatibility

Avaya IP Agent provides support for several H.323-compatible firewalls and Virtual Private Networks (VPNs). For shim-based VPNs, you must use the Advanced tab in the Avaya iClarity IP Audio dialog boxes used for login to set an IPSec IP address, that is assigned by the VPN gateway and that is visible to the application on the personal computer. If you need assistance, contact Avaya technical support.

The VPN solution provided by Avaya iClarity IP Audio only supports VPNs that use one-to-one IP address substitution. VPNs that use many-to-one IP address substitution cannot be used with Avaya IP Agent.
Chapter 2: Installing Avaya IP Agent for PC-based configurations

This section contains procedures and important information for installing and uninstalling Avaya IP Agent on a PC.

This section includes the following topics:

- **Prerequisites** on page 28
- **Voice-over-IP considerations** on page 33
- **Interactive installation** on page 36
- **Silent installation** on page 43
- **Upgrades and reinstallation** on page 47
- **Uninstalling Avaya IP Agent** on page 50
Prerequisites

This section provides information on the necessary hardware and software for successful installation and usage of Avaya IP Agent.

This section contains the minimum or recommended requirements for the following:

- **CD-ROM contents** on page 28
- **Avaya communication server** on page 29
- **Personal computer hardware** on page 30
- **Personal computer software** on page 31

CD-ROM contents

The Avaya IP Agent CD-ROM contains the following items:

- Avaya IP Agent installation program
- Avaya IP Agent program files
- Documentation in PDF format - Adobe Acrobat® Reader 5.0 or later is required to view PDF documents.
- A readme.txt file containing last minute information
Avaya communication server

The following table shows the Avaya communication servers that can be used with Avaya IP Agent:

<table>
<thead>
<tr>
<th>IP Endpoint</th>
<th>CallMaster VI</th>
</tr>
</thead>
<tbody>
<tr>
<td>● Avaya communication servers with Avaya Communication Manager software</td>
<td>● Avaya communication servers with Avaya Communication Manager software</td>
</tr>
<tr>
<td>● Avaya communication servers with Avaya MultiVantage software</td>
<td>● Avaya communication servers with Avaya MultiVantage software</td>
</tr>
<tr>
<td>● DEFINITY Enterprise Communication System (ECS) R10</td>
<td>● DEFINITY ECS R6</td>
</tr>
<tr>
<td>● DEFINITY IP 600 R10</td>
<td></td>
</tr>
<tr>
<td>● DEFINITY ONE R10</td>
<td></td>
</tr>
<tr>
<td>● DEFINITY Business Communications System (BCS) R10 (Road Warrior and Telecommuter configurations only)</td>
<td></td>
</tr>
<tr>
<td>● DEFINITY Guestworks R10 (Road Warrior and Telecommuter configurations only)</td>
<td></td>
</tr>
</tbody>
</table>

Note:
The Avaya Telephone configuration can be used only with Avaya Communication Manager 2.1 or later.

Depending on the endpoint configuration being used, Avaya IP Agent requires the following additional components on the Avaya communication server:

● Telecommuter and Avaya Telephone-DCP - A Control LAN Circuit Pack (C-LAN) circuit pack (TN799B or later)

● Road Warrior (VoIP), IP Telephone, and Avaya Telephone-IP - A Control LAN Circuit Pack (C-LAN) circuit pack (TN799B or later) and an IP Media Processor (TN2302AP) circuit pack

● Avaya CallMaster VI - No extra components required
Personal computer hardware

The following topics present the minimum personal computer hardware requirements for Avaya IP Agent:

Processor

An x86-based processor rated at 300 MHz or faster is required. For Road Warrior (VoIP) configurations, a minimum of a 400 MHz processor is required. See Voice-over-IP considerations on page 33 for more information regarding hardware resources.

Hard disk space

Avaya IP Agent requires a minimum of 30 MB. Avaya IP Agent can require more hard disk space, depending on the amount of data stored for the phone directory, call history, agent greetings, and screen pops.

RAM

The following table shows the memory requirements for the Avaya IP Agent configurations and the supported operating systems:

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Windows 2000</th>
<th>Windows XP</th>
</tr>
</thead>
<tbody>
<tr>
<td>Road Warrior (VoIP) Telecommuter</td>
<td>128 MB</td>
<td>256 MB</td>
</tr>
<tr>
<td>IP Telephone</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Avaya Telephone-IP</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Avaya Telephone-DCP</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CallMaster VI</td>
<td>64 MB</td>
<td>64 MB</td>
</tr>
</tbody>
</table>

Audio

Road Warrior (VoIP) configurations require a sound card and one of the following hardware configurations:

● Headset with integrated microphone
● PC speakers and microphone

For maximum voice quality, Avaya recommends that you use a sound card that supports full-duplex operation. Use of a headset or Universal Serial Bus (USB) headset provides higher voice quality than that of simply using speakers and a microphone connected to your personal computer.
For a list of the sound cards and headsets supported by Avaya IP Agent, use the Search feature on the Avaya support Web site at http://support.avaya.com

⚠️ Important:
Only the Road Warrior (VoIP) configuration supports the use of a microphone through the personal computer.

Networking

The following list provides the network requirements for each configuration type:

- Road Warrior (VoIP) configurations - A single network connection between the personal computer and the Avaya communication server
- Telecommuter configurations - One network connection and one telephone connection (DCP or analog)
- IP Telephone and Avaya Telephone-IP configurations - One network connection for the personal computer and one network connection for the IP telephone
- Avaya Telephone-DCP configurations - One network connection and one DCP telephone connection (2400-series or 6400-series telephones)
- Avaya CallMaster VI configurations - A Digital Communications Protocol (DCP) connection to the Avaya communication server and a serial (RS-232) connection between the personal computer and the Avaya CallMaster VI telephone

Tip:
Avaya provides Avaya IP Voice Quality Network Requirements as an in-depth and informative document that defines and describes all aspects of networking and how those aspects can affect Voice-over-IP communications. You can retrieve this document from the following address:

Peripherals

The following peripherals are required for installation and use of Avaya IP Agent:

- CD-ROM drive for installation
- Mouse or compatible pointing device

Personal computer software

Avaya IP Agent requires the following software:

- One of the following Microsoft Windows operating systems:
Installing Avaya IP Agent for PC-based configurations

- *Windows 2000 Professional* with Service Pack 2
- *Windows XP Professional* with Service Pack 1

⚠️ **Important:**

The integrated firewall of *Windows XP* must be disabled for Avaya iClarity IP Audio to function.

- *Microsoft Internet Explorer 5.5* or later

⚠️ **Important:**

*Microsoft Windows 2000 Advanced Server* and *Windows 2000 Datacenter Server* are not supported.
Voice-over-IP considerations

Voice communication through Internet Protocol requires consistent, non-restrictive network bandwidth as well as the personal computer hardware sufficient to support not only the communications of the agent but also other tasks being performed on the personal computer. If you experience problems with Avaya IP Agent Voice-over-IP telephony, you should ensure that network and personal computer resources are adequate for the tasks being performed. Consider the topics in this section when you are determining the efficiency of Voice-over-IP in your contact center.

Real-time processing

Voice-over-IP uses real-time processing on your personal computer to transmit voice communication. Nearly all other processes on a personal computer use sequential processing which means that requests for system resources are processed as they become available. If resources are not available to process Voice-over-IP actions, the quality of the communication degrades.

Network bandwidth

Network bandwidth availability can also have an impact on Voice-over-IP communications. The codecs used for Voice-over-IP encoding can vary from using small packets for dial-up connections with reduced voice quality to using larger packets providing higher voice quality over broadband and high-speed connections.

Tip:

Avaya provides the Avaya IP Voice Quality Network Requirements as an in-depth and informative document that defines and describes all aspects of networking and how those aspects can affect Voice-over-IP communications. You can retrieve this document from the following address:


PC hardware and software

The personal computer software and hardware requirements in this document are the absolute minimum needed for operation. These minimum requirements do not take any tasks, applications, or other actions that may be occurring on the personal computer into account. If you experience problems with Voice-over-IP beyond those of configuration errors, most can be solved by upgrading the personal computer or using one with higher specifications.

Note:

Voice-over-IP does not guarantee toll-quality audio. This is affected by numerous variables including the codec used, network bandwidth availability, personal computer processing capabilities, sound card, network lag and packet loss, and many others.
Installing Avaya IP Agent for PC-based configurations

The following information describes personal computer considerations that are related to Voice-over-IP communications. Avaya recommends that you validate your network configuration against the Avaya IP Voice Quality Network Requirements. Additionally, Avaya provides network assessment services to determine if your network can support Voice-over-IP communications.

Troubleshooting Voice-over-IP

The speed of a processor is a consideration when you are troubleshooting Voice-over-IP difficulties. However, architecture must also be considered. Both Intel® and AMD® have produced economical processors for small businesses and home users that, while rated at comparable speeds to the higher-priced models, have reduced on-chip memory (L1/L2 cache). This affects real-time processing which, in turn, affects Voice-over-IP communications. Additionally, some chip sets have been created that include specialized instruction sets that optimize specific types of applications and processes. These include speech processing.

If you are experiencing problems with Voice-over-IP communications with Avaya IP Agent, Avaya recommends using a system with higher specifications for the following items.

- Processor speed
- On-chip memory (L1 or L2 cache)
- System Bus speed

Note: Avaya IP Agent does not officially support Cyrix™ processors.

System descriptions for Voice-over-IP

The following system descriptions provide guidelines for determining whether higher system requirements are necessary for Voice-over-IP communications.

Important:
If your system more closely resembles the moderate- or high-demand systems, an upgrade from the minimum requirements for the Voice-over-IP configuration is recommended.

Specific requirements for each type of system cannot be given because RAM, processor speed, system bus speed, on-chip memory, sound cards, network bandwidth, and applications in usage are all variables that can range widely in impact.

High demand - A high-demand system is a personal computer that uses processor-intensive applications.
The following list presents some examples of activities and applications that are used in a high-demand system:

- Multiple, CPU-intensive applications running simultaneously
- Database queries or hosting
- Multimedia applications
- Computer-Assisted Drafting (CAD) applications
- Compilers
- Streaming media

**Moderate demand** - A moderate-demand system is a personal computer that sometimes uses applications normally found in an office environment.

The following list presents some examples of activities and applications that are used in a moderate-demand system:

- Word processors
- Spreadsheets
- Web browsing
- Data entry
- General e-mail

**Low demand** - A low-demand system is a personal computer that rarely uses any applications apart from Avaya IP Agent.

The following list presents some examples of activities and applications that are used in a low-demand system:

- Text e-mail
- Simple web browsing (no streaming media)
- Minimal data entry
Interactive installation

This section provides the procedure for installing Avaya IP Agent and using the Configuration Wizard to enter Avaya communication server registration information on a personal computer.

This section contains the following topics:

- Distributed installation information on page 36
- Web-based installation information on page 36
- Before you begin on page 37
- Installing Avaya IP Agent on page 37

Distributed installation information

If you want to install Avaya IP Agent on personal computers that are not equipped with a CD-ROM drive, you can copy the contents of the CD-ROM to a network location using another personal computer. Running the install program from the network does not alter the installation procedure.

Additionally, if you are using network management software, such as Microsoft® Systems Management Server (SMS) or Hewlett-Packard® OpenView, you can deploy Avaya IP Agent using a combination of the Avaya IP Agent silent install feature and the remote execution capability of your management software.

Web-based installation information

The Avaya IP Agent product CD-ROM includes a single-file executable that will install Avaya IP Agent from a centralized Web server. You can find this file, setup.exe, in one of the following folders:

- \Setup\web install\ for PC-based installations
- \TSSetup\web install\ for Windows Terminal Services installations

If you place this file on an internal Web server, desktop users can run the installation program by navigating to a URL or by selecting a hyperlink. This file contains a signed certificate from Avaya that ensures the executable file is an Avaya distributed product. Depending on Web browser security settings, a dialog box regarding this certificate may be displayed during installation. Select Yes in this dialog box to continue the installation process. Running the install program from a Web server does not alter the installation procedure.
Before you begin

Before you attempt to install Avaya IP Agent, ensure that you do the following tasks:

- Close all applications.
- Insert the Avaya IP Agent CD-ROM in the CD-ROM drive.
- Read the readme.txt file in the root directory of the Avaya IP Agent CD-ROM.
- If you are upgrading Avaya IP Agent, you should ensure that you have obtained new licenses for this version on your DEFINITY, MultiVantage, or Communication Manager system. If you have not done so or are unsure, contact your Avaya representative for assistance.

Installing Avaya IP Agent

To install Avaya IP Agent:

1. If the Avaya IP Agent installation program did not begin after the CD-ROM was inserted, run the Launcher.exe file in the root directory of the CD-ROM.
   The installation program displays the setup selection window.
2. Next to IP Agent Setup, select the Install button.
   The installation program displays the Welcome window.
3. Select the Next button.
   The installation program displays the Software License Agreement window.
4. Read the entire Software License Agreement carefully and select the **Yes** button if you understand and agree to the terms. Selecting **No** causes the installation program to exit.

The installation program displays the **Select Configuration** window.

5. Select one of the following options:

   - **Important:**
     
     If you are reinstalling Avaya IP Agent, the Endpoint previously configured on the personal computer is selected by default.

   - **IP Endpoint** - Use this option for LAN and dial-up connections.

   - **CallMaster VI Endpoint** - Use this option for personal computers connected through a serial connection to an Avaya CallMaster VI terminal.

   **Note:**
   
   This **CallMaster VI Endpoint** option is valid only for those contact centers using Avaya CallMaster VI terminals with the 606A1 telephone type on the Avaya communication server. This also requires that the PC Application Software Translation Exchange (PASTE) customer option on the Avaya communication server is enabled.

6. Select the **Next** button.
7. If you selected **IP Endpoint** in the previous step, Avaya IP Agent displays the **IP Endpoint Options** window. If you are performing an Avaya CallMaster VI installation, skip to Step 8.

Place a check mark in the options you want to use:

- **Enable support for Auto-Answer** - Selecting this option allows Avaya IP Agent to automatically answer calls received at a station or extension. The **Auto-Answer** feature requires that Avaya communication server configuration for this station is also set for auto-answer. Failure to have this option set in both Avaya IP Agent and the Avaya communication server can result in problems during agent login or when agents answer incoming calls. The agent does not have to interact with a telephone set or Avaya IP Agent to talk to the other party on a newly received call.

- **Share Station Login information between users** - Selecting this option uses the same Avaya communication server registration information, such as extension number and password, regardless of the user IDs used to log on to this personal computer. If you leave this check box blank, each user of this personal computer must enter Avaya communication server registration information.

For IP Endpoint configurations, proceed to step 9.

8. If you selected the **CallMaster VI Endpoint** configuration, the install program displays the **Provide PASTE Feature Access Code** window. The PC Application Software Translation Exchange (PASTE) is an Avaya communication server feature that uses the Avaya CallMaster VI terminal to pass software translation information to Avaya IP Agent.

Enter the PASTE Feature Access Code in the provided field. If you do not know the PASTE Feature Access Code, leave this field blank. You can enter this code at a later time through the **Program Options** dialog box.

You can find the PASTE Feature Access Code in the Feature Access Code (FAC) form on the Avaya communication server. For more information on the PASTE Feature Access Code, see the documentation for your Avaya communication server.

9. Select the **Next** button.

The installation program displays the **Choose Destination Location** window.

10. If you want to install Avaya IP Agent in a folder other than the default, click the **Browse** button in the **Destination Folder** dialog box and select a new location.

11. When you are satisfied with the folder in which Avaya IP Agent will be installed, select the **Next** button.

The installation program displays the **Setup Type** window.

12. In the **Setup Type** window, select one of the following options and then select the **Next** button:

- **Typical** - This option installs the basic options in English as well as in the language of your Microsoft Windows operating system. Proceed to step 19.
Installing Avaya IP Agent for PC-based configurations

- **Custom** - This option installs the basic options in English as well as in any language you choose. Selecting this option and then the Next button will display the Select Language Components window where you specify the software language components to install. Proceed to the next step.

13. Indicate the language components to install by selecting the check box next to the option.

When selecting the language components to install, ensure that the Space Required does not exceed the Space Available, which is indicated at the bottom of the window.

14. Select the Next button.

The installation program displays the Select Program Folder window.

15. Use the Select Program Folder window to specify the folder name that will appear in the Start Menu. Select one of the following methods:

- Accept the default Avaya IP Agent folder name that appears in the Program Folders field.
- Enter a different folder name in the Program Folders field.
- Select an existing folder in the Existing Folders field in which to install the Avaya IP Agent Start menu shortcuts.

16. Select the Next button.

The installation program displays the Software Update Feature window.
Note:

If you are upgrading from R4, do not use the same configuration file address for Avaya IP Agent R5. Create a new area with a new configuration file.

17. If you want to use the software update feature to search for patches and updates for Avaya IP Agent on your internal network, place a check mark in the Enable software update using HTTP check box.

18. In the Address field, enter the Uniform Resource Locator (URL) address where the Avaya IP Agent configuration file will be stored. For more information about this feature, see General Settings panel on page 213.

19. Select the Next button.

The installation program displays the Shortcut and Startup Features window.

20. Select the associated check boxes for the shortcuts you want the system to create.

Note:

If you select a shortcut location, but do not select a language, the install program displays a warning indicating that you need to select at least one or more languages.

21. If you selected one of the check boxes on the upper portion of this dialog box, ensure that one of the languages in the field, Select the languages you would like to have added, is highlighted.

22. If you want Avaya IP Agent to run automatically when Microsoft Windows is started, select the Automatically start the following version of Avaya IP Agent when Windows is started check box and then select the language from the drop-down list.

Note:

You must establish a connection to your corporate network before logging in to the Avaya communication server with Avaya IP Agent. If you are using a dial-up modem with a dynamically assigned IP address, do not select this option.

23. Select the Next button.

The installation program displays the Start Copying Files window.

This window displays the options that you selected. If you need to make any changes to the selections you made, select the Back button until you reach the necessary window.

Note:

If you are recording selections for a silent installation, the Setup Mode item displays Record.

24. When you are satisfied with the specified options, select the Next button.

The install program begins copying files. When this process is complete, the View the Release Information File window is displayed.
25. Select the check box provided in the **View the Release Information File** window to view the latest information for Avaya IP Agent that was not available to be included in this document.

26. Select the **Next** button.

   If you selected to view the Release Information, the installation program displays the *readme.txt* file. Otherwise, proceed to Step 28.

27. When you have read the *readme.txt* file, close the application displaying it.

   The installation program displays the final installation window.

28. Select the **Finish** button.

   The installation program closes.

**Note:**

In some situations, conditions exist at the end of the installation process where you must restart your personal computer before you can begin using Avaya IP Agent. In these cases, the installation program will display a message stating that the system must be restarted.
Silent installation

The silent installation feature allows you to record a script, called a response file, that contains the options you select in a normal installation. After the response file has been created, it can be used with the installation program to set up Avaya IP Agent on PCs without any user interaction.

This section contains the following topics:

- Before you begin on page 43
- Command-line parameters on page 44
- Creating the silent installation response file on page 44
- Running a silent installation on page 45

Before you begin

Read and understand the following items before you attempt to use the silent installation feature:

- You cannot install different configurations (IP Endpoint and CallMaster) through a single response file. If you need to install different configurations, you must have a separate response file for each type of configuration.

- By default, the response file is saved to the main Windows program directory (%windir%).

- Do not attempt to record a response file by running Setup.exe from a location where you do not have write permission. However, through the use of the /f1 command-line parameters, you can specify a different location for the response file.

- You can rename the response file without consequence. By default, the installation script is named setup.iss. For silent install to use the renamed file, you must use the /f1 directory\filename parameters.

- A log file is created when silent install is run with a response file. If you are having multiple PCs run the silent install from the same location, the log file is overwritten with each installation. A solution to this problem is to have the silent install write the log file to the C: drive of each PC.

- Silent install can be run using Universal Naming Convention (UNC) locations. For example, if you copy the \Setup folder to a network location so that multiple PCs can access it, you can use an execution path similar to the following path: \\
\server\resource\Avaya IP Agent\Setup\Setup.exe /s

- Do not use a response file from a fresh installation for conducting upgrades on other PCs. Create a separate response file from the upgrade procedure.
Command-line parameters

The following table displays the silent installation feature parameters that allow you to record a response file and to change the names and locations of the response file and log file.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/f1 path\filename</td>
<td>Specifies a different directory location and filename for the response file.</td>
</tr>
<tr>
<td>/f2 path\filename</td>
<td>Specifies a different directory location and filename for the log file. This file is created when the /s parameter is used.</td>
</tr>
<tr>
<td>/r</td>
<td>Specifies that the installation program must record all user interactions to a response file.</td>
</tr>
<tr>
<td>/s</td>
<td>Specifies that the installation program must use a response file to conduct a silent installation. If your response file has a name other than setup.iss or is located in a different directory than Setup.exe, you must use the /f1 parameter in conjunction with this parameter.</td>
</tr>
</tbody>
</table>

Example of recording a response file

The following example would record a response file with a specific directory and filename:

```
\server\resource\Setup\Setup.exe /r /f1 "C:\temp\callmstr.iss"
```

Example of silent install with specific response and log files

The following example would use a response file other than setup.iss and create a log file of this installation on the C: drive:

```
"C:\temp\Avaya IP Agent\Setup.exe" /s /f1 "\server\resource\myfile.iss" /f2 "c:\myfile.log"
```

Creating the silent installation response file

To record a response file for silent installation:

1. Insert the Avaya IP Agent CD-ROM in the CD-ROM drive.
   - The Avaya IP Agent installation program starts.
2. Close the initial setup selection window.

3. Copy the Setup folder and its contents to your PC or to a network directory.

4. Open a command prompt. This can be done through one of the following methods:
   - Open the Start menu, select Run, enter cmd, and select the OK button.
   - Select the Command Prompt item under Programs > Accessories in the Start menu.

5. Using the Command Prompt window, navigate to the location where you copied the Avaya IP Agent Setup folder. Use the drive letter (x:) and change directory (cd) commands to change to that location. If you are unfamiliar with command-line usage, see the Windows online help that is located on your Start menu and search for Command Reference.

6. Once you have navigated into the Setup folder, enter the following command and press the Enter key.

   Setup.exe /r

   This command starts the Avaya IP Agent installation. The /r parameter notifies the installation program to record all selections made during the installation process to the response file.

   **Important:**
   To ensure that your selections are being recorded, look at the Start Copying Files window. If the Setup Mode item displays record, your silent install recording is active and working properly.

7. Following the procedure found in Interactive installation on page 36, select the appropriate options to complete the Avaya IP Agent installation for your configuration.

   All selections made during installation are saved to the response file, setup.iss. This file is saved to the same folder where Setup.exe resides. To save this file to a different location or to change the name of the file, see Command-line parameters in this section for information on the /f1 parameter.

---

**Running a silent installation**

After you have created a response file, you can run a silent installation:

1. From the target PC, open a command prompt window.

2. Using the Command Prompt window, navigate to the location where the Avaya IP Agent Setup folder is located.
3. After you have navigated into the Setup folder, enter the following command and press the Enter key:

   \texttt{Setup.exe /s}

   If you need to specify a response file other than setup.iss, add the /f1 parameter with the location and filename of the response file.

   Avaya IP Agent is installed without any notification on the target PC.

   By default, a log file is created where Setup.exe is located. If you need to specify a different location for the log file, use the /f2 directory\filename parameters in conjunction with the /s parameter.
Upgrades and reinstallation

This section provides information for installing Avaya IP Agent over a previous version of Avaya IP Agent, such as V1, V1.1, V2, V3, R4, or CentreVu Agent.

This section contains the following topics:

- Upgrading CentreVu IP Agent V1.X to Avaya IP Agent R5 on page 47
- Upgrading CentreVu IP Agent V2 to Avaya IP Agent R5 on page 48
- Upgrading Avaya IP Agent V3,R4 to R5 on page 48
- Upgrading CentreVu Agent to Avaya IP Agent R5 on page 49
- Reinstalling Avaya IP Agent R5 on page 49
- Applying product updates on page 49

Upgrading CentreVu IP Agent V1.X to Avaya IP Agent R5

This section provides information on upgrading CentreVu IP Agent V1.X to Avaya IP Agent R5.

The installation procedure for upgrading to Avaya IP Agent is the same as listed in Interactive installation on page 36 except for the following:

- You cannot change the installation directory for Avaya IP Agent.
- If you select to not store information for multiple users during installation and multiple users were used previously, Avaya IP Agent will only migrate the application data for the user performing the update.

Data migration

The following list describes how customizable data is effected when upgrading Avaya IP Agent:

- Call history - The call history is completely migrated during an upgrade.
- Phone directory - The phone directory is completely migrated during an upgrade.
- Program options - The settings you have configured for previous versions are completely migrated during an upgrade.
- Public search directory - LDAP servers and the associated settings are completely migrated during an upgrade.
- Screen pops - Screen pops are not migrated automatically during an upgrade. You must recreate your screen pops manually in Avaya IP Agent. However, once you have...
recreated the screen pops on one personal computer, you can export this information using the File > Export option from the menu bar and then import it into the remaining Avaya IP Agent personal computers.

- Personalized phone labels - If you changed the name of a feature listed in the Phone Features or Personal Phone Features, these names cannot be saved during an upgrade. You will need to rename these features in Avaya IP Agent R5.

- Personal phone features - Any features copied to the Personal Phone Features window are not saved during an upgrade. These entries must be manually copied to this window in Avaya IP Agent R5.

For Avaya CallMaster VI configurations, Avaya IP Agent R5 does not import the previous PASTE information. Avaya IP Agent R5 will download the PASTE information from the Avaya communication server when it is run for the first time.

---

**Upgrading CentreVu IP Agent V2 to Avaya IP Agent R5**

This section provides information on upgrading CentreVu IP Agent V2 to Avaya IP Agent R5.

**Data migration**

The installation procedure for upgrading to Avaya IP Agent is the same as listed in Interactive installation on page 36 except for the following:

- All data and settings used in CentreVu IP Agent V2 are migrated to Avaya IP Agent R5.

- The installation directory for CentreVu IP Agent is changed to Avaya IP Agent.

- If you select to not store information for multiple users during installation and multiple users were used previously, Avaya IP Agent will only migrate the application data for the user performing the upgrade.

---

**Upgrading Avaya IP Agent V3,R4 to R5**

This section provides information on upgrading Avaya IP Agent V3 or R4 to R5.

**Data migration**

The installation procedure for upgrading to Avaya IP Agent is the same as listed in Interactive installation on page 36 except for the following:

- All data and settings used in Avaya IP Agent V3 and R4 are migrated to Avaya IP Agent R5.
● If you select to not store information for multiple users during installation and multiple users were used previously, Avaya IP Agent will only migrate the application data for the user performing the upgrade.

---

Upgrading CentreVu Agent to Avaya IP Agent R5

This section provides information on upgrading CentreVu Agent to Avaya IP Agent.

Data migration

The installation procedure for upgrading to Avaya IP Agent is the same as listed in Interactive installation on page 36 except for the following:

● No data or settings are migrated from CentreVu Agent to Avaya IP Agent.

● CentreVu Agent must be uninstalled before Avaya IP Agent can be installed. This uninstall will be initiated during the installation of Avaya IP Agent and will be carried out upon receiving your confirmation.

---

Reinstalling Avaya IP Agent R5

This section provides information for reinstalling or upgrading to a later release of Avaya IP Agent R5.

When you are reinstalling Avaya IP Agent, the current endpoint configuration of the previous version is automatically selected. Other than this difference, the installation procedure is the same as listed in Interactive installation on page 36.

---

Applying product updates

The Product Update feature of Avaya IP Agent is used to search for version updates each time Avaya IP Agent is started. See General Settings panel on page 213 for information on this feature and how to use it.
Uninstalling Avaya IP Agent

This section explains how to uninstall Avaya IP Agent. The uninstall program removes all files and directories that were created during the installation of Avaya IP Agent.

Introduction

You can uninstall Avaya IP Agent using the Windows Add/Remove Programs feature. Read-only folders that are shared with other applications are not removed. If you have added any files or directories to the Avaya IP Agent installation directory, those files will not be removed.

The uninstall program removes:

- All installed Avaya IP Agent files, including all language versions
- Folders created by the Avaya IP Agent installation
- Log files created by Avaya IP Agent
- The iClarity IP Audio component

Steps for uninstalling Avaya IP Agent

To uninstall the Avaya IP Agent application from Windows 2000 or Windows XP:

1. Close Avaya IP Agent if it is currently running.
2. In the Windows Control Panel, select Add/Remove Programs.
   Windows displays the Add/Remove Programs dialog box.
3. In the Currently installed programs list box, highlight Avaya IP Agent.
4. Select the Change/Remove button.
   InstallShield displays a message box asking you to confirm that Avaya IP Agent should be removed.
5. Select the Yes button to start the uninstall process.
   InstallShield displays a message box asking if you want to preserve user data.
6. Select one of the following buttons regarding preservation of user data:
   - Yes - Selecting this option saves all user data and settings so that a reinstallation of Avaya IP Agent retains the same configuration.
• **No** - Selecting this option removes all Avaya IP Agent user data from the personal computer.

    When the uninstall process is complete, a window containing a successful message is displayed.

7. Select the **Finish** button to complete the uninstall process.

8. Close the **Add/Remove Programs** dialog box.
Installing Avaya IP Agent for PC-based configurations
Chapter 3: Installing Avaya IP Agent for Windows Terminal Services

This section contains procedures and important information for installing and uninstalling Avaya IP Agent in a Microsoft Windows Terminal Services environment.

Contact centers that use Windows Terminal Services or Citrix MetaFrame XP can implement Avaya IP Agent to provide agents with enhanced call features and a computer telephone interface to their extension. Avaya IP Agent can be used only in the Telecommuter mode in this environment.

This section includes the following topics:

- Prerequisites on page 54
- Installing Avaya IP Agent on Windows Terminal Services on page 57
- Reinstalling Avaya IP Agent for Windows Terminal Services on page 60
- Uninstalling Avaya IP Agent for Windows Terminal Services on page 61
Prerequisites

This section provides information on the necessary hardware and software for successful installation and use of Avaya IP Agent.

This section contains the minimum or recommended requirements for the following:

● CD-ROM contents on page 54
● Avaya communication server on page 54
● Server hardware on page 55
● Server software on page 56

CD-ROM contents

The Avaya IP Agent CD-ROM contains the following:

● Avaya IP Agent installation program
● Avaya IP Agent program files
● Documentation in PDF format - Adobe Acrobat® Reader 5.0 or later is required to view.PDF documents.
● A readme.txt file containing last minute information

Avaya communication server

The following Avaya communication servers can be used:

● Avaya communication servers with Avaya Communication Manager software
● Avaya communication servers with Avaya MultiVantage software
● DEFINITY Enterprise Communication Server (ECS) R10 (R6 or later for CallMaster VI configurations)
● DEFINITY IP 600 R10
● DEFINITY ONE R10
● DEFINITY Business Communications System (BCS) R10
● DEFINITY Guestworks R10
For the Windows Terminal Services implementation of Avaya IP Agent, the Avaya communication server must have one or more of the following component:

- A Control LAN Circuit Pack (C-LAN) circuit pack (TN799B or later)

### Server hardware

The following topics present minimum server hardware requirements for Avaya IP Agent:

#### Processor

The minimum requirements for Windows Terminal Services are sufficient for Avaya IP Agent to run properly.

#### Hard disk space

Avaya IP Agent requires a minimum of 30 MB per user installation. Avaya IP Agent can require more hard disk space, depending on the amount of data stored for the phone directory, call history, and screen pops.

#### RAM

The following table provides the minimum memory requirements for the Windows Terminal Services version of Avaya IP Agent:

<table>
<thead>
<tr>
<th>Server operating system</th>
<th>Memory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 2000 Server</td>
<td>128 MB</td>
</tr>
<tr>
<td>Windows 2000 Advanced Server</td>
<td></td>
</tr>
<tr>
<td>Windows 2003 Server - Standard Edition</td>
<td></td>
</tr>
<tr>
<td>Windows 2003 Server - Enterprise Edition</td>
<td></td>
</tr>
</tbody>
</table>

#### Networking

The desktop workstation must have one network (non-dialup) connection and one telephone connection (DCP or analog).

#### Peripherals

The following peripherals are required for installation and use of Avaya IP Agent:

- CD-ROM drive for initially accessing the product installation
- Mouse or compatible pointing device
Installing Avaya IP Agent for Windows Terminal Services

Note:
If you are using the minimum hardware requirements for Windows Terminal Services, you may experience a degradation in performance when several users are simultaneously registered with the server.

Server software

Avaya IP Agent requires the following software:

- One of the following Microsoft Windows operating systems with Windows Terminal Services:
  - Windows 2000 Server
  - Windows 2000 Advanced Server
- Microsoft Internet Explorer 5.5 or later

Note:
Avaya IP Agent for Windows Terminal Services is also compatible with Citrix® MetaFrame XP Release 3.2.
Installing Avaya IP Agent on Windows Terminal Services

This section provides information and procedures for installing Avaya IP Agent for Windows Terminal Services.

Before you begin

Read and understand the following items before attempting to install Avaya IP Agent for Windows Terminal Services:

- After you install Avaya IP Agent to each server, you must initialize the configuration for each user.
- Read the readme.txt file in the root directory of the Avaya IP Agent CD-ROM for any last-minute information.
- If you are upgrading Avaya IP Agent, ensure that you have obtained new licenses for this version on your DEFINITY, MultiVantage, or Communication Manager system. If you have not done so or are unsure if you have done so, contact your Avaya representative for assistance.
- If you install applications for your users from the server, you should perform these installations during off-hours because the Avaya IP Agent installation might require a restart of the system.

Steps for installing Avaya IP Agent for Windows Terminal Services

To install Avaya IP Agent:

1. If the Avaya IP Agent installation program did not begin after the CD-ROM was inserted, run the Launcher.exe file in the root directory of the CD-ROM.
   The installation program displays the setup selection window.

2. Next to IP Agent Terminal Services Setup, select the Install button.
   The installation program displays the Welcome window.

3. Select the Next button.
   The installation program displays the Software License Agreement window.
Installing Avaya IP Agent for Windows Terminal Services

4. Read the entire Software License Agreement carefully and select the Yes button if you understand and agree to the terms. Selecting No will cause the installation program to exit.

5. Select the Next button.

Avaya IP Agent displays the IP Endpoint Options window. The Telecommuter configuration is the only valid option for Avaya IP Agent on the Windows Terminal Services platform.

Note:
The Share Station Login information between users feature is not available for the Windows Terminal Services version of Avaya IP Agent

6. Select the Next button.

The installation program displays the Choose Destination Location window.

7. If you want to install Avaya IP Agent in a folder other than the default, click the Browse button in the Destination Folder dialog box and select a new location.

8. When you are satisfied with the folder in which Avaya IP Agent will be installed, select the Next button.

The installation program displays the Setup Type window.

9. In the Setup Type window, select one of the following options and then select the Next button:

   ● Typical - This option installs the basic options in English as well as in the language of your Microsoft Windows operating system. Proceed to Step 13.

   ● Custom - This option installs the basic options in English as well as in any language you choose. Selecting this option and then the Next button will display the Select Language Components window where you specify the software language components to install. Proceed to the next step.

10. Indicate the language components to install by selecting the check box next to the option.

    When selecting the language components to install, ensure that the Space Required does not exceed the Space Available that is indicated at the bottom of the window.

11. Select the Next button.

    The installation program displays the Select Program Folder window.

12. Use the Select Program Folder window to specify the folder name that will appear in the Start menu through one of the following methods:

    ● You can accept the default Avaya IP Agent folder name that appears in the Program Folders field.

    ● You can enter a different folder name in the Program Folders field.

    ● You can select an existing folder in the Existing Folders field in which to install the Avaya IP Agent Start menu shortcuts.
13. Select the **Next** button.

   The installation program displays the **Shortcut and Startup Features** window.

14. Select the associated check boxes for the shortcuts you want to be created.

   **Note:**
   
   If you select a shortcut location but do not select any language, the install program displays a warning indicating that you need to select at least one or more languages.

15. If you selected one of the check boxes on the upper portion of this dialog box, you must highlight the languages in the **Select the languages you would like to have added** field for shortcuts to be created in those languages.

   **Note:**

   The option **Automatically start the following version of Avaya IP Agent when Windows is started** is not available for Windows Terminal Services.

16. Select the **Next** button.

   The installation program displays the **Start Copying Files** window.

   This window displays the options that you selected. If you need to make any changes to the selections you made, select the **Back** button until you reach the necessary window.

   The install program begins copying files. When this process is complete, the **View the Release Information File** window is displayed.

17. Select the check box provided in the **View the Release Information File** window to view the latest information for Avaya IP Agent that could not be included in this document.

18. Select the **Next** button.

   If you selected to view the Release Information, the installation program displays the **readme.txt** file. Otherwise, proceed to Step 20.

19. When you have read the **readme.txt** file, close the application displaying it.

   The installation program displays the final installation window.

20. Select the **Finish** button.

   The installation program closes.
Reinstalling Avaya IP Agent for Windows Terminal Services

If you reinstall Avaya IP Agent for Windows Terminal Services, the process is exactly as described in Installing Avaya IP Agent on Windows Terminal Services on page 57. Personalized configurations and data are preserved.
Uninstalling Avaya IP Agent for Windows Terminal Services

This section explains how to uninstall Avaya IP Agent. The uninstall program removes all files and directories that were created during the installation of Avaya IP Agent.

Introduction

You can uninstall Avaya IP Agent using the Windows Add/Remove Programs feature. Read-only folders that are shared with other applications are not removed. If you have added any files or directories to the Avaya IP Agent installation directory, those files will not be removed.

The uninstall program removes:

- All installed Avaya IP Agent files, including all language versions
- Folders created by the Avaya IP Agent installation
- Log files created by Avaya IP Agent

Steps

To uninstall the Avaya IP Agent application from Windows Terminal Services, follow the procedure found in Uninstalling Avaya IP Agent on page 50.
Chapter 4: Configuring the Avaya communication server

This section provides procedures and information on how to configure the following Avaya communication servers for use with Avaya IP Agent:

- Avaya communication servers with Communication Manager software
- Avaya communication servers with MultiVantage Software
- DEFINITY Enterprise Communication Server (ECS) R10
- DEFINITY Business Communications Server (BCS) and Guestworks R10

Before agents can receive calls with Avaya IP Agent, the Avaya communication server must be configured to support extension assignments, IP connectivity, telephone types, and other settings.

⚠️ Important:
You should be familiar with administering your Avaya communication server before attempting any of the procedures in this section. If you are unfamiliar with the fields or settings described in this section, consult your Avaya communication server documentation for assistance.

This section includes the following topics:

- Required Avaya communication server circuit packs on page 64
- Validating Feature Access Codes on page 66
- Road Warrior and Telecommuter configurations on page 68
- CallMaster VI configurations on page 75
- IP Telephone and Avaya Telephone-IP configurations on page 79
- Avaya Telephone-DCP configurations on page 85

Note:
The screens shown in this section are from an Avaya communication server with the Expert Agent Selection (EAS) feature. If you do not have the EAS or some other features on your Avaya communication server, these interfaces may differ slightly from the screens shown. Because of this, each step in the procedure identifies when there is a distinction between an EAS and non-EAS system.
Required Avaya communication server circuit packs

This section provides information and documentation resources for the circuit packs required by your Avaya communication server to support the Telecommuter, IP Telephone, Avaya Telephone, and Road Warrior configurations with Avaya IP Agent.

The following two circuit packs are used for remote agent connections over TCP/IP with Avaya IP Agent:
- Control LAN Circuit Pack (C-LAN) (TN799B or later)
- IP Media Processor

This section contains the following topics:
- C-LAN circuit pack on page 64
- IP Media Processor on page 64
- Documentation on page 65

C-LAN circuit pack

C-LAN is a packet port circuit pack for Avaya communication servers that provides TCP/IP connectivity to adjuncts for applications. It has one 10BaseT or 100BaseT Ethernet connection and up to 16 DS0 physical interfaces for PPP connections. Two integrated modems provide remote PPP connectivity over analog facilities. Multiple C-LAN circuit packs can be added to a system to increase TCP/IP capacity.

This circuit pack provides data signaling over TCP/IP for Avaya IP Agent. It is used for the Telecommuter, IP Telephone, Avaya Telephone, and Road Warrior configurations where a data connection is made to the Avaya communication server. The voice path does not use this circuit pack.

Note:
Avaya recommends that the TN799C V4 or later C-LAN circuit pack is used for its increased ability to handle maximum capacities. Previous versions could encounter difficulties when the maximum number of active endpoints is reached.

IP Media Processor

The IP Media Processor provides the transmission of voice data over an IP network. This enables support of applications that comply with H.323-v2 protocols. It also reduces per-port costs and improves quality through its dynamic jitter buffers. Additionally, it
Required Avaya communication server circuit packs

performs echo cancellation, silence suppression, Dual Tone Multi-Frequency (DTMF) detection, and conferencing.

This circuit pack provides Voice-over-Internet Protocol (VoIP) for Avaya IP Agent. It is used for the Road Warrior, IP Telephone, and Avaya Telephone-IP configurations where a VoIP connection is made to the Avaya communication server.

Documentation

For installation procedures and configuration information for the C-LAN and IP Media Processor circuit packs, see Administration for Network Connectivity for your Communication Manager, MultiVantage, or DEFINITY system.
Validating Feature Access Codes

This section provides the procedure for administering the Feature Access Codes (FACs) on an Avaya communication server. Feature Access Codes are used by Avaya IP Agent to give agents the ability to perform the following actions:

- Change the current work mode
- Log in
- Log out
- Adjust the method with which an agent receives the next call (Auto-In, Manual-In)
- Request supervisor assistance

Before you begin

Feature Access Codes cannot be entered unless the fac capability is assigned in the dial plan.

To change settings on the Avaya communication server, you must have a user ID with the proper administrative permissions.

⚠️ Important:

Screens presented in this section might differ in appearance from those of your Avaya communication server. All options on the specified forms mentioned in this procedure are available, but might not be on the page noted.

Steps for validating Feature Access Codes

To validate Feature Access Codes:

1. Log in to the Station Administration Terminal (SAT) on the Avaya communication server.

2. Enter `display dialplan` to access the dial plan form and then ensure that the fac option is assigned in the dial plan.

   If the fac option is not assigned in the dial plan, your dial plan does not currently support Feature Access Codes. For more information on configuring your dial plan for Feature Access Codes, see the documentation for your Avaya communication server.

3. Enter `display feature-access-codes` to view the feature-access-codes form.
4. Navigate to the call center portion of the feature-access-codes form.

Non-EAS Avaya communication servers will display only a subset of the access code fields shown in the following figure.

```
<table>
<thead>
<tr>
<th>FEATURE ACCESS CODE (FAC)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic Call Distribution Features</td>
</tr>
<tr>
<td>After Call Work Access Code: 773</td>
</tr>
<tr>
<td>Assist Access Code: 774</td>
</tr>
<tr>
<td>Auto-In Access Code: 770</td>
</tr>
<tr>
<td>Aux Work Access Code: 271</td>
</tr>
<tr>
<td>Login Access Code: 205</td>
</tr>
<tr>
<td>Logout Access Code: 206</td>
</tr>
<tr>
<td>Manual-In Access Code: 272</td>
</tr>
<tr>
<td>Service Observing Listen Only Access Code: 95</td>
</tr>
<tr>
<td>Service Observing Listen/Talk Access Code: 953</td>
</tr>
<tr>
<td>Add Agent Skill Access Code: 99</td>
</tr>
<tr>
<td>Remove Agent Skill Access Code: 99</td>
</tr>
<tr>
<td>Remote Logout of Agent Access Code: 256</td>
</tr>
<tr>
<td>Call Vctoring/Prompting Features</td>
</tr>
<tr>
<td>Converse Data Return Code: 205</td>
</tr>
</tbody>
</table>
```

**Note:**

The Feature Access Codes shown in the graphic are only an example and do not need to be configured as such on your Avaya communication server. You are free to determine your own Feature Access Codes.

5. Administer the Feature Access Codes for Login and Logout as well as any other FACs that you want available for your agents.

For Avaya CallMaster VI configurations, you must also administer the PASTE Feature Access Code which is located on a different page of this form.

If Feature Access Codes are not assigned, see the documentation for your Avaya communication server to find instructions on adding Feature Access Codes.
Road Warrior and Telecommuter configurations

If you will be using Avaya IP Agent for Voice-over-IP through the PC (Road Warrior configuration) or using any telephone as your extension (Telecommuter configuration), this section provides the procedures and information for proper administration of your Avaya communication server.

This section contains the following topics:

- Ensuring compatibility on page 68
- Configuring station settings on page 70

Ensuring compatibility

In this procedure, you set features on your Avaya communication server so that Avaya IP Agent can be used in your content center.

Before you begin

The settings for IP connections can be enabled only if your Avaya communication server supports use of Internet Protocol (IP) for calls.

⚠️ Important:

If any settings of your Avaya communication server do not conform with the steps in this procedure, you must contact Avaya to purchase the appropriate options or configuration for your Avaya communication server before you can use Avaya IP Agent.

If you need to configure a specific range of ports to use with IP communications because of firewalls or for some other reason, you must assign the range through both the Avaya communication server and Avaya iClarity IP Audio. See Advanced tab on page 233 for information on configuring port ranges on both systems.

Steps for ensuring Road Warrior and Telecommuter station settings

To ensure that your Avaya communication server supports the Telecommuter and Road Warrior configurations:

1. Log in to the Station Administration Terminal (SAT) on the Avaya communication server.
2. Enter `display system-parameters customer-options`.

The SAT displays Page 1 of the `system-parameters customer-options` form.

### Optional Features

<table>
<thead>
<tr>
<th>Feature</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>GS Version:</td>
<td>W3S</td>
</tr>
<tr>
<td>Location:</td>
<td>1</td>
</tr>
<tr>
<td>Maximum Ports:</td>
<td>8000</td>
</tr>
<tr>
<td>Maximum XMOBILE Stations:</td>
<td>0</td>
</tr>
<tr>
<td>Maximum Administered IP Trunks:</td>
<td>100</td>
</tr>
<tr>
<td>Maximum Concurrently Registered IP Stations:</td>
<td>400</td>
</tr>
<tr>
<td>Maximum Administered Remote Office Trunks:</td>
<td>0</td>
</tr>
<tr>
<td>Maximum Concurrently Registered Remote Office Stations:</td>
<td>0</td>
</tr>
<tr>
<td>Maximum Number of DGS Boards with Echo Cancellation:</td>
<td>0</td>
</tr>
</tbody>
</table>

(NOTE: You must logoff & login to affect the permission changes.)

3. Ensure that the **Maximum Concurrently Registered IP Stations** field is set to a number greater than zero. This number represents the total number of IP stations that can be connected to the Avaya communication server at one time. IP stations can consist of Avaya IP Agent, Avaya IP Softphone, and IP telephone sets.

4. Navigate to Page 3 of the `customer-options` form.

### Optional Features

<table>
<thead>
<tr>
<th>Feature</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Emergency Access to Attendant?</td>
<td>y</td>
</tr>
<tr>
<td>Extended Cfg/Fxd Admin?</td>
<td>n</td>
</tr>
<tr>
<td>External Device Alarm Admin?</td>
<td>n</td>
</tr>
<tr>
<td>Flexible Billing?</td>
<td>n</td>
</tr>
<tr>
<td>Forced Entry of Account Codes?</td>
<td>y</td>
</tr>
<tr>
<td>Global Call Classification?</td>
<td>y</td>
</tr>
<tr>
<td>Hospitality (Basic)?</td>
<td>y</td>
</tr>
<tr>
<td>Hospitality (GBYS) Enhancements?</td>
<td>y</td>
</tr>
<tr>
<td>M.323 Trunks?</td>
<td>y</td>
</tr>
<tr>
<td>ISDN BRI Trunks?</td>
<td>y</td>
</tr>
<tr>
<td>ISDN-PRI?</td>
<td>y</td>
</tr>
<tr>
<td>Malicious Call Trace?</td>
<td>y</td>
</tr>
<tr>
<td>Mode Code for Centralized Voice Mail?</td>
<td>n</td>
</tr>
<tr>
<td>Multifrequency Signaling?</td>
<td>n</td>
</tr>
<tr>
<td>Multimedia Appl. Server Interface (MSSI)?</td>
<td>n</td>
</tr>
<tr>
<td>Multimedia Call Handling (Basic)?</td>
<td>n</td>
</tr>
<tr>
<td>Multimedia Call Handling (Enhanced)?</td>
<td>n</td>
</tr>
<tr>
<td>Multiplex Locations?</td>
<td>y</td>
</tr>
<tr>
<td>IP Stations?</td>
<td>y</td>
</tr>
<tr>
<td>ISDN Feature Plus?</td>
<td>n</td>
</tr>
<tr>
<td>ISDN Network Call Redirection?</td>
<td>y</td>
</tr>
</tbody>
</table>

(NOTE: You must logoff & login to affect the permission changes.)

5. Ensure that the **IP Stations** field is set to `y`.  

---

**Issue 1.1 August 2004 69**
Configuring the Avaya communication server


### MAXIMUM IP REGISTRATIONS BY PRODUCT ID

<table>
<thead>
<tr>
<th>Product ID</th>
<th>Rel. Limit</th>
<th>Product ID</th>
<th>Rel. Limit</th>
<th>Product ID</th>
<th>Rel. Limit</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP_Agent</td>
<td>400</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IP_Phone</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IP_TRIA</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IP_Soft</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IP_SOFTNET</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

(Note: You must logoff & login to effect the permission changes.)

7. Ensure that the Limit field for the IP_Agent Rel. 5 Product ID is set to the number of licenses you purchased for Avaya IP Agent R5.

---

**Configuring station settings**

This section provides the procedure for configuring station settings to support the Telecommuter and Road Warrior configurations.

**Before you begin**

Before configuring station settings on the Avaya communication server, you should have completed the procedures in *Ensuring compatibility* on page 68 to verify that your Avaya communication server supports Avaya IP Agent and Feature Access Codes.

To change settings on the Avaya communication server, you must have a user ID with the proper administrative permissions.

If the station has not yet been created, you must create it using the `add station` command on the Avaya communication server.

**Steps for configuring Road Warrior and Telecommuter station settings**

To change station settings to support the Road Warrior and Telecommuter configurations:

1. Log in to the Station Administration Terminal (SAT) on the Avaya communication server.
2. Enter `change station XXXXX` where `XXXXX` is the number of the station to be used with Avaya IP Agent.

   The Avaya communication server displays the `change station` form for the specified station.

   ![Station Form]

   - **Extension**: 44444
   - **Type**: 8434D
   - **Port**: X
   - **Name**: IP Agent Station 44444

   **Station Options**
   - **Login Group**: 2
   - **Data Module**: No
   - **Speakerphone**: No
   - **Display Language**: English
   - **Extension**: 1001
   - **Extension**: 2002
   - **Extension**: 3003
   - **Extension**: 4004
   - **Extension**: 5005
   - **Extension**: 6006
   - **Extension**: 7007
   - **Extension**: 8008
   - **Extension**: 9009

3. In the **Type** field, enter the type of telephone that Avaya IP Agent will emulate.

   Avaya recommends using one of the following telephone types because of the number of features available and the ability to display 80 characters for contact center or call information:
   - **8434D**
   - **606A1**

   **Note:**

   In Telecommuter mode, Avaya IP Agent can take over the administration and functionality of a physical Digital Communication Protocol (DCP) telephone. The physical telephone must be one of those listed in [Compatible telephone types for Avaya IP Agent](#) on page 21. For DCP, the physical telephone is unusable while Avaya IP Agent is registered with its extension. The telephone will become usable again when the Avaya IP Agent session is disconnected from the Avaya communication server.

   If you selected the **8434D** type, and more feature buttons are needed for the station, enter `y` in the **Expansion Module** field.

4. Enter one of the following options in the **Port** field:
   - **X** - This option specifies that station administration is done without hardware.
   - **port** - This option is used when a remote agent takes direct control of a real extension that has a DCP connection to the Avaya communication server. Enter the port number of the actual telephone assigned to this extension. When a remote agent logs in to this extension using Avaya IP Agent, the actual telephone that is
Configuring the Avaya communication server

locally connected to the Avaya communication server port is disabled and cannot be used.

5. Enter a number in the **Security Code** field that will be used as a password during the extension login to the Avaya communication server.

If a security code is not entered, this station cannot log in to the Avaya communication server.

6. Set the **IP Softphone** field to **y**.

7. Navigate to Page 2 of the **change station** form.

8. Set the **Multimedia Mode** field to **enhanced**.

9. Set the **Service Link Mode** field to one of the following options:
   - **as-needed** - Use this setting if the station has low call traffic or a toll is charged for calls.
   - **permanent** - Use this setting if the station has high call traffic or if it is set as an auto-answer station.

10. Ensure that the **IP Emergency Calls** field is set to the appropriate setting for your contact center.

11. If the **Auto Answer** field is set to **All** or **ACD** on the station or agent form, you must enable the **Enable support for auto-answer** feature in the Avaya IP Agent **Program Options** and then reboot. You can find this option under **Tools > Program Options** in the Avaya IP Agent main window.
12. Navigate to Page 3 of the `change station` form.

13. On pages 3, 4, and 5 of the station administration forms, assign functions to each button that you want to appear in your Avaya IP Agent `Phone Features` window.

You must assign the necessary agent work mode buttons that are used in your contact center:

- **auto-in** - This function makes agents available for new calls immediately after they finish with the current call.
- **manual-in** - This function makes the agent available to take a call and then places the agent in the After Call Work (ACW) mode when the call has been completed.
- **after-call** - This function places agents in the After Call Work (ACW) mode.
- **aux-work** - This function places agents in the Auxiliary Work (AUX) mode. Multiple Auxiliary Work buttons with different reason codes can be assigned to this extension.

**Note:**

You can configure your Avaya communication server to prompt for reason codes when an agent enters the `aux-work` state.

- **release** - Assignment of this feature is mandatory. This feature terminates the current call and line appearance.
- **callr-info** - This function is required only with the Call Prompting feature so that agents are allowed to display information collected from the originator of the call. The Call Prompting feature obtains information from a caller through a `collect-digits` vector step on the Avaya communication server.
Important:
The 4600, 6400, and 607A1 telephone types do not have a physical Drop button; therefore, you must assign a drop function for each station to ensure proper operation of the Avaya IP Agent Drop feature.

When this station is connected to the Avaya communication server, the assigned button functions are displayed in the Avaya IP Agent Phone Features window.

You can find information on all available button functions in the documentation for your Avaya communication server.
CallMaster VI configurations

If you use Avaya CallMaster VI telephones for your contact center agents, this section provides the procedures for configuring your Avaya communication server for compatibility with Avaya IP Agent.

This section contains the following topics:

- Ensuring compatibility on page 75
- Configuring station settings on page 76

Ensuring compatibility

This section provides the procedure for ensuring that your Avaya communication server is configured to support Avaya IP Agent in the Avaya CallMaster VI configuration.

Before you begin

Read and understand the following items before administering your Avaya communication server:

- A BCS/Guestworks system does not support Avaya CallMaster VI configurations.

⚠️ Important:

If any Avaya communication server settings do not conform with the steps in this procedure, you must contact Avaya to purchase the appropriate options or configuration before you can use Avaya IP Agent.

Steps for ensuring CallMaster VI compatibility

To ensure that your Avaya communication server supports Avaya IP Agent in the CallMaster VI configuration:

1. Log in to the Station Administration Terminal (SAT) on the Avaya communication server.
2. Enter `display system-parameters customer-options`. The SAT displays Page 1 of the `system-parameters customer-options` form.

3. If you are using Avaya CallMaster VI telephone sets with the 606A1 telephone type, you must ensure that the PC Application Software Translation Exchange (PASTE) feature is enabled. Locate the `PASTE (Display PBX Data on Phone)` field and ensure that it is set to `y`.

---

Configuring station settings

This section provides the procedure for configuring station settings to support the Avaya CallMaster VI configurations for Avaya IP Agent.
Before you begin

Before configuring station settings on the Avaya communication server, you should have completed the procedure in Ensuring compatibility on page 75 to verify that your Avaya communication server supports Avaya IP Agent and Feature Access Codes.

To use Avaya CallMaster VI telephones, you must have the PASTE feature enabled on your Avaya communication server.

To change settings on the Avaya communication server, you must have a user ID with the proper administrative permissions.

If the station has not yet been created, you must create it using the add station command on the Avaya communication server.

Steps for configuring CallMaster VI station settings

To change station settings to support Avaya CallMaster VI configurations:

1. Log in to the Station Administration Terminal (SAT) on the Avaya communication server.

2. Enter change station XXXX where XXXX is the number of the station to be used with Avaya IP Agent.

   The Avaya communication server displays the change station form for the specified extension.

3. In the Type: field, enter 606A1.

4. In the Port: field, enter the number of the port providing the connection for the Avaya CallMaster VI telephone.

5. Navigate to Page 3 of the change station form.

6. On pages 3, 4, 5, and 6 of the station administration forms, assign functions to each button that you want to appear in your Avaya IP Agent Phone Features window.

   You must assign the necessary agent work mode buttons that are used in your contact center:

   ● **auto-in** - This function makes agents available for new calls immediately after the current call is finished.

   ● **manual-in** - This function makes the agent available to take a call and then places the agent in the After Call Work (ACW) mode when the call has been completed.

   ● **after-call** - This function places agents in the After Call Work (ACW) mode.

   ● **aux-work** - This function places agents in the Auxiliary Work (AUX) mode. Multiple Auxiliary Work buttons with different reason codes can be assigned to this extension.
Configuring the Avaya communication server

**Note:**
You can configure your Avaya communication server to prompt for reason codes when an agent enters the **aux-work** state.

- **release** - Assignment of this feature is mandatory. This feature terminates the current call and line appearance.

- **callr-info** - This function is only required with the *Call Prompting* feature so that agents are allowed to display information collected from the originator. The *Call Prompting* feature obtains information from a caller through a **collect-digits** vector step.

When this station is connected to the Avaya communication server, the assigned button functions are displayed in the Avaya IP Agent **Phone Features** window.

You can find information on all available button functions in the documentation for your Avaya communication server.

7. After you create a station and assign or modify buttons, you must perform a download for the Avaya CallMaster VI. Go to the personal computer connected to the Avaya CallMaster VI station and select **Settings > Phone Configuration** from the Avaya IP Agent menu bar.

   Avaya IP Agent displays a confirmation dialog box.

8. Select the **OK** button.
IP Telephone and Avaya Telephone-IP configurations

This section provides the procedures for configuring your Avaya communication server to function properly with Avaya IP Agent if you use Avaya IP telephones in your contact center.

This section contains the following topics:

- Ensuring compatibility on page 79
- Configuring station settings on page 81

Ensuring compatibility

This section provides the procedure for ensuring that your Avaya communication server is configured to support the IP Telephone and Avaya Telephone-IP configurations.

Before you begin

The settings for IP connections can be enabled only if your Avaya communication server supports use of Internet Protocol (IP) for calls.

⚠️ Important:

If any settings of your Avaya communication server do not conform with the steps in this procedure, you must contact Avaya to purchase the appropriate options or configuration for your Avaya communication server before you can use Avaya IP Agent.

If you need to configure a specific range of ports to use with IP communications because of firewalls or for some other reason, you must assign the range through both the Avaya communication server and Avaya iClarity IP Audio. See Advanced tab on page 233 for information on configuring port ranges on both systems.

Steps for ensuring IP telephone compatibility

To ensure that your Avaya communication server supports the IP Telephone and Avaya Telephone-IP configurations:

1. Log in to the Station Administration Terminal (SAT) on the Avaya communication server.
Configuring the Avaya communication server

2. Enter `display system-parameters customer-options`.

   The SAT displays Page 1 of the `system-parameters customer-options` form.

   
<table>
<thead>
<tr>
<th>OPTIONAL FEATURES</th>
</tr>
</thead>
<tbody>
<tr>
<td>GS Version: 4.0.5</td>
</tr>
<tr>
<td>Location: 1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>IP PORT CAPACITIES</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Administered IP Trunks: 160</td>
</tr>
<tr>
<td>Maximum Concurrently Registered IP Stations: 400</td>
</tr>
<tr>
<td>Maximum Administered Remote Office Trunks: 0</td>
</tr>
<tr>
<td>Maximum Concurrently Registered Remote Office Stations: 0</td>
</tr>
</tbody>
</table>

   Maximum Number of DS1 Boards with Echo Cancellation: 0

   [NOTE: You must logoff & login to affect the permission changes.]

3. Ensure that the **Maximum Concurrently Registered IP Stations** field is set to a number greater than zero. This number represents the total number of IP stations that can be connected to the Avaya communication server at one time. IP stations can consist of Avaya IP Agent, Avaya IP Softphone, and IP telephone sets.

4. Navigate to Page 3 of the `customer-options` form.

5. Ensure that the **IP Stations** field is set to **y**.

   (NOTE: You must logoff & login to affect the permission changes.)
6. Navigate to Page 9 of the **customer-options** form.

### MAXIMUM IP REGISTRATIONS BY PRODUCT ID

<table>
<thead>
<tr>
<th>Product ID</th>
<th>Rel.</th>
<th>Limit</th>
<th>Product ID</th>
<th>Rel.</th>
<th>Limit</th>
<th>Product ID</th>
<th>Rel.</th>
<th>Limit</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP_Agent</td>
<td>400</td>
<td></td>
<td>IP_Agent</td>
<td>400</td>
<td></td>
<td>IP_Agent</td>
<td>400</td>
<td></td>
</tr>
<tr>
<td>IP_Phone</td>
<td>10</td>
<td></td>
<td>IP_Phone</td>
<td>10</td>
<td></td>
<td>IP_Phone</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>IP_Pbx</td>
<td>10</td>
<td></td>
<td>IP_Pbx</td>
<td>10</td>
<td></td>
<td>IP_Pbx</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>IP_Soft</td>
<td>10</td>
<td></td>
<td>IP_Soft</td>
<td>10</td>
<td></td>
<td>IP_Soft</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>IP_AGENTSC</td>
<td>10</td>
<td></td>
<td>IP_AGENTSC</td>
<td>10</td>
<td></td>
<td>IP_AGENTSC</td>
<td>10</td>
<td></td>
</tr>
</tbody>
</table>

*(Note: You must logoff & login to effect the permission changes.)*

7. For the Avaya Telephone-IP configuration, ensure that the **Limit** field for the **IP_AGENTSC Rel. 5** Product ID is set to the number of licenses you purchased for Avaya IP Agent R5. For the IP Telephone configuration, verify the number of licenses for the **IP_AGENT Rel. 5** Product ID.

**Note:**

This configuration can use either the **IP_AGENTSC** or **IP_Agent** licenses.

---

### Configuring station settings

This section provides the procedure for configuring station settings to support the IP Telephone and Avaya Telephone-IP configurations.

#### Before you begin

Before configuring station settings on the Avaya communication server, you should have completed the procedure in **Ensuring compatibility** on page 79 to verify that your Avaya communication server supports Avaya IP Agent and Feature Access Codes.

To change settings on the Avaya communication server, you must have a user ID with the proper administrative permissions.

If the station has not yet been created, you must create it using the **add station** command on the Avaya communication server.

**Important:**

To use an Avaya IP telephone with Avaya IP Agent, the firmware version of the telephone must be 1.7 or later.
Configuring the Avaya communication server

For the IP Telephone configuration, the Computer Telephony Integration (CTI) control feature must be enabled on the IP telephone before it can be used in conjunction with Avaya IP Agent. This feature does not need to be enabled if you are administering the Avaya Telephone-IP configuration. To enable the CTI control feature:

1. Press the Mute button on your IP telephone.
2. Press 2 8 4 # on the IP telephone dial pad.

The telephone display will display the state of the CTI control feature. CTI=manual indicates that the feature is enabled.

3. Depending on the feature state, perform the appropriate action:
   - If CTI=manual is displayed, save your changes by following the prompts on the telephone display.
   - If CTI=off is displayed, press 1 # to enable CTI control, and then save your changes by following the prompts on the telephone display.

Steps for configuring IP Telephone and Avaya Telephone-IP station settings

To change station settings to support the IP Telephone and Avaya Telephone-IP configurations:

1. Log in to the Station Administration Terminal (SAT) on the Avaya communication server.
2. Enter change station XXXXX where XXXXX is the number of the station to be used with Avaya IP Agent.

   The Avaya communication server displays the change station form for the specified station.

   3. In the Type field, enter the type of telephone that Avaya IP Agent will control. The station type must match that of the IP telephone.
4. Ensure that the Port field is set to IP.
5. Enter a number in the **Security Code** field that will be used as a password during the extension login to the Avaya communication server.

   If a security code is not entered, this station cannot log in to the Avaya communication server.

6. Set the **IP Softphone** field to y.

7. Navigate to Page 2 of the **change station** form.

8. Ensure that the **Multimedia Mode** field has been set to enhanced.

9. Set the **Service Link Mode** field to one of the following options:

   - **as-needed** - Use this setting if the station has low call traffic or a toll is charged for calls.
   
   - **permanent** - Use this setting if the station has high call traffic or if it is set as an auto-answer station.

10. If the **Auto Answer** field is set to All or ACD on the station or agent form, you must enable the **Enable support for auto-answer** feature in the Avaya IP Agent **Program Options** and then reboot. You can find this option under **Tools > Program Options** in the Avaya IP Agent main window.

11. Navigate to Page 3 of the **change station** form.
12. On pages 3, 4, and 5 of the station administration forms, assign functions to each button that you want to appear in your Avaya IP Agent **Phone Features** window.

You must assign the necessary agent work mode buttons that are used in your contact center:

- **auto-in** - This function makes agents available for new calls immediately after they finish with the current call.
- **manual-in** - This function makes the agent available to take a call and then places the agent in the After Call Work (ACW) mode when the call has been completed.
- **after-call** - This function places agents in the After Call Work (ACW) mode.
- **aux-work** - This function places agents in the Auxiliary Work (AUX) mode. Multiple Auxiliary Work buttons with different reason codes can be assigned to this extension.

**Note:**
You can configure your Avaya communication server to prompt for reason codes when an agent enters the **aux-work** state.

- **release** - Assignment of this feature is mandatory. This feature terminates the current call and line appearance.
- **callr-info** - This function is required only with the Call Prompting feature so that agents are allowed to display information collected from the originator of the call. The Call Prompting feature obtains information from a caller through a **collect-digits** vector step on the Avaya communication server.

When this station is connected to the Avaya communication server, the assigned button functions are displayed in the Avaya IP Agent **Phone Features** window.

You can find information on all available button functions in the documentation for your Avaya communication server.
Avaya Telephone-DCP configurations

The Avaya Telephone-DCP configuration allows agents to use Avaya IP Agent as a direct interface with a Digital Communication Protocol (DCP) telephone. This configuration is used when there is no need for agents to use any of the following capabilities:

- Voice-over-IP
- A telephone outside the contact center
- An extension with a different telephone type that allows more features than the DCP telephone.

This section contains the following topics:

- Ensuring compatibility on page 85
- Configuring station settings on page 87

Ensuring compatibility

This section describes the setting of features on your Avaya communication server so that Avaya IP Agent can be used in your content center.

Before you begin

The settings for IP connections can be enabled only if your Avaya communication server supports use of Internet Protocol (IP) for calls.

⚠️ Important:

If any settings of your Avaya communication server do not conform with the steps in this procedure, you must contact Avaya to purchase the appropriate options or configuration for your Avaya communication server before you can use Avaya IP Agent.

If you need to configure a specific range of ports to use with IP communications because of firewalls or for some other reason, you must assign the range through both the Avaya communication server and Avaya iClarity IP Audio. See Advanced tab on page 233 for information on configuring port ranges on both systems.

The DCP telephone must be connected for Avaya IP Agent to register with the Avaya communication server. If the telephone is disconnected, registration through Avaya IP Agent will be denied. Conversely, if the DCP telephone is disconnected after registration has been made, Avaya IP Agent will be disconnected by the Avaya communication server.
Steps for ensuring Avaya Telephone-DCP compatibility

To ensure that your Avaya communication server supports the Avaya Telephone-DCP configuration:

1. Log in to the Station Administration Terminal (SAT) on the Avaya communication server.

2. Enter `display system-parameters customer-options`.

   The SAT displays Page 1 of the `system-parameters customer-options` form.

3. Ensure that the Maximum Concurrently Registered IP Stations field is set to a number greater than zero. This number represents the total number of IP stations that can be connected to the Avaya communication server at one time. IP stations can consist of Avaya IP Agent, Avaya IP Softphone, and IP telephone sets.

4. Navigate to Page 3 of the `customer-options` form.
Configuring station settings

Before you begin

Before configuring station settings on the Avaya communication server, you should have completed the procedures in **Ensuring compatibility** on page 85 to verify that your Avaya communication server supports Avaya IP Agent and Feature Access Codes.

To change settings on the Avaya communication server, you must have a user ID with the proper administrative permissions.

If the station has not yet been created, you must create it using the `add station` command on the Avaya communication server.

**Steps for configuring Avaya Telephone-DCP station settings**

To change station settings to support the Avaya Telephone-DCP configuration:

1. Log in to the Station Administration Terminal (SAT) on the Avaya communication server.
2. Enter `change station XXXXX` where `XXXXX` is the number of the station to be used with Avaya IP Agent.

   The Avaya communication server displays the `change station` form for the specified station.

   ![STATION FORM]

   3. In the *Type* field, enter the type of telephone that will be used with Avaya IP Agent. If this station possesses an expansion module, set the **Expansion Module** field to *y*.

   **Important:**
   This field must reflect the exact model of telephone that will be used by the agent.

4. In the *Port* field, specify the port that this DCP telephone will use.

   This option is used when a remote agent takes direct control of a telephone that has a DCP connection to the Avaya communication server. Enter the port number of the actual telephone assigned to this extension.

5. Enter a number in the *Security Code* field that will be used as a password during the extension login to the Avaya communication server.

   If a security code is not entered, this station cannot log in to the Avaya communication server.

6. Set the *IP Softphone* field to *y*. 

---

88  Avaya IP Agent Installation and User Guide
7. Navigate to Page 2 of the change station form.

8. Set the Multimedia Mode field to enhanced.

9. Set the Service Link Mode field to one of the following options:
   - **as-needed** - Use this setting if the station has low call traffic or a toll is charged for calls.
   - **permanent** - Use this setting if the station has high call traffic or if it is set as an auto-answer station.

10. If the Auto Answer field is set to All or ACD on the station or agent form, you must enable the Enable support for auto-answer feature in the Avaya IP Agent Program Options and then reboot. You can find this option under Tools > Program Options in the Avaya IP Agent main window.

11. Navigate to Page 3 of the change station form.

12. On pages 3, 4, and 5 of the station administration forms, assign functions to each button that you want to appear in your Avaya IP Agent Phone Features window.

   You must assign the necessary agent work mode buttons that are used in your contact center:
Configuring the Avaya communication server

- **auto-in** - This function makes agents available for new calls immediately after they finish with the current call.

- **manual-in** - This function makes the agent available to take a call and then places the agent in the After Call Work (ACW) mode when the call has been completed.

- **after-call** - This function places agents in the After Call Work (ACW) mode.

- **aux-work** - This function places agents in the Auxiliary Work (AUX) mode. Multiple Auxiliary Work buttons with different reason codes can be assigned to this extension.

**Note:**
You can configure your Avaya communication server to prompt for reason codes when an agent enters the **aux-work** state.

- **release** - Assignment of this feature is mandatory. This feature terminates the current call and line appearance.

- **callr-info** - This function is only required with the Call Prompting feature so that agents are allowed to display information collected from the originator of the call. The Call Prompting feature obtains information from a caller through a **collect-digits** vector step on the Avaya communication server.

**Important:**
The 6400-series telephones do not have a physical Drop button; therefore, you must assign a **drop** function for each station to ensure proper operation of the Avaya IP Agent Drop feature.

When this station is connected to the Avaya communication server, the assigned button functions are displayed in the Avaya IP Agent **Phone Features** window.

You can find information on all available button functions in the documentation for your Avaya communication server.
Chapter 5: Using enhanced configuration options

This section provides information and procedures for configuring advanced features in a contact center that uses Avaya IP Agent.

This section contains the following topics:

- Configuring the Emergency Call Handling Service on page 92
- Configuring Avaya IP Agent for VPN configurations on page 95
- Installing the Quality of Service Packet Scheduler on page 97
- Configuring Alternate Gatekeeper on Avaya communication servers on page 99
- Configuring server load balancing across gatekeepers on page 100
Configuring the Emergency Call Handling Service

The Emergency Call Handling Service (E911) allows IP Endpoints to use numbers that connect to emergency services, such as 911 in the United States. When used, this feature reaches only the emergency service in the Public Safety Answering Point area where the Avaya communication server is located.

⚠️ WARNING:
Because IP Endpoints do not dial to and connect with local emergency services when dialing from remote locations, agents or extensions in remote locations should not use this feature for emergencies.

Avaya Inc. is not responsible or liable for any damages resulting from misplaced emergency calls made from an Avaya endpoint. Your use of this product indicates that you have read this advisory and agree to use an alternative telephone to dial all emergency calls from remote locations.

This section contains the following topics:

- Administering the Avaya communication server for Emergency Call Handling on page 92
- Administering Avaya IP Agent for Emergency Call Handling on page 93

Note:
For Avaya Telephone-DCP and CallMaster VI configurations, this feature is not configured through Avaya IP Agent. If an emergency call is dialed on a telephone while this configuration is in use, the emergency call is treated normally by the Avaya communication server.

Note:
This feature is not available for IP Telephone configurations.

Administering the Avaya communication server for Emergency Call Handling

See the documentation for your Avaya communication server for information on configuring the Emergency Call Handling feature.
Administering Avaya IP Agent for Emergency Call Handling

This section provides the procedure for configuring Avaya IP Agent to use the Emergency Call Handling Service.

Before you begin

The Avaya communication server to which you are connecting must have each extension properly configured for the Emergency Call Handling Service before this feature can be used through Avaya IP Agent.

Steps

To configure the Emergency Call Handling Service in Avaya IP Agent:

1. Start Avaya IP Agent.
   - Windows displays Avaya IP Agent and the Login window.
2. In the Login window, select the Settings button.
   - Avaya IP Agent displays the Settings dialog box.
3. Select the Emergency tab.
4. Place a check mark in the Enable emergency call handling feature check box.
5. Select the location that will be sent through the Avaya communication server for calls placed to emergency services:
Using enhanced configuration options

- **Your extension number XXXXXXX** - Select this option button if you want your extension number to be sent to emergency personnel. This selection is best used for those stations within the contact center.

- **Telephone number** - Select this option button if you want a telephone number other than your extension sent to emergency services. Specify the telephone number to send in the provided field. For example, enter a number corresponding to a Digital Communications Protocol (DCP) telephone in your vicinity that has a fixed, known location so that emergency personnel know where to respond. If you are unsure of a number to enter, see your system administrator.

6. Select the **OK** button.

7. In the **Login** dialog box, select the **Login** button.

   Any calls to emergency services will show the selected telephone number.
Configuring Avaya IP Agent for VPN configurations

If you are using a VPN, you may need to specify a local IP address for proper network communication. Set this address through the Login Settings dialog box.

**Note:**
Use of a VPN is not supported with Avaya IP Agent for Windows Terminal Services.

---

**Steps**

To set the local IP address for a VPN configuration:

1. Start Avaya IP Agent.
   - Windows displays Avaya IP Agent and the Login window.
2. In the Login window, select the Settings button.
   - Avaya IP Agent displays the Settings dialog box.
3. Select the Advanced tab.
   - Avaya IP Agent displays the Advanced tab panel:
Using enhanced configuration options

4. Place a check mark in the **Use the following IP address (as displayed by the VPN client)** check box.

   Avaya IP Agent enables the associated IP address field.

5. In the IP address field, enter the local IP address to be used by the VPN client.

6. Select the **OK** button.

   All subsequent login attempts to the Avaya communication server will cause this dialog box to be displayed.
Installing the Quality of Service Packet Scheduler

Quality of Service (QoS) can help improve voice transmission on your network and personal computer when using Voice-over-IP. However, before you can use Quality of Service, you must install the QoS Packet Scheduler.

Note:
The QoS Packet Scheduler for Windows XP is automatically installed when Avaya IP Agent is installed.

Before you begin

You should read and understand the following items before installing the Quality of Service Packet Scheduler:

- Some VPN client applications have conflicts with the Packet Scheduler. If your VPN exhibits problems, remove the QoS Packet Scheduler from your personal computer.
- If you are using QoS in conjunction with a firewall, the range of ports for QoS set up on the Avaya communication server must overlap the range of firewall ports specified in Avaya IP Agent by 100 ports. If these ranges do not overlap by 100 ports, QoS is not used by Avaya iClarity IP Audio and transmissions are done within the range of firewall ports.
- Many Avaya IP telephones are equipped with internal QoS. For information about QoS in IP telephones, see the documentation for your specific telephone.

Steps for installing QoS for Windows 2000

To install the QoS Packet Scheduler for Windows 2000:

1. Log in to the Microsoft Windows 2000 personal computer as a user with Administrator privileges.
2. From the Start menu, select Settings > Network and Dial-up Connections.
3. Select the local area connection on which you want to install QoS Packet Scheduler.
4. From the File menu, select Properties.
   Windows displays the Local Area Connection dialog box.
5. Select the Install button.
   Windows displays the Select Network Component Type dialog box.
Using enhanced configuration options

6. Select **Service**.
7. Select the **Add** button.
   Windows displays the **Select Network Service** dialog box.
8. Select **QoS Packet Scheduler**.
9. Select the **OK** button.
10. Select the **Close** button in the **Local Area Connection Properties** dialog box.
11. Close the **Network and Dial-up Connections** window.
Configuring Alternate Gatekeeper on Avaya communication servers

Use the Alternate Gatekeeper feature when an IP Endpoint registers with an Avaya communication server. When Avaya IP Agent registers with an Avaya communication server, a C-LAN circuit pack IP address is sent to the IP Endpoint. If registration is successful, the Avaya communication server sends back the IP addresses of all C-LAN circuit packs defined in the same network region. Avaya IP Agent can use these addresses as alternatives if call signaling on the original C-LAN circuit pack fails.

Tip:
You can better control the usage and workload of C-LAN circuit packs by creating network regions.

Alternate Gatekeeper configuration

For information on defining Alternate Gatekeeper addresses, refer to your Avaya communication server documentation.
Configuring server load balancing across gatekeepers

Load balancing for an Avaya communication server refers to the ability of distributing IP Endpoint traffic across all C-LAN circuit packs that are defined within the same network region.

Load Balancing configuration

Load balancing is achieved by defining all of the IP addresses of the C-LAN circuit packs to be part of a network region on an Avaya communication server. After this has been completed, IP Endpoints registering with the Avaya communication server will be automatically assigned to the different C-LAN circuit packs in sequential order. This helps distribute IP Endpoints evenly amongst the C-LAN circuit packs.

Important:

It is important that you use the network region feature to control which C-LAN circuit packs are available when one pack loses connectivity. Without proper region assignments for your C-LAN circuit packs, Avaya IP Agent could attempt to connect to a C-LAN circuit pack that has not been properly configured or is not intended for use with Avaya IP Agent.

For more information on defining C-LAN circuit packs within a network region, refer to the documentation for your Avaya communication server.

Load Balancing documentation

For installation procedures and configuration information for the C-LAN and IP Media Processor circuit packs, see Administration for Network Connectivity for your Communication Manager, MultiVantage, or DEFINITY system.
Chapter 6: Running Avaya IP Agent

This chapter explains how to begin using Avaya IP Agent. It contains the following sections:

- Starting Avaya IP Agent on page 102
- Initializing IP Endpoint configurations on page 103
- Initializing CallMaster VI configurations on page 112
- Registering with the Avaya communication server on page 113
- Logging in as an agent (EAS) on page 117
- Logging in as an agent (non-EAS) on page 119
- Logging out of Avaya IP Agent on page 121
- Exiting Avaya IP Agent on page 122
- Using alternate user interfaces on page 123
Starting Avaya IP Agent

This section provides the procedure for starting the Avaya IP Agent application.

Steps for starting Avaya IP Agent

To start Avaya IP Agent:

1. Select the **Start** button from the Windows task bar.

2. Do the following step that is appropriate for your situation:

   - If you upgraded a previous version of Avaya IP Agent, select **Programs > Avaya IP Agent**.
   
   - If you are using a new installation of Avaya IP Agent, select **Programs > Avaya**.

3. Select **Avaya IP Agent - <language>**.

   The Avaya IP Agent window is displayed. Although Avaya IP Agent is now running, your extension is not yet registered with the Avaya communication server.

4. If this is the first time that Avaya IP Agent is run, you must follow the procedure for your type of configuration:

   - For IP Endpoint configurations, go to [Initializing IP Endpoint configurations](#) on page 103.

   - For CallMaster VI configurations, go to [Initializing CallMaster VI configurations](#) on page 112.
Initializing IP Endpoint configurations

If you have performed a new installation of Avaya IP Agent for an IP Endpoint configuration, the Configuration Wizard is displayed when you first start Avaya IP Agent. The Configuration Wizard prompts you to enter the necessary configuration information for registering with an Avaya communication server and for Voice-over-IP audio performance.

Steps

To configure your installation of Avaya IP Agent to register with an Avaya communication server:

1. Start Avaya IP Agent.
   Avaya IP Agent starts the Configuration Wizard automatically.

2. Select the Next button.
   Avaya IP Agent displays the next window of the Configuration Wizard.

3. Select the appropriate option:
   - **Log into Avaya call server** - Select this option for Road Warrior, Telecommuter, and Avaya Telephone configurations.
     If you are using the Avaya Telephone configuration, place a check mark in the Control an Avaya telephone check box.
   - **Log into Avaya IP Telephone** - Select this option for IP Telephone configurations. Do not select this option if you will be using the Avaya Telephone-IP configuration.
4. Select the **Next** button.

   Avaya IP Agent displays the next window of the Configuration Wizard.

5. Enter the necessary information in the following fields:
   - **Extension** - The extension number of the station that will be used with Avaya IP Agent.
   - **Password** - The numeric password associated with the specified extension.
   - **Remember password for next login session** - Place a check mark in this check box if you do not want to enter your password each time you register with the Avaya communication server. If you are concerned with the possibility of unauthorized persons assuming this identity, leave this check box blank.
   - **IP Address** - Enter the IP address of the IP telephone that will be used with Avaya IP Agent. If you have entered an extension number, select the **Discover** button to automatically populate the IP address of the IP telephone.

6. Select the **Next** button.

   Avaya IP Agent displays the next window of the Configuration Wizard.

7. In the **Primary Server Address** field, enter the domain name or IP address of the Avaya communication server C-LAN circuit pack that will be used for connections.

8. In the **Alternative Server Addresses** field, you have the option of defining other C-LAN circuit pack addresses that will be used should the primary address fail. This field is optional.

   **Tip:**
   The alternative server addresses should reside in the same network region as the primary server address. For more information on defining network regions, see the documentation for your Avaya communication server.
9. Select the **Next** button.
   Avaya IP Agent displays the next window of the Configuration Wizard.

10. Select the pre-defined **Dialing Location** from the drop-down list. This selection will control certain telephony properties such as area code, outside line access, and so forth.

11. Select the **Next** button.
   Avaya IP Agent displays a warning message regarding the Emergency Call Handling feature.

   ![Emergency Call Handling Warning Message](image.png)

   **Note:**
   For the IP Telephone configuration, the Emergency Call Handling window is not displayed. If you are using the IP Telephone configuration, proceed to Step 17.

12. Read the text of this warning completely and select the **I Agree** button if you understand and agree to the conditions stated in this message.

   If you select the **I Disagree** button, the **Configuration Wizard** will exit or, for Windows Terminal Services, return to a previous **Configuration Wizard** window.

   After you select **I Agree**, Avaya IP Agent displays the next window of the Configuration Wizard.

   ![Emergency Call Handling Configuration](image.png)
13. If you want to enable this feature, place a check mark in the **Enable Emergency Call Handling feature** check box.

14. If you enabled the Emergency Call Handling feature, select the location that will be sent through the Avaya communication server for calls placed to emergency services:

**WARNING:**

Because IP Endpoints do not dial to and connect with local emergency services when dialing from remote locations, **agents or extensions in remote locations should not use this feature for emergencies.**

Avaya Inc. is not responsible or liable for any damages resulting from misplaced emergency calls made from an Avaya endpoint. Your use of this product indicates that you have read this advisory and agree to use an alternative telephone to dial all emergency calls from remote locations.

- **Your extension number XXXXXXX** - Select this option button if you want your extension number to be sent to emergency personnel. This selection is best used for those stations within the contact center. Enter the number of digits that your contact center uses for extensions. For DEFINITY R10 systems, extension numbers can range from one to five digits. For MultiVantage and Communication Manager systems, extension numbers can range from one to seven digits.

- **Telephone number** - Select this option button if you want a telephone number other than your extension sent to emergency services. Specify the telephone number to send in the provided field.

This selection must be compatible with the station definition on the Avaya communication server in the **IP Emergency Calls** field. Failure to use the same setting as the Avaya communication server will result in login failure for this extension.
15. Select the **Next** button.

For Road Warrior and Telecommuter configurations, Avaya IP Agent displays the next window of the Configuration Wizard.

This window is not displayed for Avaya Telephone-DCP configurations. If you are using the Avaya Telephone-DCP configuration, proceed to step 17.

16. Select the type of IP Endpoint configuration that will be used for this installation of Avaya IP Agent.

If you select the **Road Warrior (Voice over IP)** option, you will also need to specify the throughput available in the **Bandwidth Setting** field. Select the **Help** button for specific information about the different bandwidth settings.

If you are using Avaya IP Agent for Windows Terminal Services, you can only select the **Telecommuter** option.

⚠️ Important:

The quality of the audio in a Road Warrior configuration is dependent on many factors. See [Voice-over-IP considerations](#) on page 33 for specific information.

If you select the **Telecommuter** option, you must specify the telephone or extension number that will be used to make and receive calls with Avaya IP Agent.

**Note:**

For Road Warrior configurations, two lights are displayed in the status bar of the main window. These lights indicate the status of the network connection. If these lights turn red, your network is having connectivity problems or you have chosen a bandwidth that cannot be supported by your network connection.
17. Select the **Next** button.

Avaya IP Agent displays the next window of the Configuration Wizard.

You have completed the process for specifying the settings that will be used to connect and function with the Avaya communication server. The next part of the Configuration Wizard will guide you through the process of adjusting the audio properties of your PC.

**Note:**

You must complete this section before you will be allowed to register with the Avaya communication server.

18. Select the **Next** button.

Avaya IP Agent displays the next window of the Configuration Wizard. This window varies based on the configuration type.

19. In the **Select a playback device** field, select the appropriate device that Avaya IP Agent should use for audio output.
20. If you are setting a Road Warrior configuration, select the appropriate device on your PC in the **Select a recording device** list. For other configurations, this drop-down list box is not displayed and you can continue to the next step.

21. If your PC contains multiple sound devices and you have specified the Telecommuter configuration, you can choose to have Avaya IP Agent play ringing sounds through another sound device. To do so, place a check mark in the **Enable a secondary ring device** check box. Then, select the appropriate sound device from the **Select a secondary playback device** drop-down list box.

22. If your PC contains multiple sound devices and you have specified the Telecommuter configuration, you can choose to have Avaya IP Agent play ringing sounds through another sound device. To do so, place a check mark in the **Enable a secondary ring device** check box. Then, select the appropriate sound device from the **Select a secondary playback device** drop-down list box.

23. If you want to use agent greetings in the Telecommuter configuration, place a check mark in the **Play greetings via Avaya Switcher II** check box. Please note that this feature is not available in the Windows Terminal Services version of Avaya IP Agent.

**Important:**
The Avaya Switcher II connects directly to both your telephone and PC. If you are not using an Avaya Switcher II, you will not be able to properly record and use agent greetings in Telecommuter mode.

24. Select the **Next** button.

Avaya IP Agent displays the next window of the Configuration Wizard.

25. If you are setting a Road Warrior configuration, select the device to use for transmitting and receiving audio:

- **Headset or Handset** - Select this option if you will be using a headset (Universal Serial Bus or attached to PC sound card) or a special handset that connects to your PC.

- **PC Microphone and PC Speakers** - Select this option if you will be using a microphone and speaker system attached to your PC.

- **Half-Duplex Sound Device** - Select this option if it is available because Avaya iClarity IP Audio will adjust its performance for this type of sound device. Avaya recommends that full-duplex sound devices be used for Voice-over-IP communications.
25. Select the **Next** button.

Avaya IP Agent displays the next window of the Configuration Wizard.

26. Follow the instructions listed in this window to set the optimal volume level for the audio output of your PC sound device.

27. After setting the volume level, select the **Next** button.

28. If you selected the Avaya Switcher II feature, Avaya IP Agent displays a window for setting the microphone playback volume of this unit. If you did not enable this feature, proceed to the next step.
29. After you have set the microphone playback volume, select the **Next** button.

   Avaya IP Agent displays the next window of the Configuration Wizard.

   ![Configuration Wizard](image)

30. If you are administering a Road Warrior configuration, set the microphone recording level.

   If you want Avaya iClarity IP Audio to automatically adjust the recording levels, select the top option.

   If you want to use a steady and consistent level of volume for recording, select the bottom option.

   You must set the initial level by moving the slider bar so that when you speak into your microphone, you can see green boxes in the **Audio meter**. These boxes should not exceed the boundaries marked by the caret characters.

31. Select the **Next** button.

   Avaya IP Agent displays a test window.

32. Select the **Test** button to set the level of background noise in your environment.

33. Select the **Next** button.

   Avaya IP agent displays the last window of the Configuration Wizard.

34. If you do not need to go back and readjust your audio settings, select the **Finish** button to complete the Configuration Wizard.
Initializing CallMaster VI configurations

If you have completed a new installation of Avaya IP Agent for a CallMaster VI configuration, the **Select Communication Port** window is displayed when you first start Avaya IP Agent.

In the drop-down list box, select the communications (COM) port that is used to connect the PC to the Avaya CallMaster VI telephone. When you have specified the COM port, select the **OK** button to continue.
Registering with the Avaya communication server

Before you can use Avaya IP Agent, you must register Avaya IP Agent with the Avaya communication server and register your extension through the Login window. Once you are registered with the Avaya communication server, you can make yourself available for ACD calls by performing an agent login.

⚠️ Important:

Avaya CallMaster VI configurations do not register with the Avaya communication server as described in this section. Registration is automatic through the Avaya CallMaster VI telephone. If you are using an Avaya CallMaster VI configuration, proceed to Logging in as an agent (EAS) on page 117.

This section provides the procedure for registering with an Avaya communication server. This must be done so that you can use Avaya IP Agent for placing and answering calls in an IP Endpoint configuration.

Before you begin

If you attempt to log in to an Avaya communication server that is not a DEFINITY, MultiVantage, or Communication Manager system, Avaya IP Agent displays an Invalid Station Type error message. You must use a DEFINITY, MultiVantage, or Communication Manager system with Avaya IP Agent. You can see a list of systems that are supported by consulting Avaya communication server on page 29.

Setting default registration information

The Settings button on the Login window can be used to configure more advanced features that are used with Avaya IP Agent and the Avaya communication server. For more information on these settings, see Login Settings dialog box on page 228.

Steps for registering with an Avaya communication server

To register with the Avaya communication server:

1. When you start Avaya IP Agent, the Login window is displayed. If this window is not displayed, select File > Station Login from the Avaya IP Agent main window.
   
   Avaya IP Agent displays the Login window for your IP Endpoint configuration.
2. In the **Extension** field, enter your extension, which has been administered for Avaya IP Agent on the Avaya communication server.

3. In the **Password** field, enter the numeric password for the specified extension.

4. In the **Configuration** field, select the appropriate IP Endpoint configuration.

5. Do one of the following steps based on your IP Endpoint configuration:

<table>
<thead>
<tr>
<th>Telecommuter / Road Warrior / Avaya Telephone</th>
<th>IP Telephone</th>
</tr>
</thead>
<tbody>
<tr>
<td>In the <strong>Call Server Address</strong> field, enter the IP Address or name of the Avaya communication server.</td>
<td>In the <strong>Telephone IP Address</strong> field, enter the IP address of your IP telephone. Alternatively, select the <strong>Discover</strong> button to query the Avaya communication server for the IP address of the specified extension.</td>
</tr>
</tbody>
</table>

6. Depending on the type of IP Endpoint configuration you are using, ensure that the correct information is specified in the appropriate field:

- **Telephone At** (Telecommuter) - This is the telephone or extension number that will receive incoming calls. This number cannot be the same as the number entered in the **Extension** field. The Avaya communication server administrator will have created a new extension to support voice communication.

- **Bandwidth Setting** (Road Warrior) - Select a bandwidth that is available through the network connection for this personal computer.

- **Dialing Location** - Select the entry that contains the appropriate telephony properties for your current location.

7. If you do not want to enter your password each time you register with the Avaya communication server, place a check mark in the **Remember password for next login session** check box. If you are concerned with the possibility of unauthorized persons registering as this extension, leave this check box blank.

8. If you want to automatically register with the Avaya communication server when Avaya IP Agent is started at a later time, enable the **Automatically log in if possible when application restarts** check box. You must have successfully registered with the Avaya communication server at least once in the past to use this option.

9. Select the **Login** button. When you successfully register with the Avaya communication server, the controls in the Avaya IP Agent main window are enabled.
10. If you are using the Telecommuter or IP Telephone configuration, do the appropriate action shown in the following table:

<table>
<thead>
<tr>
<th>Telecommuter</th>
<th>IP Telephone</th>
</tr>
</thead>
<tbody>
<tr>
<td>Avaya IP Agent displays the <strong>Verify Telephone Number</strong> dialog box upon successful registration with the Avaya communication server. When you first start using Avaya IP Agent, it is important that you make some test calls to verify that you have set up your connection properly.</td>
<td>Press # on the IP telephone key pad to allow Avaya IP Agent to log in to the IP telephone.</td>
</tr>
</tbody>
</table>

## Registering while using a VPN

If the VPN feature of Avaya IP Agent has been enabled through the **Login Settings** dialog box, the **VPN Configuration In Effect** dialog box is displayed during all subsequent login attempts to the Avaya communication server:

This dialog box contains the following options:

- **Disable the user of local IP address assigned by the VPN client** - Select this option to deactivate the VPN feature for this and all subsequent login attempts. To re-enable this option, you must follow the steps under **Configuring Avaya IP Agent for VPN configurations** on page 95.

- **Change the local IP address used by this application** - With this option, the VPN feature remains active. However, you can change the IP address that will be used by the VPN client.

- **Continue with the current settings** - Select this option to retain the current IP address settings for the VPN client and continue the login process.
Running Avaya IP Agent

When you have selected the appropriate option, press the **OK** button to continue the login process.
Logging in as an agent (EAS)

After registering with the Avaya communication server, you can, as an extension, receive calls through Avaya IP Agent. However, to receive calls from a skill, you need to log in as an agent of that skill. This section provides the procedure for logging in to Avaya IP Agent as an agent. This procedure is for logging in to Avaya communication servers that use the Expert Agent Selection (EAS) feature.

Steps for logging in (EAS)

To log in to Avaya IP Agent as a member of an ACD skill:

1. In the Avaya IP Agent window, select the Login button.
   
   Avaya IP Agent displays the Agent Login dialog box.

2. In the Agent Login dialog box, enter your agent number and password in the appropriate fields.

3. Select the Login button.
   
   If you are using the Telecommuter, Avaya Telephone, or IP Telephone configuration, the extension specified in the Login window will ring. For Road Warrior (VoIP) and Avaya CallMaster VI configurations, a line appearance will be created.

   **Note:**
   
   If you do not answer your telephone immediately or if you entered the wrong number for the voice connection, Avaya IP Agent displays an error message. Acknowledge the error message by selecting the OK button and then repeat the login procedure.

4. Answer the telephone.
   
   You will hear a confirmation tone, the buttons on the agent toolbar are enabled, and you will be automatically put in the AUX-work mode.
5. To leave the AUX-work mode, select either the **Auto-In** or **Manual-In** button.

For more information about **Auto-In** and **Manual-In** work modes, see [Selecting an agent work mode](#) on page 128.

You are now ready to begin receiving and making calls.
After registering with the Avaya communication server, you can, as an extension, receive calls through Avaya IP Agent. However, to receive calls from a split, you need to log in as an agent of that split. This section provides the procedure for logging in to splits through Avaya IP Agent. This procedure is for logging in to Avaya communication servers that do not have the Expert Agent Selection (EAS) feature.

Before you begin

In order for an agent to be able to log in to a split, Avaya IP Agent must be configured to support a non-EAS Avaya communication server. To change the Avaya IP Agent configuration:

1. Select Tools > Program Options.
2. From the Program Options window, select the ACD Agent item from the list box.
3. Remove the check mark from the Configure program for EAS agent support check box.
4. Ensure that a check mark is present in the Prompt for agent ID and password during agent login check box.

Note:
If this feature is not enabled, you must enter your agent ID and password through the telephone key pad.

5. Select the OK button.
6. Close Avaya IP Agent by selecting File > Exit from the main window.
7. Restart Avaya IP Agent.

Steps for logging in (non-EAS)

To log in to Avaya IP Agent as a member of an ACD split:

1. In the Avaya IP Agent window, locate the Agent toolbar. This toolbar lists the splits assigned to this station.

   If this toolbar is not visible, select View > Toolbars > Agent.

2. On the Agent toolbar, select the split you want to log into.

   Avaya IP Agent displays a menu with a Login option.
3. Select the **Login** option.
   
   Avaya IP Agent displays the **Agent Login** dialog box.

4. If your extension requires a password, enter the password for this split.
   
   If you are logging in to a split that consists of only one or two digits, you may be required to place one or more zeros in front of the split number. This is dependent on the configuration of your Avaya communication server. See the documentation for your Avaya communication server.

5. Select the **Login** button.

6. Select the split from the Agent toolbar again.

7. Select the appropriate work mode from the resulting menu.

8. For each split you want to log in to, repeat this procedure.

   An agent can log in to a total of four splits.

   ![Agent Login Dialog Box]

   **Figure 1.** Agent Login Dialog Box

---

120 Avaya IP Agent Installation and User Guide
Logging out of Avaya IP Agent

This section provides the procedure for logging out of Avaya IP Agent as an agent.

Steps

To log out of Avaya IP Agent:

1. Select the **Logout** button on the agent toolbar, or select **Agent > Agent Logout** from the menu bar.
   
   If the Avaya communication server has been configured to require logout reason codes, Avaya IP Agent displays a prompt in the status bar for entry of the reason code.

2. Enter your logout reason code through the keyboard or the **Dial Pad**.


Exiting Avaya IP Agent

This section provides the procedure for exiting the Avaya IP Agent application.

Steps

To exit Avaya IP Agent and log out of the Avaya communication server:

1. After you have logged out as an agent, select **File > Exit** from the main window.

   The Avaya IP Agent main window closes and your extension is logged out of the Avaya communication server.
Using alternate user interfaces

This section provides information and procedures for the alternate user interfaces that are available in Avaya IP Agent.

In many contact center environments, agents use many different applications simultaneously. This can lead to overlapped application windows on the Windows desktop. This can cause difficulties in accessing or using the necessary application windows quickly and efficiently. To help overcome this problem, Avaya IP Agent provides three alternate user interfaces that use much less space on the Windows desktop than the default main window. The following figure compares interface size:

Note:
The procedures in this document are written for the default main window. You will not be able to exactly follow these procedures when you are using an alternate user interface. However, the Program Menu button on the right side of the interface allows you to access the most commonly used features in Avaya IP Agent. Also, the shortcut key combinations for Avaya IP Agent do not function while you use an alternate user interface.

AutoAnswer interface

This interface uses the least amount of space, and is intended for agents using the Auto-In and Auto-answer features. Call-handling buttons, such as Transfer, Hold, and Release are present. Buttons for agent work modes and Avaya IP Agent features are not available in this interface.
Mini interface

This interface is slightly wider than the AutoAnswer interface and is intended for the contact center agent who determines the necessary work mode, such as AUX (Auxiliary Work) and ACW (After-Call Work). In addition to the call-handling buttons, this interface also contains buttons for any agent work modes assigned to this extension.

Titlebar interface

When an agent is on a call, this interface is the largest of the alternate interfaces. It includes call-handling buttons, agent work modes buttons, and buttons used to access other Avaya IP Agent features, such as the Phone Directory and Call History window.

Selecting an alternate interface

This section provides the steps for selecting one of the three alternate user interfaces available with Avaya IP Agent.

Steps

To select an alternate user interface.

1. From the Avaya IP Agent main window, select View > Alternate Interfaces.
2. From the branching menu, select the interface that you want to use:
   - AutoAnswer
   - Mini Interface
   - Titlebar

Avaya IP Agent displays the selected interface.
Using alternate user interfaces

Accessing features

To access Avaya IP Agent features that are not represented by a button, click the **Program Menu** button on the far right side of the interface. A menu containing login and logout options, work modes, online help items, and features is displayed.

Returning to the main interface

To return to the Avaya IP Agent main window from an alternate user interface, click the Maximize button next to **Program Menu** button on the right side of the interface.

Removing alternate user interfaces

If you do not want these interfaces available for use, remove all files located in the following directory:

```plaintext
<install-directory>\Avaya\Avaya IP Agent\Skins
```

If you want only one interface available to agents, leave that file in the `\Skins` directory and delete the other files.

**Note:**

Avaya IP Agent cannot recreate these files once they have been deleted.

Renaming alternate user interfaces

If you want to change the name of an alternate user interface, rename the necessary file in the following directory:

```plaintext
<install-directory>\Avaya\Avaya IP Agent\Skins
```
Note:
Because the names of these menu items are derived from actual filenames, these items will appear in English for international versions of Avaya IP Agent. To cause these menu items to appear in a specific language other than English, you must use a language-specific version of Windows and then rename the files as needed.
Chapter 7: Avaya IP Agent basic operations

This chapter contains information on the basic operations of Avaya IP Agent.

This chapter includes the following topics:

- **Selecting an agent work mode** on page 128
- **Handling incoming calls** on page 130
- **Transferring a call** on page 137
- **Conferencing calls** on page 141
- **Handling outgoing calls** on page 146
Selecting an agent work mode

During the course of placing calls, receiving calls, and performing work associated with those calls, work modes are used to indicate the availability of the agent or the work being performed.

Definitions of agent work modes

Auto-In and Manual-In

The **Auto-In** and **Manual-In** buttons are used to place an agent in the AVAIL (Available) work mode so that the agent can receive calls.

If an agent is in **Auto-In** mode and completes a call, the agent is automatically available to receive another call, or can be placed in After-Call Work (ACW) mode for an administered length of time. When the timed ACW interval expires, the agent is automatically returned to available status. If the agent tries to change agent modes while active on a call, the change is not made until the agent disconnects from the call.

If the agent is in **Manual-In** mode and completes a call, the agent is automatically placed in After-Call Work (ACW) mode. To become available to receive another ACD call, the agent must manually select the **Auto-In** or **Manual-In** mode. If the agent tries to change agent modes while not on an active call, the change takes place immediately.

**ACW (After-Call Work)**

Agents use this work mode to indicate that tasks related to the previous call are being performed. This button is not usually used in conjunction with the **Auto-In** feature because agents with the **Auto-In** feature are made available for a new call when the current call is completed.

This work mode can be selected while the agent is on an active call. The change will not occur until the current call is finished and released. This work mode may not function correctly if the agent uses it while in **Auto-In** mode.

**AUX (Auxiliary Work)**

Agents use this work mode to indicate that they cannot receive calls. Usually, this indicates that the agent is not in the proximity of the telephone because of meals, approved periods of inactivity, meetings, training, and so forth.
It is possible for multiple Auxiliary Work modes to be assigned to an extension as each can possess a different reason code to indicate the various situations that an agent cannot receive calls.

This work mode can be selected while the agent is on an active call. The change will not occur until the current call is finished and released.

---

### Changing work modes

The agent work modes can be changed through the following methods:

- Using shortcut keys - See Shortcut keys on page 245.
- Selecting the associated work mode button on the agent toolbar - See Agent toolbar on page 206.
- Selecting the work mode from the Avaya IP Agent System Tray icon - See System Tray icon on page 210.
- Selecting the work mode from the Agent menu in the main window - See Agent menu on page 201.

**Note:**

When a work mode is active, the timer, which is displayed in the Call Information Panel, displays the total time that the agent has been in the selected work mode. To disable this timer, see How to remove the call timer on page 265.
Handling incoming calls

This section describes those functions that you will be using every day when you receive an incoming call at your station, including answering a call and holding a call.

This section includes the following topics:

- **Answering a call** on page 130
- **Holding a call** on page 134
- **Releasing a call** on page 135
- **Dropping a call** on page 136

Answering a call

Answering a call depends on how the Avaya communication server and the network are administered. Each contact center environment is different, which can affect the way agents answer calls. Avaya suggests that each contact center evaluate its configuration and instruct agents on the best way to answer calls with Avaya IP Agent. There are too many possible Avaya IP Agent configurations to list them in this document. The following are some suggested procedures on answering calls for different configurations.

Telecommuter

**Configuration settings for Telecommuter**

The following list provides the options to set for this configuration:

- Agent Administration for auto-answer is set to station or none.
- Station Administration for auto-answer is set to none.
- Station Administration has service link set to as-needed.
- Each time a call is received, the analog or DCP telephone that provides the voice path will ring. The personal computer will also emit a ringing sound if you have configured Avaya IP Agent to do so.
- Your Central Office (CO) must have the Answer Supervision feature. Contact your telecommunication provider for more information.

**Steps for answering Telecommuter calls**

To answer a call for this configuration:

1. The agent should wait for the telephone to ring and then answer it. Answering of the telephone will automatically be detected through Avaya IP Agent.
2. After the call is completed and the calling party disconnects from the call, or after the agent selects **Release** for that call, the agent should hang up the telephone if no more calls are ringing on the Avaya IP Agent screen.

3. If there is another incoming call indicated on the screen, the agent should not hang up the telephone, but select the **Answer** button for the new call appearance on the Avaya IP Agent screen. The agent is then connected to the new call. The previous call is placed on hold.

**Note:**

If an incoming call is displayed in the Avaya IP Agent main window before the telephone rings, the agent must wait for the telephone set to ring before answering.

---

**Telecommuter (Auto-Answer)**

**Configuration settings for Telecommuter (Auto-Answer)**

The following list provides the options to set for this configuration:

- Agent Administration for auto-answer is set to **station**, **ACD**, or **all**.
- Station Administration for auto-answer is set to **ACD** or **all**.
- Station Administration has the service link set to **permanent**.
- During the event of agent login, the telephone will ring to deliver the login confirmation tone.

**Steps for answering Telecommuter (Auto-Answer) calls**

To answer a call for this configuration:

1. The agent should answer the telephone and do not return it to the on-hook state for the remainder of the shift for that agent.

   If the telephone is accidentally cut off or placed on-hook, the Avaya communication server rings the telephone when it has a call to deliver. The agent must answer by picking up the handset.

2. As with any auto-answer telephone, the Avaya communication server will provide a **zip tone** (a beep) to signal that a new call has arrived.
Road Warrior and CallMaster VI

Configuration settings for Road Warrior and CallMaster VI

In this configuration, the Auto-Answer feature is not active.

Steps for answering Road Warrior and CallMaster VI calls

To answer a call for this configuration:
1. A caller places a call to the contact center and is routed to a specific extension.
   Avaya IP Agent displays a call appearance in a Call Information Panel (CIP) in the main window.
2. The agent should select the Answer button on the new CIP.
   The call is connected and the agent can begin conversing with the calling party.

Road Warrior and CallMaster VI (Auto-Answer)

Configuration settings for Road Warrior and CallMaster VI (Auto-Answer)

In this configuration, the Auto-Answer feature is enabled.

Steps for answering Road Warrior and CallMaster VI (Auto-Answer) calls

To answer a call for this configuration:
1. A caller places a call to the contact center and is routed to a specific extension.
   Avaya IP Agent displays a call appearance in a Call Information Panel (CIP) in the main window.
2. Avaya IP Agent automatically answers the call without any action from the agent, who can then begin conversing with the calling party.
IP Telephone and Avaya Telephone

Configuration settings for IP Telephone and Avaya Telephone

The following list provides the options to set for this configuration:

● Agent Administration for auto-answer is set to station or none.
● Station Administration for auto-answer is set to none.
● Station Administration has service link set to as-needed.
● Each time a call is received, the telephone that provides the voice path rings. The personal computer also emits a ringing sound if you have configured Avaya IP Agent to do so.
● Your Central Office (CO) must have the Answer Supervision feature. Contact your telecommunication provider for more information.

Steps for answering IP Telephone and Avaya Telephone calls

To answer a call for this configuration:

1. The agent should wait for the telephone to ring and then answer it. Answering of the telephone will automatically be detected through Avaya IP Agent.

2. After the call is completed and the calling party disconnects from the call, or after the agent selects Release for that call, the agent should hang up the telephone if no more calls are ringing on the Avaya IP Agent screen.

3. If there is another incoming call indicated on the screen, the agent should not hang up the telephone, but select the Answer button for the new call appearance on the Avaya IP Agent screen. The agent is then connected to the new call. The previous call is placed on hold.
Holding a call

You can put a call on hold by using either the Auto Hold or Manual Hold feature. When a call is on hold, the text on the button for the associated Call Information Panel (CIP) changes to **Reconnect**.

Using Manual Hold

To perform a Manual Hold, select the **Hold** button on the Phone Button toolbar. For those using the Telecommuter configuration or the IP Telephone configuration, you may also place a call on hold by pressing the **Hold** button on the telephone, if it is so equipped.

Using Auto Hold

The Auto Hold feature does not require pressing a **Hold** button. If you change to a second call appearance, the first call is automatically placed on hold.

Reconnecting to a call on hold

To reconnect to a call that is currently on hold, select the **Reconnect** button on the appropriate CIP. Alternatively, you may re-select the **Hold** button in the main window.
Releasing a call

There are different methods for releasing a call. These methods will work only if the Release feature has been administered for your station.

Steps for releasing a call

To release a call:

1. Do one of the following actions:
   - While on an active call, select the **Release** button that is located on the Call Information Panel (CIP). You will not hear a dial tone after you select the **Release** button.
   - Select the **Release** button that is located on the Phone Button toolbar.
   - If you are using an Avaya CallMaster VI, press the **Release** button on the telephone.
   - If you are using Telecommuter or IP Telephone configuration, you may hang up the handset.
   - Select the **Release** item in the **Phone Features** window.

2. If you have a call on hold, you must first reconnect to it before you can release the call.

In the example below, you would have to reconnect to extension 1048 before you could release it.
Dropping a call

Use the Drop feature when you want to disconnect from a normal call or drop the last party added to a conference call.

To drop a call, select the **Drop** button located on the Phone Button toolbar. You are then disconnected from the call and hear a dial tone.
Transferring a call

This section describes the following methods of transferring calls:

- Basic call transfer on page 137
- Unsupervised call transfer on page 138
- Enhanced call transfer on page 139

Before you begin

Read and understood the following items before using the procedures described in this topic:

- The Transfer button on the Phone Buttons toolbar can be configured for Basic, Unsupervised, or Enhanced transfer. Use the Call Handling screen in the Program Options dialog box to set this option. You can also choose a type of transfer that is different from the default, by selecting Call > Transfer from the menu bar.

- If all of your call appearances are currently in use, you can transfer a call only to an existing call appearance, not to a new telephone number.

- If you enable the Abort Transfer or Abort Conference feature on your Avaya communication server, Avaya IP Agent cannot transfer or conference between active call appearances.

Basic call transfer

Use the Basic Transfer feature to send an active call to another extension or telephone number. With this type of transfer, you enter the number to receive the transfer through the keyboard and then announce the call to the receiving party.
Steps for a Basic Transfer

To transfer a call using Basic Transfer:

1. While you are on an active call, select **Call > Transfer > Basic Transfer** from the menu bar.

The current call is automatically put on hold, a new Call Information Panel (CIP) is displayed, and a dial tone is heard.

2. Using the keyboard or **Dial Pad**, enter the number of the party to receive the transferred call.

3. When the receiving party answers, you can privately talk to the party and then select **Basic Transfer** again to complete the transfer.

Both CIPs are no longer displayed in the main window, indicating that the transfer was successful.

You can complete the transfer at any time after the number is entered, either during the ringing state or after the second party answers.

You can change this call transfer into a conference by selecting **Basic Conference** instead of **Basic Transfer**.

4. If there is no answer, the line is busy, or you decide the transfer is not needed, do the following steps to cancel the transfer:
   - Select the **Release** button associated with the receiving party. This action terminates the call to the receiving party.
   - Return to the call on hold by selecting the **Reconnect** button on the associated CIP.

Unsupervised call transfer

Use the Unsupervised Transfer feature to transfer an active call to another extension or telephone number by entering the number of the receiving party into a dialog box. Announcement of the call to the receiving party is not available in this mode.
Steps for an Unsupervised Transfer

To transfer a call using Unsupervised Transfer:

1. While you are on an active call, select Call > Transfer > Unsupervised Transfer.
   Avaya IP Agent displays the Unsupervised Transfer dialog box.

2. In the available field, enter the number to receive the current call.
3. Select OK to transfer the call.
   Unlike the basic transfer, you do not have to select Transfer a second time to complete the transfer.
   The Call Information Panel (CIP) will disappear from the main window which indicates that the transfer was successful.

Enhanced call transfer

Use the Enhanced Transfer feature to transfer the active call to another extension or telephone number by entering the number of receiving party into a dialog box. With this mode, you have the ability to transfer the call directly without announcing it to the receiving party or you can wait to announce the call and then decide whether to transfer the call.

Steps for an Enhanced Transfer

To transfer a call using enhanced transfer:

1. While you are active on a call, select Call > Transfer > Enhanced Transfer.
   Avaya IP Agent displays the Enhanced Transfer dialog box.

2. In the available field, enter the number of the receiving party.
3. Select the **OK** button.

   The caller is automatically put on hold, a new Call Information Panel (CIP) is displayed, a dial tone is heard, and Avaya IP Agent displays a confirmation dialog box.

   ![Confirmation Dialog Box]

   If you need to enter digits, such as answering prompts, use the number pad on the right side of this dialog box. If you are on hold or are delayed for some reason, you can return to the original call without losing this call by selecting the **Switch to call on hold** button and select this button again to return to the transfer.

4. Remain on the line and wait for an answer.

5. Perform one of the following actions:

<table>
<thead>
<tr>
<th>If...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>The number dialed is answered</td>
<td>Announce the call and select the <strong>OK</strong> button in the confirmation dialog. Both CIPs are no longer displayed in the main window, indicating that the transfer was successful.</td>
</tr>
<tr>
<td>The number dialed is not answered or is busy</td>
<td>Select the <strong>Cancel</strong> button in the confirmation dialog and select the <strong>Reconnect</strong> button on the appropriate CIP to return to the held call.</td>
</tr>
</tbody>
</table>
Conferencing calls

This section provides information and procedures for conferencing multiple calls together so that all parties can communicate simultaneously.

This section contains the following topics:

- **Basic Conference** on page 141
- **Enhanced Conference** on page 143

**Note:**

If all of your call appearances are currently in use, you can conference only with existing call appearances, not new telephone numbers.

---

**Basic Conference**

Use the Basic Conference feature to connect multiple calls together so that all parties can communicate simultaneously. With this method, you use the numbers on the keyboard or the **Dial Pad** to enter the telephone numbers to conference together.

**Steps for using Basic Conference**

To conference a call using Basic Conference:

1. While you are active on a call, select **Call > Conference > Basic Conference**.

![Basic Conference Interface]

The current call is automatically placed on hold, a new Call Information Panel (CIP) is displayed, and a dial tone is heard.

2. Use the keyboard or **Dial Pad** to enter the number of the party you want to add to the conference call.
3. When the second party answers, you can privately talk to the second party and then select **Basic Conference** again to initiate the conference call.

You may initiate the conference when the number is entered, during the ringing state, or after the second party answers.

One CIP is displayed in the main window, which displays **CONFERENCE 2**. indicating that a conference is active.

![Conference 2 Window]

You may change the conference call into a transfer by selecting **Basic Transfer** instead of **Basic Conference** in Step 3.

4. Repeat the previous steps until you have conferenced all parties.

The single CIP displays **CONFERENCE X**, where X equals the number of parties participating in the call.

**Example:**

If you added three parties to the call, the CIP displays **CONFERENCE 3**.

![Conference 3 Window]

5. If there is no answer, the line is busy, or you decide the conference is not needed:

   - Select the **Release** button associated with the party that was going to be added to the conference.
   - Return to the held call by selecting the **Reconnect** button on the associated CIP.
Enhanced Conference

Use the Enhanced Conference feature to connect multiple calls together by entering the extensions or telephone numbers through a dialog box and then adding them to an active call.

Steps for using Enhanced Conference

To add a party to a current call, perform the following steps:

1. While you are on an active call, select **Call > Conference > Enhanced Conference**.
   
   Avaya IP Agent displays the Enhanced Conference dialog box.

   One call appearance

   ![Enhanced Conference dialog box for one call appearance]

   Note:
   
   The dialog box you see may be different because it depends on the number of call appearances that are present. If all available call appearances are active, the dialog box does not have a **New Number** field. If only one call appearance is active, the dialog box does not display the **Existing Call** field.

2. In the **New Number** field, enter the extension or telephone number of the party you want to add to the active call.

   Note:
   
   If you have only one call appearance, the field in which you provide a telephone number is not labeled.
3. Select the **OK** button.

The current call is automatically placed on hold, a new CIP is displayed, a dial tone is heard, and Avaya IP Agent displays a confirmation dialog box.

If you need to enter digits, such as answering prompts, use the number pad on the right side of this dialog box. If you are on hold or are delayed for some reason, you can return to the original call without losing this call by selecting the **Switch to call on hold** button and select this button again to return to the conference.

4. When you decide to add the call to the conference, select the **OK** button. If there is no answer, the line is busy, or you decide to cancel the conference, select the **Cancel** button.

If you selected the **Cancel** button, select the **Reconnect** button on the CIP associated with the original call.

5. If you selected the **OK** button, wait for an answer.

<table>
<thead>
<tr>
<th>If...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>The number dialed is answered</td>
<td>You can privately talk to the new party and then select the <strong>OK</strong> button in the confirmation dialog to add the party to the call. One CIP is displayed in your main window, which displays <strong>CONFERENCE 2</strong>, indicating that a conference is active.</td>
</tr>
<tr>
<td>The number dialed is not answered or is busy</td>
<td>Select the <strong>Cancel</strong> button in the confirmation dialog and then select the <strong>Reconnect</strong> button to return to the original call.</td>
</tr>
</tbody>
</table>

6. Repeat the previous steps until you have conferenced all parties.

The single CIP displays **CONFERENCE X**, where **X** equals the number of parties participating in the call.
Example:

If you added three parties to the call, the CIP displays **CONFERENCE 3**.

Any person on the conference call can hang up at any time.

7. To disconnect the last person added to the conference call, select the **Drop** button.

8. When the conference call is over, select the **Release** button.

The CIP is removed from the main window.
Handling outgoing calls

There are several ways you can make the handling of outgoing calls more efficient. You can use a Recent Calls list, a Speed Dial number, or an Abbreviated Dial button.

Note:
In the Phone Directory, you may notice that all telephone numbers are prefixed with a "+1" (in the United States). All external telephone numbers are displayed in the Phone Directory in canonical format, as seen in the following example:
+1 (800) 555-1234

This format is universally constant and allows this number to be dialed from anywhere in the world. This number is dialed only if deemed necessary through the Dialing Properties of your personal computer.

For example, a user with a laptop may have two or more sets of Dialing Properties configured. In the office, one set of Dialing Properties cause a number, sometimes a "9", to be dialed to access an external line. Alternatively, the same laptop could have a Dialing Properties set that does not use an external line number for when the user is at home or traveling. The format of telephone numbers in the Phone Directory ensures that all of these configurations will work without having to change the format.

This section includes the following topics:
- Recent Calls list on page 146
- Using the Phone Directory on page 147
- Administering and using Speed Dial on page 151
- Abbreviated Dial button on page 153

Recent Calls list

You can quickly dial or re-dial recent incoming or outgoing calls by using the Recent Calls list. Telephone numbers are not duplicated in the list, so if the last ten calls are to the same number, the number is displayed only once in the list. Only those calls with valid telephone numbers are added to the list.
Before you begin

Before using the Recent Calls list, read and understand the following items:

- You or your system administrator can control the number of recent call numbers displayed by setting that number in the Program Options dialog box.
- The list can show a maximum of the last 25 unique numbers recorded in the Call History log. Abbreviated Dial buttons or numbers dialed on active calls (pin numbers) are not included in the list.
- Letters that are dialed, for example, 1800GOAVAYA, are displayed in the recent calls list as letters, not as the associated numbers.

Steps for using the Recent Calls list

To make a call using the Recent Calls list:

1. Select the down arrow next to the Call History button.
   
   Avaya IP Agent displays a list of previously dialed and received numbers.

2. Select the number you want Avaya IP Agent to dial.
   
   A call appearance is created and the selected telephone number is dialed.

Using the Phone Directory

The Phone Directory feature stores contact information that you provide. Through this interface, you can dial telephone numbers and send e-mail messages to those contacts that you have defined.

The Phone Directory stores the types of information shown in the following list:

- Name
Menu bar

The following is a list of menus and menu items available for the Phone Directory window:

**File**
- **New** - This item displays the Properties dialog and allows entry of a new contact.
- **Import**
  - **Text File (Comma Separated Values)** - This item allows you to import a .csv file containing contacts and their associated information.
- **Export** - This item exports the Phone Directory to a comma-separated value file (.CSV)

**Note:**
The entries for the comma-separated values are listed below in the order that they are displayed:
- Name
- Address
- Email
- Business
- Business Fax
Handling outgoing calls

- Home
- Home Fax
- Mobile
- Assistant
- Car
- Company
- Pager
- Pronunciation (Japanese version only)

Each item must be enclosed within quotation marks.

- **Search Public Directory** - This item opens the **Search Public Directory** window, which can be used to search for contact information through an Lightweight Directory Access Protocol (LDAP) service. Entries can be added to the **Phone Directory** from the **Search Public Directory** window. For more information on this feature, see Using a Public Directory with Avaya IP Agent on page 167.

- **Close** - Selecting this item closes the **Phone Directory** window.

**Edit**

- **Name, Number, Email, Category** - Edit the displayed information for the selected contact.
- **Delete** - Delete the selected contact.
- **Properties** - View all information for the selected contact.
- **Categories** - Add, delete, or modify the categories defined in the **Phone Directory**.
- **Field Organizer** - Organize the fields displayed in the **Phone Directory**.

**View**

Use this menu to determine how the entries appear in the **Phone Directory** window. These items are similar to those used in Windows Explorer: **Large Icons**, **Small Icons**, **List**, and **Details** (default).

**Action**

- **Call: (name)** - Select this menu item to initiate a telephone call to the highlighted contact.
- **Send Email** - Select this menu item to initiate an e-mail message to the highlighted contact.

**Toolbar**

The toolbar of the **Phone Directory** window contains the following controls:
Avaya IP Agent basic operations

- **Name** - This field allows the dynamic filtering of the entries in the Phone Directory on any field. Select the name button to display the list of fields available for the Phone Directory. After you select the field on which to filter, enter letters or digits in the corresponding field. Each character entered in this field causes only those entries matching the filter to remain visible. For example, entering the letter S causes all entries that do not begin with that letter to be hidden. For numeric fields, any numbers entered in this field are used to filter the entries. The filtering for numeric fields is not sequential. Any entries that contain the string of numbers entered will remain visible. Additionally, any punctuation existing in the entry is ignored. For example, entering the numbers 123 would match against the following entries:
  - (555) 555-1234
  - (800) 123-5555
  - 1 (230) 555-5555
  - 512-3555

- **Dial Number** - Select this button to dial the telephone number of the highlighted entry.
- **Send Email** - Select this button to open an e-mail message to the highlighted entry.
- **Properties** - Select this button to display a dialog box containing the details of the highlighted entry. This dialog box also allows modification of this information.
- **Delete** - Select this button to delete the highlighted entry.
- **New entry** - Select this button to display the Properties dialog and enter the information for a new contact.
- **Categories** - Select this button to display a list of all categories defined in the Phone Directory and to filter the existing contacts. Selecting one of the categories in this list results in only those contacts assigned to that category remaining visible.

**Phone Directory window usage**

Within the Phone Directory window, you can perform the following actions on a selected contact:

- With the mouse, right-click on an entry to display a pop-up menu containing the following items:
  - **Call (contact)** - Initiates a call to the selected contact.
  - **Send Email** - Initiates an e-mail to the selected contact.
  - **Delete** - Removes the selected contact from the Phone Directory.
  - **Properties** - Displays a dialog box listing all information for the selected contact. This dialog box also allows editing of that information.

- Press the **Enter** key or double-click the mouse to initiate a call to a contact.
- Press **Alt + Enter** to display all information for the selected contact.
Press the **Delete** key to remove the selected contact from the **Phone Directory**.

You can also sort the entries in the **Phone Directory** by clicking the title of any column. The sorting is done based on the column selected and alternates between ascending to descending order with subsequent clicks.

**More information**

The following topics provide additional information on the use of the **Phone Directory** window:

- **Administering and using Speed Dial** on page 151
- **Searching a Public Directory** on page 170

---

**Administering and using Speed Dial**

Use the Speed Dial feature to dial frequently-used telephone numbers by selecting entries from the Speed Dial list or by pressing function keys (F2-F8) on the keyboard. Entries in the **Phone Directory** can be assigned as Speed Dial numbers. A maximum of 25 telephone numbers can be assigned to the Speed Dial list.

**Steps for assigning a Speed Dial number**

To assign a telephone number in the **Phone Directory** to the Speed Dial list:

1. In the Avaya IP Agent main window, select **Tools** > **Phone Directory**.
   
   Avaya IP Agent displays the **Phone Directory** dialog box.

2. Enter or edit the appropriate information in the **Properties** dialog box.

2. Enter or edit the appropriate information in the **Properties** dialog box.

<table>
<thead>
<tr>
<th>If...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>You are creating a new entry</td>
<td>Select <strong>File &gt; New...</strong> from the menu bar.</td>
</tr>
<tr>
<td>You are editing an entry</td>
<td>Highlight the entry and select <strong>Edit &gt; Properties</strong> from the menu bar. Avaya IP Agent displays the <strong>Properties</strong> dialog box.</td>
</tr>
</tbody>
</table>
Avaya IP Agent basic operations

4. Place a check mark in the **Speed Dial** check box next to the telephone number that you want to use as a Speed Dial number.

   Avaya IP Agent displays the **Speed Dial Function Keys** dialog box.

   ![Screen capture of Speed Dial Function Keys dialog box]

5. If you want to have the telephone number for this **Phone Directory** entry available when a function key, such as F2, F3, ..., F8, is pressed, select the **Assign this number to a function key** option.

   The **Phone Directory** entry appears in the **F2** row.

   **Note:**

   If you want to assign this new entry to another function key, highlight it and use the up and down arrow icons in the dialog box to move the entry to a new location in the list.

6. When you are satisfied with the function key that this number has been assigned to, press the **OK** button.

7. In the **Properties** window, select the **OK** button to close it.
Using a Speed Dial number

To select a Speed Dial number:

1. Select the down arrow next to the Phone Directory button in the Avaya IP Agent main window.

   Avaya IP Agent displays the Speed Dial Numbers list.

2. Select the party that you want to call.

   A call appearance is created and the telephone number is dialed.

   **Note:**
   
   If you have assigned a Phone Directory entry to a function key, you can simply press that function key to dial the associated telephone number.

---

Abbreviated Dial button

If the Abbreviated Dial feature has been administered on the Avaya communication server for your extension, you can store telephone numbers in the Phone Features window for quick and easy dialing. Each number can be a complete or partial telephone number, an extension number, a trunk, or feature code.

**Steps for using Abbreviated Dial**

To make a call using an Abbreviated Dial button:

1. Select **Tools > Phone Features**.

   Avaya IP Agent displays the Phone Features window.
2. In the **Phone Features** dialog box, select the Abbreviated Dial button associated with the number you want to dial.

A call appearance is created and the selected telephone number is dialed.

The button label for an Abbreviated Dial is a number, whereas the button label for an autodial button is the word *autodial* plus the number. This difference is shown in the following table:

<table>
<thead>
<tr>
<th>Abbreviated Dial</th>
<th>Autodial</th>
</tr>
</thead>
<tbody>
<tr>
<td>51008</td>
<td>autodial 51008</td>
</tr>
</tbody>
</table>
Chapter 8: Agent Greetings

This section provides information and procedures for the creation and use of agent greetings through Avaya IP Agent.

The Agent Greetings feature frees you from having to repeatedly say the same greeting at the beginning of each call. When a call is answered, your microphone is muted and the selected greeting is played. After the greeting is played, your microphone is un-muted and you are able to talk to the calling party.

Additionally, it is possible to configure agent greetings to play only for specific telephone numbers or VDNs from which calls originate.

This chapter includes the following topics:

- Creating agent greetings on page 157
- Setting the active agent greeting on page 158
- Setting activation criteria for agent greetings on page 159
- Deleting agent greetings on page 160

Before you begin

Read and understand the following items before you work with the Agent Greetings feature:

- Avaya IP Agent supports agent greetings for Avaya CallMaster VI endpoints and IP endpoints using the Road Warrior configuration. The Telecommuter configuration can support agent greetings if you use an Avaya Switcher II headset. The IP Telephone and Avaya Telephone configurations do not support agent greetings.

- Agent greetings are stored in different locations, depending on your current Avaya IP Agent configuration.
  - Road Warrior / Telecommuter - You can store the agent greetings on your personal computer or in a network location. These configurations will support up to 15 greetings of 30 seconds each.
  - CallMaster VI - Agent greetings are stored on the CallMaster VI unit and not on the personal computer.

- To view or configure the optional settings for agent greetings, such as configuring the agent greeting to play for a specific VDN or ANI, see Agent Greetings settings on page 235.
Agent Greetings

- If you are using the Avaya Switcher II headset, you must run the Audio Tuning Wizard and enable the **Play greetings via Avaya Switcher II** check box. You must then close and restart Avaya IP Agent for **Agent Greetings** to appear in the **Tools** menu.
Creating agent greetings

This section provides the procedure for recording an agent greeting.

Note:
Before users of the CallMaster VI configuration can record agent greetings, the user must first deactivate the headset by clicking the headset button in the headset toolbar.

Steps for creating an agent greeting

To record an agent greeting:

1. Change to an inactive agent mode, such as Auxiliary Work or After Call Work, to prevent interruptions from incoming calls when you are recording your greeting.

2. From the Avaya IP Agent main window menu bar, select Tools > Agent Greetings. Avaya IP Agent displays the Agent Greetings window.

3. Highlight an agent greeting in the list by clicking on the name.

4. Select the Record button.

5. By using the microphone that is either on your headset or attached to the personal computer, speak your greeting.

6. When you have finished recording your greeting, select the Stop button. Avaya IP Agent enables and updates the selected greeting.
Setting the active agent greeting

This section provides the procedure for setting an agent greeting as the one to play for incoming calls.

Steps for setting an active agent greeting

To set an agent greeting to activate:

1. From the Avaya IP Agent main window menu bar, select **Tools > Agent Greetings**. Avaya IP Agent displays the **Agent Greetings** window.
2. Place a check mark next to the agent greeting that will be used for all incoming calls.

   **Note:**
   There are some circumstances when it is possible to have more than one agent greeting active at the same time. For example, you can set multiple agent greetings to be active if each greeting has a unique VDN as the activation criteria. This is also true for agent greetings that play for specific Automatic Number Identification (ANI) telephone numbers or Prompted Digits. If two agent greetings meet the same criteria so that both would play for a single call, Avaya IP Agent restricts the activation of both agent greetings.

3. Close the **Agent Greetings** window.

   Avaya IP Agent updates the agent greeting toolbar to display the currently active greeting and uses this greeting for all incoming calls.

Alternate method

If you have the Agent Greetings toolbar displayed in the Avaya IP Agent main window, you can use the mouse to click the agent greetings button and, from the resulting menu, select a different agent greeting. This action sets the selected agent greeting as active.
Setting activation criteria for agent greetings

This section provides the procedure for configuring the properties of an agent greeting. These settings include the name, description, and auto-play criteria for the ANI, VDN, or Prompted Digits that will activate the agent greeting.

Steps for setting agent greeting activation criteria

To set the activation criteria for an Agent Greeting:

1. From the Avaya IP Agent main window menu bar, select Tools > Agent Greetings.
   Avaya IP Agent displays the Agent Greetings window.
2. Highlight the agent greeting to modify by clicking on the name.
3. Select the Properties button in the button bar.
   Avaya IP Agent displays the Agent Greetings dialog box for the selected greeting.
4. Use this dialog box to change the settings for this agent greeting. See Agent Greetings settings on page 235 for complete information on the different panels for this dialog box and the associated controls.
Deleting agent greetings

This section provides the procedure for deleting an existing agent greeting.

Steps for deleting an agent greeting

To delete an existing agent greeting:

1. From the Avaya IP Agent main window menu bar, select **Tools > Agent Greetings**.
   Avaya IP Agent displays the **Agent Greetings** window.
2. Highlight an agent greeting in the list by clicking on the name.
3. Select the Delete button which is displayed as an X on the toolbar.
   Avaya IP Agent deletes the selected agent greeting.
Chapter 9: Using VuStats

The VuStats feature is used to pass contact center information from the Avaya communication server to a display on a station or extension. Supervisors and agents use this feature to monitor contact center activity and statistics.

The VuStats window of Avaya IP Agent displays any VuStats buttons that have been assigned to the extension by the communication server administrator.

Using Avaya IP Agent, you will be able to specify how long the program monitors each transmission of VuStats information before it moves to the next one.

This section includes the following topics:

- Configuring an extension for VuStats through the Avaya communication server on page 162
- Viewing a single set of VuStats information in Avaya IP Agent on page 163
- Adjusting intervals for monitoring VuStats on page 164
Configuring an extension for VuStats through the Avaya communication server

For an Avaya IP Agent extension to display VuStats information, the following configurations on the Avaya communication server must be done:

- The extension must be assigned as a telephone type that has a display. Avaya recommends the 8434D or 606A1 telephone types for Road Warrior and Telecommuter configurations.

- The extension must have one or more buttons assigned with the `vu-display` feature. Different streams of VuStats information are available by specifying the `format` and `ID` parameters of the `vu-display` feature.

- For different views and formats, multiple VuStats configurations can be assigned to the buttons for this extension.

Configuration

For information on configuring extensions for the VuStats feature through your Avaya communication server, see the "VuStats" section of Guide to ACD Call Centers.

Definitions and reference material for the VuStats fields on the forms of the Avaya communication server can be found in the Administrator's Guide for your Avaya communication server.
Viewing a single set of VuStats information in Avaya IP Agent

This section provides the procedure for displaying a single set of VuStats information in the Phone Display panel of the Avaya IP Agent main window.

Before you begin

To view VuStats information in the main window of Avaya IP Agent, you must ensure that the Phone Display panel is visible. Select the View menu from the main menu and verify that a check mark next to the Phone Display menu item is present. If a check mark is not present, select the item to enable it.

Before performing this procedure, the VuStats feature must have been assigned to one or more buttons for this extension. See Configuring an extension for VuStats through the Avaya communication server on page 162 for more information.

Steps

To display VuStats in the Avaya IP Agent main window:

1. From the Avaya IP Agent main window menu bar, select Tools > Phone Features. Avaya IP Agent displays the Phone Features window.
2. Select the VuStats information to view by double-clicking the associated entry in the Phone Features window.

Avaya IP Agent displays the selected VuStats information in the Phone Display toolbar of the main window.
Adjusting intervals for monitoring VuStats

When VuStats are being displayed through the VuStats Monitor, you can configure the following time-related items:

- **Refresh Rate** - The period of time that passes before focus is changed from the last line of display in the list to the first line.

- **Display Interval** - The period of time that passes before the VuStats Monitor changes focus from one VuStats line of display to the next one in the list.

Before you begin

You should ensure that you set the VuStats Monitor time intervals so that each line of display can be updated before the Refresh Rate changes focus to the top of the list. For example, if you have six VuStats lines of display in the VuStats Monitor and the Display Interval is set for 10 seconds, your Refresh Rate should be 60 seconds or greater.

**Tip:**
If a VuStats line of display has not been updated before the next VuStats item begins to update, increase the Display Interval delay.

Steps

To change the periods of time used in the VuStats Monitor window:

1. Start the VuStats Monitor.
2. Click the Refresh Rate button on the toolbar of the VuStats Monitor window.
   
   Avaya IP Agent displays a menu with the following time intervals:
   
   - 10 seconds
   - 20 seconds
   - 30 seconds
   - 60 seconds
   - 120 seconds
3. Select the interval that should pass before focus is changed from the last line of display to the first line.
4. Click the **Display Interval** button on the toolbar of the **VuStats Monitor** window.
   Avaya IP Agent displays a menu with the following time intervals:
   - 5 seconds
   - 10 seconds

5. Select the interval that should pass before focus is changed from one line of display to the next line.
   When focus moves to a line of display in the **VuStats Monitor**, the VuStats data for that line is updated.

6. After setting one or both time intervals, click the **Start** button on the toolbar.
   The **VuStats Monitor** window begins displaying VuStats information according to the time intervals specified.
Using VuStats
Chapter 10: Using a Public Directory with Avaya IP Agent

This section provides information and procedures for the Search Public Directory feature of Avaya IP Agent.

This feature provides access to corporate or public directory services which enable you to query those services by any defined field.

The Search Public Directory feature is also called Search LDAP (Lightweight Directory Access Protocol).

⚠️ Important:

Avaya IP Agent does not support the enhancements available in LDAP v3. If you use an LDAP v3 Public Directory service, you must use Avaya IP Agent as an LDAP v2 client.

This section includes the following topics:

- Defining a Public Directory service on page 168
- Searching a Public Directory on page 170
- Selecting the fields to display and the order on page 173
- Identifying multiple telephone number fields on page 175
- Deleting a Public Directory service on page 177
Defining a Public Directory service

So that you can search for information on a Public Directory (LDAP) server by using Avaya IP Agent, a definition of the service must first be created and configured.

Steps for defining a Public Directory service

To define and configure a Public Directory service for Avaya IP Agent:


3. In the following fields, enter the necessary information:
   - **Description** - Enter a name by which you will identify this Public Directory server. This field is required.
   - **Server Address** - Enter the network domain or IP address of the Public Directory server. This field is required.
   - **Login** - If authorization is required by the Public Directory server, enter a valid user name in this field.
   - **Password** - Enter the password for the user name specified in the previous field.
   - **Search Root** - Enter an LDAP format string representing the type of information being sought. For example, `ou=people, o=mycompany.com` specifies that information under the organization unit of "people" within the organization of "mycompany.com" is used for the search. Refer to the documentation for your LDAP server.
system and company database configuration for more information on Base DN or Search Root strings.

If you are unsure of the settings for your Public Directory server, contact the administrator of that system.

4. Select the Advanced tab if changes to the following defaults are required:
   - **Port**: 389
   - **Search timeout**: 200 (secs)
   - **Maximum number of entries returned per search**: 200

5. After entering all necessary information, select the OK button.

   Avaya IP Agent adds this Public Directory to the list of available services and closes the Directory Properties dialog box.
Searching a Public Directory

After a Public Directory service has been defined, a search against that database can now be performed. If a Public Directory service has not been defined, see Defining a Public Directory service on page 168.

Steps for searching a Public Directory

To search a Public Directory service:

1. In the Avaya IP Agent menu bar, select **Tools > Search Public Directory**.
   
   Avaya IP Agent displays the **Search Public Directory** dialog box.

2. To select the Public Directory service to use, start by clicking the Directory Menu button.

   Avaya IP Agent displays a menu listing all defined Public Directory services.

3. From the resulting list, select the Public Directory service that you will use.

   The selected item from the menu is set as the active Public Directory service and the Directory Menu button displays its name.
4. Click the **Name** field to view a list of available fields defined in this Public Directory service.

![Image of Search Public Directory window](image)

**Note:**

If you have not connected previously to the Public Directory service, you must first run a query with the default settings. After this first query, all defined fields of the service will be available.

5. Select the field through which you want to conduct your search. The data field that you select appears as the label.

6. In the field to the right of the label, enter a string to search for within the selected data field and press the Enter key.

Avaya IP Agent sends the query to the Public Directory service, receives the data, and displays it in the **Search Public Directory** window.

![Image of Public Directory window](image)

For example, after setting the data type to **Name**, enter **Smith** in the field and press the Enter key.
Using a Public Directory with Avaya IP Agent

Tip:
You can use an asterisk as a wildcard for a string. For example, entering the string, j*n, returns all names beginning with a J and ending with an N with one or more characters in between. This could include entries such as John, but also entries such as Joseph Brown.

7. Right-click on an entry in the set of resulting data.
Avaya IP Agent displays a pop-up menu for the entry.

8. Select an action from the following table:

<table>
<thead>
<tr>
<th>If...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>You want Avaya IP Agent to dial the number listed for the selected entry</td>
<td>Select <strong>Call</strong>: Name. If you have configured Avaya IP Agent to have multiple telephone numbers for each entry, another pop-up menu is displayed with this list of numbers. From this second list, select the number you want to call.</td>
</tr>
<tr>
<td>You want to compose an e-mail to the address associated with the selected entry</td>
<td>Select <strong>Send Email</strong>.</td>
</tr>
<tr>
<td>You want to view all available data for the selected entry</td>
<td>Select <strong>Properties</strong>. Avaya IP Agent displays the Properties dialog box.</td>
</tr>
<tr>
<td>You want to add this entry to your Avaya IP Agent Phone Directory</td>
<td>Select <strong>Add to Directory</strong>. Avaya IP Agent adds the name, telephone number, and e-mail address for this selection in the Phone Directory.</td>
</tr>
</tbody>
</table>
Selecting the fields to display and the order

Avaya IP Agent allows you to select which fields from the Public Directory service will be displayed in the Search Public Directory window.

Steps for displaying Public Directory fields

To configure which Public Directory fields will be displayed in the Search Public Directory window after a query and in which order they will be displayed:

1. From the main window menu bar, select Tools > Search Public Directory.
   Avaya IP Agent displays the Search Public Directory window.

2. From the menu bar of the Search Public Directory window, select Edit > Field Organizer....
   Avaya IP Agent displays the Field Organizer window.

   ![Field Organizer window](image)

   **Note:**
   If the Field Organizer window does not contain any fields, you might need to first run a query of the Public Directory service with the default settings so that the list of available fields can be retrieved.

3. In the Available Fields list box, highlight the field you want to add to the Search Public Directory window.
   You can highlight multiple fields in this list box by holding down the Ctrl key and clicking the cursor on each field name.
Using a Public Directory with Avaya IP Agent

4. After the necessary fields have been highlighted, select the right arrow button (>) to move the selected fields to the Show fields in this order list box.

   The left arrow button (<) will remove the highlighted field from the Show fields in this order list box.

   The double arrow buttons (<< and >>) will move all fields from one list box to the other.

5. To change the order of the fields in the Show fields in this order list box, highlight the field to move by clicking on it.

6. Use the up and down buttons at the bottom of the list box to move the position of the highlighted field.

7. Repeat Steps 5 and 6 for the pertinent fields to set the desired order.

8. Select the OK button.

   Note:
   The selected fields and the associated order will not be displayed until you run a new query.
Identifying multiple telephone number fields

Avaya IP Agent allows you to select multiple fields to be considered as telephone numbers. For example, the Public Directory service could have several numbers assigned to an individual, such as pager, fax, voice mail, mobile telephone, home telephone, and so forth.

When multiple telephone numbers are identified in Avaya IP Agent, the Call feature of the Search Public Directory window will ask you to select which of these numbers you want to call.

Steps for identifying telephone number fields

To select multiple telephone numbers to be available for the Call feature, perform the following steps:

1. From the main window menu bar, select Tools > Search Public Directory.
   
   Avaya IP Agent displays the Search Public Directory window.

2. From the Search Public Directory window menu bar, select Edit > Select Phone Numbers....
   
   Avaya IP Agent displays the Select Phone Numbers window.

   ![Select Phone Numbers window](image)

3. In the Available Fields list box, highlight the field you want to add as another telephone number for the contact.
   
   You can highlight multiple fields in this list box by holding down the Ctrl key and clicking the cursor on each field name.

4. After the necessary fields have been highlighted, select the right arrow button (>) to move the selected fields to the Phone Number Fields list box.
5. Select the **OK** button.
Deleting a Public Directory service

This section provides the procedure for deleting a Public Directory service from Avaya IP Agent.

Steps for deleting a Public Directory service

To delete a Public Directory service, perform the following steps:

1. From the main window menu bar, select Tools > Search Public Directory.
   
   Avaya IP Agent displays the Search Public Directory window.

2. To select the Public Directory service to delete, click the Directory Menu button.
   
   Avaya IP Agent displays a menu listing all defined Public Directory services.

   
   The selected item from the menu is set as the active Public Directory service and the Directory Menu button displays its name.

4. Once again, click the Directory Menu button.
   
   Avaya IP Agent displays Directory Menu.

5. From the Directory Menu, select Remove.
   
   Avaya IP Agent deletes the active Public Directory service from Avaya IP Agent and sets the first remaining service as active.
Using a Public Directory with Avaya IP Agent
Chapter 11: Screen pops

Screen pops are used to start an application or interface when an incoming call is received by Avaya IP Agent or when an outgoing call is placed.

Screen pops are most useful for the following actions:

- Starting an application so that the agent can enter customer or critical information regarding the call.
- Viewing data based on information transmitted with the call, such as customer information, the area from which they are calling, or the selections a customer made while being processed through a vector.

There are two types of screen pops:

- **Windows application** - This type of screen pop starts a Windows application, such as an HTML browser, a database interface, a trouble ticket program, or a custom application. This type of screen pop is also capable of passing parameters as part of an HTML string when it is initialized.

- **Dynamic Data Exchange (DDE)** - This type of screen pop retrieves information you specify from a call and passes it to a DDE server or application. The DDE server or application can then send information from its database or a file to an interface displayed on the personal computer.

This section includes the following topics:

- [Creating a Windows application screen pop](#) on page 181
- [Creating a DDE screen pop](#) on page 186
- [Setting the active screen pop](#) on page 191
- [Modifying a screen pop](#) on page 192
- [Deleting a screen pop](#) on page 193

**Before you begin**

Read and understand the following items before administering screen pops through Avaya IP Agent:

- Many DDE services have distinct features. For this reason, the complete syntax for a DDE query cannot be specified in this document. For information regarding your DDE service and how to query information from it, refer to the documentation supplied with that product.
Screen pops

- User-to-User Information (UUI) is a unique identifier that is added to an incoming call through an external application, such as Avaya ASAI. To pass UUI, the Avaya communication server must have the **Display UUI Information** feature enabled. Additionally, the UUI feature does not support user-defined languages. This feature is only available for *incoming* calls, and it requires that a `uui-info` button is administered for the extension receiving the call.
Creating a Windows application screen pop

This section provides the procedure for starting a Windows application when Avaya IP Agent receives an incoming call or an outgoing call is made.

Steps for creating an application screen pop

To create a Windows screen pop:

1. From the menu bar of the Avaya IP Agent window, select **Tools > Screen Pops**.
   Avaya IP Agent displays the **Screen Pops** window.

2. Select **File > New**.
   Avaya IP Agent displays the **Screen Pops** wizard.

3. Enter a name for this screen pop in the text box.

4. Ensure that the **Window Explorer** option button is selected.
5. Select the **Next** button.

Avaya IP Agent displays the **Screen Pops - Trigger** window.

6. Select the appropriate call condition from the following table:

<table>
<thead>
<tr>
<th>If...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>This screen pop should be run for incoming calls</td>
<td>Select one of the following options to indicate when it should start:</td>
</tr>
<tr>
<td></td>
<td>● <strong>Ringing</strong> - The screen pop starts when Avaya IP Agent receives an incoming call.</td>
</tr>
<tr>
<td></td>
<td>● <strong>Answered</strong> - The screen pop starts when an incoming call has been answered through the Avaya IP Agent interface or by picking up the handset in the Telecommuter or IP Telephone configuration.</td>
</tr>
<tr>
<td></td>
<td>● <strong>Missed</strong> - The screen pop starts when the call appearance from an incoming call disappears after not being answered. This can be caused by the caller hanging up or if the call was routed to a voice mail system after a specific number of rings.</td>
</tr>
<tr>
<td></td>
<td>● <strong>Released</strong> - The screen pop starts when the <strong>Release</strong> button is pressed on a Call Information Panel (CIP) or when the agent hangs up the telephone in the Telecommuter or IP Telephone configuration.</td>
</tr>
</tbody>
</table>
If... | Then...
---|---
This screen pop should be run for outgoing calls | Select one of the following options to indicate when it should start:
- **Connected** - The screen pop starts when the party being called answers the telephone.
- **Released** - The Screen Pop starts when the Release button is pressed on a CIP or when the agents hangs up the telephone in the Telecommuter or IP Telephone configuration.

7. If you want the screen pop to start when an incoming call appears on a specific VDN:
   a. Place a check mark in the **Pop the screen only when the VDN is** check box.
   b. In the associated field, enter the VDN name (up to 15 characters) that will cause this screen pop to run.

8. Select the **Next** button.

   Avaya IP Agent displays the **Screen Pop - Action** window.

9. In the field provided, enter one of the following:
   - **A Uniform Resource Locator (URL) address** - This refers to a Web page. This could also include CGI scripts, java scripts, or many other Web-enabled tools.
   - **A filename** - This can be any filename with an extension specified in the Windows Registry as having an associated application that is used to open it, for example, .HTM, .DOC, and .TXT. If a filename is specified that does not have a valid application association in the Registry, Windows will display an error message.
10. Calls contain information that can also be included in this field as parameters of a URL address string. To include call information parameters with a URL string, select the arrow to the right of the field to display the Insert Call Data menu.

The information that may be available for retrieval from a call are:

- **Caller Name (%n)** - Passes the name of the other party on the call, if available
- **Caller Number (%m)** - Passes the telephone number of the other party on the call, if available
- **Prompted Digits (%p)** - Passes the digits the caller selected while being processed through a vector, if available.
- **VDN (%v)** - Passes the VDN name through which the call was connected
- **UUI (%u)** - Passes User-to-User-Information that was collected by the Avaya communication server from a centralized application.
- **Start Time (%s)** - Passes the time when the telephone call was received by Avaya IP Agent
- **Date (%d)** - Passes the current date when the telephone call is received by Avaya IP Agent

⚠️ **Important:**

> These parameters cannot be used for passing arguments to an executable program.

You may also specify these parameters manually within the URL address string.

11. After entering the URL address or filename, select the Next button.

12. If you specified any parameters to be used in the Action window, you are presented with the Format Call Information window for each parameter. In this window, you can specify the number of characters or digits used for that parameter in the screen pop.

If you want to limit the number of characters presented for each parameter, do the following steps:

a. Enable the check box on the specific parameter screen.

b. Use the **Number of characters to include** and **Location** fields to adjust the boundaries of the string.

c. After you have specified the boundaries of the parameter string, select the Next button.

If more than one parameter was specified in the Action dialog box earlier, the Format Call Information for the next parameter is presented. Select the Next button when you have finished configuring each parameter.

If there are no more parameters to configure, Avaya IP Agent displays the Testing dialog box.
13. Select the Test button to verify that the configuration of this screen pop works as intended.

If you are using parameters in your screen pop, you will be presented with another dialog box that allows you to enter Caller Name, Caller Number, Prompted Digits, VDN, and UUI as test information. Select the Continue button when all necessary test information has been entered in these fields.

Avaya IP Agent starts the screen pop.

14. After you have confirmed that the test of the screen pop was successful, close the screen pop and select the Next button on the Testing window.

Avaya IP Agent displays the Setup Completed window.

15. Select the Finish button.

Avaya IP Agent saves this screen pop and displays it in the Screen Pops window.
Creating a DDE screen pop

This section provides the procedure for starting a DDE screen pop when Avaya IP Agent receives an incoming call or when an outgoing call is made.

Steps for creating a DDE screen pop

To create a DDE screen pop:

1. From the menu bar of the Avaya IP Agent window, select Tools > Screen Pops.  
   Avaya IP Agent displays the Screen Pops window.
2. Select File > New.  
   Avaya IP Agent displays the Screen Pops wizard.
3. Select the Dynamic Data Exchange (DDE) option button.
4. Select the Next button.  
   Avaya IP Agent displays the Screen Pops - Trigger window.
5. Select the appropriate call condition from the following table:

<table>
<thead>
<tr>
<th>If...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>This screen pop should be run for incoming calls</td>
<td>Select one of the following options to indicate when it should start:</td>
</tr>
<tr>
<td></td>
<td>● <strong>Ringing</strong> - The screen pop starts when Avaya IP Agent receives an incoming call.</td>
</tr>
<tr>
<td></td>
<td>● <strong>Answered</strong> - The screen pop starts when an incoming call has been answered through the Avaya IP Agent interface or by picking up the handset in the Telecommuter or IP Telephone configuration.</td>
</tr>
<tr>
<td></td>
<td>● <strong>Missed</strong> - The screen pop starts when the call appearance from an incoming call disappears after not being answered. This can be caused by the caller hanging up or if the call was routed to a voice mail system after a specific number of rings.</td>
</tr>
<tr>
<td></td>
<td>● <strong>Released</strong> - The screen pop starts when the agent hangs up the telephone in the Telecommuter or IP Telephone configuration.</td>
</tr>
<tr>
<td>This screen pop should be run for outgoing calls</td>
<td>Select one of the following options to indicate when it should start:</td>
</tr>
<tr>
<td></td>
<td>● <strong>Connected</strong> - The screen pop starts when the party being called answers the telephone.</td>
</tr>
<tr>
<td></td>
<td>● <strong>Released</strong> - The screen pop starts when the agent hangs up the telephone in the Telecommuter or IP Telephone configuration.</td>
</tr>
</tbody>
</table>

6. If you want the screen pop to start when an incoming call appears on a specific VDN:
   a. Place a check mark in the **Pop the screen only when the VDN is** check box.
   b. In the associated field, enter the VDN name (up to 15 characters) that will cause this screen pop to run.
7. Select the **Next** button.

Avaya IP Agent displays the **Action** window.

8. In the **Action** window, enter the necessary DDE information for the following fields:

- **Service** - A string expression that identifies an application or DDE server that can participate in a DDE conversation. Usually, the application argument is the file name of a program for a Windows-based application. Do not specify the `.EXE` extension of the program.

- **Topic** - A string expression that is the name of a topic recognized by the application argument. This will be the second parameter of the DDEInitiate() function.

**Important:**

Many DDE services have distinct features. For this reason, complete syntax for a DDE query cannot be specified in this document. For information regarding your DDE service, refer to the documentation supplied with that product.

9. Select which option will be used for the DDE conversation from the following list:

- **Execute command** - A string expression that specifies a command recognized by the server application. The string will only be changed to input caller information. The syntax must match the syntax required by the DDE program. For example, if embedded quotes are necessary, such as "name="Smith"", you must enter the text string with all required quotation marks.

- **Poke Item** - A string expression that is the name of a data item recognized by the topic specified by the DDE Initiate() function.

  - **Data** - A string containing the data to be supplied to the other application.

10. Enter the appropriate information in the fields for the selected option. Use the arrow button to the right of the **Execute command** or **Data** fields to specify information for Avaya IP Agent to retrieve from the telephone call and pass to the DDE conversation.

    The information that may be available for retrieval from a call are:
11. If you specified any parameters to be used in the Action window, you are presented with the Format Call Information window for each parameter. In this dialog box, you can specify the number of characters or digits used for that parameter in the screen pop.

   If you want to limit the number of characters presented for each parameter, do the following steps:
   a. Enable the check box on the specific parameter screen
   b. Use the Number of characters to include and Location fields to adjust the boundaries of the string.
   c. After you have specified the boundaries of the parameter string, select the Next button.

   If more than one parameter was specified in the Action window earlier, the Format Call Information window for the next parameter is presented. Select the Next button when you have finished configuring each parameter.

   If there are no more parameters, Avaya IP Agent displays the Testing window.

12. Select the Test button to verify that the configuration of this screen pop works as intended.

   If you are using parameters in your screen pop, you will be presented with another dialog box that allows you to enter Caller Name, Caller Number, Prompted Digits, VDN, and UUI as test information. Select the Continue button when all necessary test information has been entered in these fields.

   Avaya IP Agent starts the screen pop.

13. After you have confirmed that the test of the screen pop was successful, close the screen pop and select the Next button on the Testing window.

   Avaya IP Agent displays the Setup Completed window.
Screen pops

14. Select the Finish button.

Avaya IP Agent saves this screen pop and displays it in the Screen Pops window.
Setting the active screen pop

This section provides the procedure for specifying which screen pop will be set as the one used for incoming or outgoing calls.

Steps for setting an active screen pop

To set the active screen pop:

1. From the Avaya IP Agent main window menu bar, select Tools > Screen Pops. Avaya IP Agent displays the Screen Pops window.

2. In the Name column, place a check mark next to the screen pops to use for all subsequent telephone calls.

   It is possible to set multiple screen pops as being active if those screen pops do not conflict in their selection criteria. For example, if two or more screen pops are set to activate during a Ringing call, but are set for different VDNs, all of these can be active at the same time.

3. Close the Screen Pops window.

   Avaya IP Agent saves this selection and uses the selected screen pops for any subsequent call, if applicable.
Modifying a screen pop

This section provides the procedure for modifying a screen pop that has already been created.

Steps for modifying a screen pop

To modify a screen pop:

1. From the Avaya IP Agent main window menu bar, select **Tools > Screen Pops**. Avaya IP Agent displays the **Screen Pops** window.

2. Choose the screen pop that you want to modify and double-click it. Avaya IP Agent opens the **Screen Pops** wizard and populates it with the data configured for this screen pop.

3. For each dialog, change the necessary configuration as needed and select the **Next** button to continue for each one.

   See [Creating a Windows application screen pop](#) on page 181 or [Creating a DDE screen pop](#) on page 186 for specific information on each window of the **Screen Pops** wizard.

4. When you reach the **Setup Completed** window, select the **Finish** button. Avaya IP Agent saves the changes made to the screen pop and closes the **Screen Pops** wizard.

5. Close the **Screen Pops** window.
Deleting a screen pop

This section provides the procedure for deleting a screen pop from Avaya IP Agent.

Note:
Deletion of a screen pop cannot be undone.

Steps for deleting a screen pop

To delete a screen pop:

1. From the Avaya IP Agent main window menu bar, select Tools > Screen Pops.

   Avaya IP Agent displays the Screen Pops window.

2. Highlight the screen pop to be deleted by clicking on it.

3. From the menu bar, select Edit > Delete.

   The selected screen pop is deleted.

4. Close the Screen Pops window.
Screen pops
Chapter 12: Dialog Reference

This section provides descriptions of the graphical interfaces used in Avaya IP Agent and their basic functionality. Only those interfaces not described through other sections of this document are described here.

This section contains the following topics:

- Main window and menus on page 196
- Avaya IP Agent option dialogs on page 212
- Login Settings dialog box on page 228
- Agent Greetings settings on page 235
- Audio settings on page 239
Main window and menus

This section describes the menus and panels in the Avaya IP Agent main window. This section includes the following topics:

- **Menu bar** on page 196
- **Toolbars** on page 204
- **Information panels** on page 209
- **System Tray icon** on page 210

Menu bar

The Avaya IP Agent main window provides full-function, multi-line telephony support on your personal computer. This window is also used to access all the features found in Avaya IP Agent.

This section defines all of the items available in the Avaya IP Agent menus. Some menus and menu items are available only when they are valid for your current configuration. For example, the **Call** menu is not available in an IP Endpoint configuration when a call is not currently active. Other menus, menu items, and buttons on the interface will be disabled when the associated functionality cannot be used because of configuration, call instance, or agent work mode.

This section contains the following topics:

- **File menu** on page 197
- **Edit menu** on page 198
- **Call menu** on page 198
- **View menu** on page 200
- **Agent menu** on page 201
- **Tools menu** on page 202
- **Audio menu** on page 203
- **Settings menu** on page 204
- **Help menu** on page 204
Main window and menus

File menu

The following items are available on the File menu:

- **Station Login, Station Logout** - These items appear as the first item in this menu. They are used for logging the station or agent in and out of the Avaya communication server. This menu item varies between these two possibilities depending on your current login state. These items do not appear for Avaya CallMaster VI configurations.

- **Import Settings** - Selecting this menu item gives you the ability to open a file containing settings from another Avaya IP Agent installation and apply those settings to this installation.

- **Export Settings** - Selecting this menu item saves the settings from this installation of Avaya IP Agent to a file. This file can then be re-imported to this personal computer or to another personal computer with Avaya IP Agent.

**Note:**

When exporting and importing settings, most name changes to features in the **Phone Features** or **Personal Phone Features** windows are made on a per extension basis. To ensure that name changes are made for all extensions, right-click on the feature and select the **Rename (All Extensions)** item from the resulting menu.

Exported settings are platform-dependent. If you export Avaya IP Agent settings from a Windows XP personal computer, do not import the settings to a personal computer that uses a different operating system.

Imported and exported files include the following settings:

- All settings available in the **Program Options** window
- Screen pops
- Lightweight Directory Access Protocol (LDAP) settings
- Personal Phone features
- Phone features
- Abbreviated Dialing settings
- Call Center features
- Telephone button labels
- Audio settings
- Speed-dial settings

- Exit - Selecting this menu item closes Avaya IP Agent after making the necessary logouts for the agent and the extension.

Edit menu

The following items are available on the Edit menu:

- **Cut** - Removes any highlighted text in the **Number** field and places it on the Windows clipboard.
- **Copy** - Copies any highlighted text in the **Number** field and places it on the Windows clipboard.
- **Paste** - Retrieves the last item placed on the Windows clipboard and places it in the **Number** field.

Call menu

The Call menu is available only when a call is made or received.
The following items are available on the **Call** menu:

- **Release** - Terminates an active call.
- **Drop** - Disconnects from a call without requiring you to hang up the handset, turn off the speakerphone, or press the switch hook.

⚠️ **Important:**

6400-series telephones must have a Drop button administered on the Avaya communication server in order for the Drop feature in the Avaya IP Agent window or menus to function properly.

- **Hold** - Places a call on hold until you can return to it. While the call is on hold, you can place another call, activate a feature, or answer another call.
- **Transfer** - Sends a call from your extension to another extension or outside number. Use this feature when the other party on the call needs to speak with someone else. There are three different types of transfers available.

  The following types of call transfers are available with Avaya IP Agent:

  - **Basic Transfer** - Select **Transfer**, dial the number on the keyboard or the **Dial Pad**, announce the call, and select **Transfer** again.
  - **Unsupervised Transfer** - Select **Transfer**, enter the number to be called in the displayed dialog box, and select the **OK** button to transfer the call. You are not able to talk to the party receiving the transferred call with this type of transfer.
  - **Enhanced Transfer** - Select **Transfer**, enter the number to be called in the displayed dialog, and select **OK**. You can announce the call and then, in the displayed message box, select **OK** to complete the transfer or **Cancel** to abort the transfer.

- **Conference** - Adds other parties to a call. There are two different types of conferences available.

  The following types of call conferencing are available with Avaya IP Agent:

  - **Basic Conference** - Select **Conference** which displays another call appearance. Dial the number of the party to add to the conference through the keyboard or the **Dial Pad**, announce the conference to the new party, and select **Conference** again to add the new party.
  - **Enhanced Conference** - Select **Conference** which displays a dialog box. Enter the number to call in the appropriate field, and select the **OK** button. After you announce the conference to the new party, select the **Yes** button in the resulting message box to add the new party.
View menu

The following items are available on the View menu:

- **Phone Display** - Enabling this item displays a panel above the status bar. This panel can display information from sources such as VuStats or call-prompting digits.

- **Dial Pad** - Enabling this item displays a Dial Pad window, which contains a series of numbers and symbols resembling a telephone keypad. Use your mouse to dial numbers on the Dial Pad.

- **Toolbars > Show Labels** - Enabling this item displays labels for the buttons on the Phone buttons toolbar, the Agent toolbar, and the Phone features toolbar.

- **Toolbars > Phone Buttons** - Enabling this item displays the Phone buttons toolbar, which contains buttons for the Drop, Transfer, Conference, and Hold functions.

- **Toolbars > Dial Number** - Enabling this item displays the Dial Number toolbar, which provides a field for entering digits. It also contains the buttons used to access the Call History feature, the Phone Directory feature, the Dial Pad, and the Search Public Directory feature.

- **Toolbars > Audio Control** - Enabling this item displays the Audio Control toolbar. Using this toolbar, the user can enable or disable audio transmission, audio receiving, and the headset. This toolbar is only available for Road Warrior (VoIP) configurations.

- **Toolbars > Agent** - Enabling this item displays the Agent toolbar, which an agent can use to change their work modes. It also contains a Login/Logout button for agents.

- **Toolbars > Phone Features** - Enabling this item displays the Phone features toolbar, which is populated with previously selected folders from the Phone Features window. When you select a folder on this toolbar, a list is displayed with all of the available features that are currently assigned to that folder.
● **Toolbars > Feature Buttons** - Enabling this item displays the Feature button toolbar, which is populated with previously selected buttons from the Phone Features window. Buttons on this toolbar have an associated lamp that identifies the status of the feature the button represents.

● **Toolbars > Agent Greetings** - Enabling this item displays the Agent greetings toolbar, which is used to select, play, and stop agent greetings that have been previously recorded. This toolbar is available only for the Road Warrior (VoIP) and Avaya CallMaster VI configurations.

● **Toolbars > Headset** - Enabling this item displays the Headset toolbar, which contains a button for answering a call or creating a new call appearance when a call is not currently active.

● **Status Bar** - Enabling this item displays the Status Bar at the bottom of the Avaya IP Agent main window. The Status Bar displays different types of information, such as current activity, notification of voice messages, the state of Avaya IP Agent, and tooltips.

● **Alternate Interfaces** - This menu item lists all alternate user interfaces that have been installed with Avaya IP Agent. The alternate user interfaces use much less desktop space than the default interface. See Using alternate user interfaces on page 123 for more information.

**Agent menu**

The following items are available on the **Agent** menu:

● **Agent Login** - This item displays the Agent Login dialog box for entering your EAS Agent login ID number and password.

● **Agent Logout** - This item enables you to log out so that calls are not routed to this extension.

● **Auto-In Mode** - This is an Automatic Call Distribution (ACD) work mode. Agents in the Auto-In mode are available to receive new calls upon completion of the current call.

● **Manual-In Mode** - This is an ACD work mode. Agents must use the Manual-In feature to re-enter the AVAIL (Available) work mode from the AUX (Auxiliary Work) work or the ACW (After Call Work) work mode.
After Call Work (ACW) - This is an ACD work mode that indicates that an agent is performing tasks related to the last call.

Auxiliary Work Mode (AUX) - This is an ACD work mode that indicates that an agent is not available to receive an ACD call. Depending on how the ACD is administered, the AUX work mode can require that agents provide a reason code before the work mode can be assigned. Multiple Auxiliary Work buttons with different reason codes can be assigned to an extension.

Assist - This item initiates a request for assistance from a skill supervisor.

Tools menu

The following items are available on the Tools menu:

Phone Features - Selecting this item displays the Phone Features window, which lists the feature buttons that have been assigned to this extension.

Personal Phone Features - Selecting this item displays the Personal Phone Features window, which is used to create a smaller list of phone features that are used often or for ease of access.

Call History - Selecting this item displays the Call History window, which displays a log of all calls received by this extension. This log includes name, number, date, time, duration, and call notes.

Phone Directory - Selecting this item displays the Phone Directory window, which is used to store names, addresses, phone numbers, and other information. See Using the Phone Directory on page 147 for more information.

Search Public Directory - Selecting this item displays the Search Public Directory window, which allows you to search Lightweight Directory Access Protocol (LDAP) servers by any field defined in the public directory. See Using a Public Directory with Avaya IP Agent on page 167 for more information.

Screen Pops - Selecting this item displays the Screen Pops window, which lists all the screen pops that are defined on this personal computer. See Screen pops on page 179 for more information.
- **Agent Greetings** - Selecting this item displays the Agent Greetings window, which lists all of the agent greetings that are defined on this personal computer. Agents, with the proper access permissions, can manage the greetings from this window. This item is available only for the Road Warrior (VoIP) and Avaya CallMaster VI configurations. See Agent Greetings on page 155 for more information.

- **VuStats Monitor** - Selecting this item displays the VuStats Monitor window, which is used to view the VuStats information being sent to this extension. See UsingVuStats on page 161 for more information.

- **Program Options** - Selecting this item displays the Program Options dialog box for Avaya IP Agent. See Avaya IP Agent option dialogs on page 212 for more information.

**Audio menu**

**Note:**

The Audio menu is not available for CallMaster VI configurations.

The following items are available on the Audio menu:

- **Volume and Ringer Settings** - Selecting this item displays the Volume and Ringer Settings dialog box. Through this dialog box, you can adjust the volume for your speakers, microphone, and ringer. You can also mute all devices and control other options.

- **Audio Options** - Selecting this item displays the Audio Options dialog box through which you can adjust the settings for IP audio, such as bandwidth and gain levels. This item is only available for Road Warrior configurations.

- **Audio Monitor** - Selecting this item displays the Audio Monitor dialog box, which displays the audio levels currently used for your microphone and speakers. This window also displays information for your VoIP connection. This item is only available for Road Warrior configurations.

- **Tuning Wizard** - Selecting this item runs the Tuning Wizard, which queries the personal computer for the optimal settings for Voice-over-IP. This item is only available for Road Warrior and Telecommuter configurations.
Settings menu

Note:
The Settings menu is displayed only for CallMaster VI configurations.

The following items are available on the Settings menu:

- **Phone Configuration** - Selecting this item downloads the PASTE code from the Avaya communication server to the Avaya CallMaster VI unit.

Help menu

The following items are available on the Help menu:

- **Contents** - Selecting this item displays the table of contents for Avaya IP Agent online help.

- **About Avaya IP Agent** - Selecting this item displays the About dialog box which provides product information for Avaya IP Agent.

Toolbars

This section provides descriptions and additional information on the toolbars of the Avaya IP Agent window. Toolbars contain buttons that provide quick access to specific commands.
and tools. Toolbars can be added or removed from the main window by selecting each one in the View menu on page 200.

This section contains the following topics:

- Toolbar locations on page 205
- Phone buttons toolbar on page 205
- Dial Number toolbar on page 206
- Agent toolbar on page 206
- Agent greetings toolbar on page 207
- Phone features toolbar on page 207
- Feature button toolbar on page 207
- Audio Control toolbar on page 208
- Headset toolbar on page 208
- CallMaster toolbar on page 208

### Toolbar locations

Each toolbar can be moved to any location in the main window.

To move a toolbar:

1. Move the mouse pointer on the far-left side of the toolbar until the mouse pointer changes its appearance to the resizing icon.
2. Click and hold the left mouse button.
3. Drag the toolbar to the necessary location. The toolbar will change positions as you move it over different areas of the main window.
4. When the toolbar is correctly positioned in its new location, release the left mouse button.

### Phone buttons toolbar

The Phone buttons toolbar provides quick access to the basic phone buttons: Hold, Drop, Transfer, and Conference.

The Transfer and Conference buttons provide drop-down lists that allow the agent to select the type of transfer or conference to make.
Dial Number toolbar

The Dial Number toolbar contains the **Number** field for entering telephone numbers to dial. Additionally, this field can be used to enter the first characters of a name from the **Phone Directory**. If the first character of the string entered in this field is a letter, the title of the field will be changed from **Number** to **Name**. When you enter a partial name in this field and press the **Enter** key or click the telephone button on the right side of the field, a list is displayed with all entries in the **Phone Directory** that match the string of characters.

For example, entering `Sm` in the field and pressing the **Enter** key could display a pop-up menu with the following entries in the **Phone Directory**:

```
Name: 
Small, Jim (Business)
Smith, John (Business)
Smith, John (Home) 
Smith, Robert (Business)
Stone-Jones, Sarah Lynn (Business)
```

This field will search for entries only in the **Phone Directory**. It cannot be used to search a public directory (LDAP).

This toolbar also contains the following features that you can access with a single click:

- **Dial Pad** window
- **Phone Directory** window
- Speed-dial drop-down list
- **Call History** window
- Recent call drop-down list
- **Search Public Directory** window

Agent toolbar

The Agent toolbar provides buttons for agent login and logout, as well as agent work modes for Avaya communication servers with Expert Agent Selection (EAS).
**Note:**
If multiple Auxiliary Work buttons with differing reason codes are assigned to this extension, an arrow is displayed to the right of the *Aux Work* button. When you select this arrow, a menu that lists all of the Auxiliary Work reason codes is displayed. Select the appropriate reason code from this menu.

**Agent greetings toolbar**

The Agent greetings toolbar lets you select, play, and stop greetings. This toolbar is only available for Road Warrior (VoIP), Telecommuter (with Avaya Switcher II), and Avaya CallMaster VI configurations. For this toolbar to be available, you must be logged in as an agent and have the appropriate feature buttons assigned to this station. See Configuring the Avaya communication server on page 63 for more information on which buttons are necessary.

**Phone features toolbar**

The Phone features toolbar can display one or more folders from the *Phone Features* window. When you click a button in this toolbar, Avaya IP Agent displays a list of the items contained within the associated folder.

To display items on this toolbar, open the *Phone Features* window, right-click on the folder that you want to display, and select **Display on Toolbar**.

**Note:**
This toolbar can support a maximum of seven buttons.

**Feature button toolbar**

The Feature button toolbar can display one or more items from the *Phone Features* window.

To display items on this toolbar, open the *Phone Features* window, right-click on a feature that you want to display, and select **Display on Toolbar**.

**Note:**
This toolbar can support a maximum of seven buttons.
Audio Control toolbar

The Audio Control toolbar allows control of the following items:

- Microphone status and volume
- Speaker status and volume
- Ringer status and volume control

This toolbar is only available for Road Warrior (VoIP) and Avaya CallMaster VI configurations.

Headset toolbar

The Headset toolbar contains a button used to toggle the headset or handset on and off hook.

Note:
If this station has been set as a 606A1 phone type on the Avaya communication server, this button may not function properly in the Telecommuter configuration.

CallMaster toolbar

Note:
This toolbar is only available for CallMaster VI configurations.

The CallMaster toolbar contains the following controls:

- Microphone - Select this button to mute the microphone on the CallMaster VI headset.
- Volume control - Select this button to display a slider control that allows you to adjust the volume of audio heard through the headset.
- Headset - Select this button to enable or disable the CallMaster VI headset.
Information panels

This section contains descriptions and information on the areas of the main window that display information to the user.

There are three different types of panels in Avaya IP Agent, which are described in the following topics:

- Call Information Panel on page 209
- Agent Information Panel on page 209
- Phone Display Panel on page 209

Call Information Panel

Avaya IP Agent displays the Call Information Panel (CIP) only during incoming and outgoing calls. It provides information about the call, such as call status, call display, call duration. It also displays an Answer/Release/Reconnect button.

If a call is currently active and the other party is listed in the Phone Directory, that name is displayed in the CIP instead of the information passed from the ACD.

The call status, incoming, outgoing, or on-hold, is displayed in the first section. Right-click the CIP to display a pop-up menu containing available options for this call, such as hold, transfer, and conference.

The timer in this panel displays the amount of time that has elapsed for a call and the work done in a subsequent non-active work mode, such as ACW. When an agent enters Auto-In or Manual-In mode, the timer is reset to 0.

Note:
To disable the call timer, see How to remove the call timer on page 265.

Agent Information Panel

Avaya IP Agent displays the Agent Information Panel when agent status information is available and no calls are currently active. If you are logged in as an agent, the status information also includes the current agent work mode.

Phone Display Panel

The Phone Display Panel is a 40-character display that is located above the Status Bar. This display area is updated automatically with call-related and non-call-related information from the Avaya communication server, such as call-prompting digits, VuStats data, and the local date and time display from the ACD. Only those telephone types that are capable of displaying 80 characters are compatible with this feature. See Compatible telephone types for Avaya IP Agent on page 21 for compatible telephone types.
System Tray icon

The Avaya IP Agent System Tray icon is an easy way to access commonly used features and to change your agent work mode.

To display the System Tray icon menu, right-click the icon.
If you are not logged in as an agent, the work mode entries in this menu will not be displayed.

Placing calls through the System Tray icon

You can use two methods to place a call using the Avaya IP Agent System Tray icon:
• Highlight dialing - Highlight a telephone number in any application. Then, when you right-click the System Tray icon, selecting the item at the top of the menu will automatically dial the highlighted number.

Note:
The Windows Terminal Services version of Avaya IP Agent does not support highlight dialing.
● Clipboard dialing - If you highlight a telephone number, right-click the selection, and select **Copy**, that number is saved to the Windows clipboard. Then, if you right-click the Avaya IP Agent System Tray icon, the top item of the resulting pop-up menu will display the telephone number that you copied to the clipboard.

Both of these methods allow for calling telephone numbers with letters, such as 1-800-GO-AVAYA.

**Call handling with the System Tray icon**

The Avaya IP Agent System Tray icon can also be used to access common telephone functionality, such as placing a call on Hold.

To use the capability, you must be on a call when you right-click the System Tray icon.
Avaya IP Agent option dialogs

Use the Program Options dialog box to configure the many feature areas of Avaya IP Agent. Select Tools > Program Options... to display this dialog box.

This section contains descriptions for the following panels of the Program Options dialog box:

- General Settings panel on page 213
- ACD Agent panel on page 215
- Call Handling panel on page 216
- Call History panel on page 217
- Call Information Display panel on page 218
- Database Options panel on page 219
- User Interface Options panel on page 220
- External Number Format panel on page 221
- Event Logging panel on page 222
- Greetings Options panel on page 223
- Voice Message Number panel on page 224
- Phone Settings panel on page 225
- Feature Access panel on page 226
General Settings panel

The **General Settings** panel contains the following items:

- **Select your configuration**: - Use this feature to select the type of configuration that you want to use.
  - **IP Endpoint, using Network Connection** - Select this option for Road Warrior, Telecommuter, IP Telephone, and Avaya Telephone configurations.
  - **CallMaster Endpoint, using CallMaster VI Terminal** - Select this option for CallMaster VI configurations. Select this option only if you have a CallMaster VI terminal connected to your personal computer.

- **PASTE Feature Access Code** - This feature is used for Avaya CallMaster VI configurations. Use this field to enter the PC Application Software Translation Exchange (PASTE) code for an Avaya CallMaster VI unit. This code, which is found on the Avaya communication server, allows the Avaya CallMaster VI unit to translate information sent from the Avaya communication server and relay that information to Avaya IP Agent.

- **Enable automatic login** - This feature is only available for Road Warrior, Telecommuter, IP Telephone, and Avaya Telephone configurations. When this check box is enabled, Avaya IP Agent attempts to register with the Avaya communication server when started. It will use the information that was last used for a successful registration with the Avaya communication server.

- **Enable support for auto-answer** - When this check box is enabled, Avaya IP Agent automatically connects an incoming call without requiring the agent to pick up the handset or select the **Answer** or headset buttons on the main window. For this functionality, the auto-answer feature on the Avaya communication server must be
assigned to this extension. After activating support for auto-answer, you must restart Avaya IP Agent.

- **Handle voice call request from other programs** - When this check box is enabled, Avaya IP Agent intercepts requests from other applications on the personal computer to begin a call and functions as though the call was started through Avaya IP Agent.

- **Enable software update using HTTP** - When this check box is enabled, Avaya IP Agent reads the configuration file in the location specified in the **Address** field for program updates. The configuration file is a file that redirects Avaya IP Agent to the location of the current update. This file can be created in any ASCII text editor or you can use the configuration file provided on the Avaya IP Agent CD-ROM. If an update for Avaya IP Agent is found, it is installed. The default filename is **IPAgentUpdateInfo.cfg**. However, you may rename this file and enter the name of the new file in the **Address** field. This feature uses only Uniform Resource Locator (URL) or IP addresses that can communicate information by using the Hypertext Transfer Protocol (HTTP). The following example displays the format of the configuration file:

```
[Update]
Version=4.0.1.5
PathToUpdate=http://myserver.mycompany.com:80/dirpath/AvayaIPAgent.exe
NewCfgAddress=

[Report]
Address=http://myserver.mycompany.com/report.asp
```

**Note:**
- This feature does not support Universal Naming Convention (UNC) or local directory paths. For example, `\servername\resource\filename` or `file:///c:\temp\filename` are not supported.

**Note:**
- This feature is not supported with Avaya IP Agent on Windows Terminal Services.

- The **Version** entry is mandatory. This entry specifies the version of the available update. Avaya IP Agent compares the current version of the application against the version listed in the configuration file. If the version in the configuration file is later than the version of Avaya IP Agent being used on the PC, Avaya IP Agent reads the location specified in the **PathToUpdate** entry.

- The **PathToUpdate** entry is optional. This entry specifies the URL or IP address where the Avaya IP Agent update is available. If a location is not specified in this entry, Avaya IP Agent searches the directory containing the configuration file for **AvayaIPAgent.exe**.

- The **NewCfgAddress** entry is optional. This entry specifies the URL or IP address where another configuration file is located. If the other configuration file is found, Avaya IP Agent uses the information in this file rather than the information in the previous configuration file. Using this feature eliminates the need for the
administrator to visit each installation and make the change manually. When Avaya IP Agent is redirected to another configuration file, the location and filename are overwritten in the Program Options. When Avaya IP Agent is restarted, it will attempt to open the new configuration file instead of the old one.

- The Address entry is optional. This entry is used by Avaya IP Agent to send information to a Web page following an upgrade. This information can then be viewed by an administrator to determine which personal computers have applied the latest Avaya IP Agent update. For example, following an update, Avaya IP Agent could send the following string to a Web page for entry into a database, such as an .ASP Web page:

```
http://server.company.com/report.asp?pcname=MYPC&station=5551212&agentid=1000&version=4.0.1.5&lastupdate=Failed&date=01/01/2003&time=12:00:00 PM
```

The Address entry is used to prefix the string of fields and data.

If you require assistance in creating a Web page for this feature, you can contact the Avaya Professional Services Organization for information and pricing regarding available services.

---

**ACD Agent panel**

The **ACD Agent** panel contains the following items:

- **Configure program for EAS agent support** - When this check box is enabled, Avaya IP Agent supports the Expert Agent Selection (EAS) feature for Avaya communication servers. Otherwise, Avaya IP Agent supports a non-EAS environment. EAS environments use *skills* and non-EAS environments use *splits*. 
Dialog Reference

- **Prompt for agent ID and password during agent login** - When this check box is enabled, Avaya IP Agent displays a dialog box when an agent requests a login to the Avaya communication server. The dialog box prompts the agent for agent ID and password.

- **Save agent password during agent login** - When this check box is enabled, Avaya IP Agent saves the password of an agent after a successful login.

- **Automatically log into the ACD** - When this check box is enabled, Avaya IP Agent attempts to automatically log the agent into the Avaya communication server after successful extension registration.

---

**Call Handling panel**

The **Call Handling** panel contains the following items:

- **Call Transfer - Use Basic Transfer** - Selecting this option sets the default transfer mode to the basic method.

- **Call Transfer - Use Unsupervised Transfer** - Selecting this option sets the default transfer mode to the unsupervised method.

- **Call Transfer - Use Enhanced Transfer** - Selecting this option sets the default transfer mode to the enhanced method.

- **Call Conferencing - Use Enhanced Conference** - Enabling this check box sets the default conferencing mode to the enhanced method. Otherwise, Avaya IP Agent uses the basic conferencing mode.
Note:
The default transfer mode in this panel is changed if you select a different transfer mode from the main window. For example, if you set **Use Basic Transfer** in this panel, but select to use an Enhanced Transfer from the main window, **Use Enhanced Transfer** is now set as the default in this panel.

---

**Call History panel**

The **Call History** panel contains the following items:

- **Log incoming calls** - When this check box is enabled, Avaya IP Agent makes a record of all calls received at this station in the **Call History** log.

- **Log outgoing calls** - When this check box is enabled, Avaya IP Agent makes a record of all calls made from this station in the **Call History** log.

- **Months to keep calls in log** - Use this field to specify the number of months for which records are stored in the **Call History** log.

- **Number of recent calls displayed** - Use this field to specify the number of records that are displayed when you click the **Call History** quick list on the Dial Number toolbar.

- **Clear history** - Selecting this button clears all records from the **Call History** log.
Call Information Display panel

The Call Information Display panel contains the following items:

- **Display call information on the title bar during a call** - When this check box is enabled, Avaya IP Agent displays information about the active call in the title bar of the main window.

- **Replace call information with phone directory entry** - When this check box is enabled, Avaya IP Agent uses the information from the Phone Directory if the telephone number for the active call is found. If the telephone number for the active call is not found, the call information from the Avaya communication server is displayed.

- **Display call information using Japanese font** - When this check box is enabled, Avaya IP Agent displays all information in Japanese. This feature is available only if the Japanese version of Avaya IP Agent was installed.

- **Enter the size of the font to be used to display call information on Call Information Panel** - Use this field to select the point size of the font that Avaya IP Agent uses to display call information in the Call Information Panel on the main window.
The **Database Options** panel contains the following items:

- **Directory**: This field displays the current location of the database (Agent.mdb) that Avaya IP Agent uses to store the entries for the **Call History** log and the **Phone Directory**.

  **Note:**
  
  If you want to change the location of the program database, you must copy the database to the new location before changing this setting.

- **Default**: If you have previously changed the location of the database, you can select this button to change the location back to the default location that was set during installation.

- **Change...**: Select this button to specify a different location for the Avaya IP Agent database (Agent.mdb).

- **Enable program database backup**: If you want to Avaya IP Agent to automatically save a copy of the program database, place a check mark in this check box.

- **Days between backups**: Use this spin control to specify the number of days between backups of the program database.
The **User Interface Options** panel contains the following items:

- **Always display the main window on top** - When this check box is enabled, Avaya IP Agent always appears in the foreground of your Windows desktop, in front of all other application windows.

- **Display tooltips for toolbars** - When this check box is enabled, tooltips appear when the mouse cursor is placed over buttons on the toolbars of the main window.

- **Display letters on the dialpad** - When this check box is enabled, the **Dial Pad** displays the letters that correspond to the numbers on the number pad of a telephone.

- **Display the Shortcut icon in the system tray** - When this check box is enabled, the Avaya IP Agent icon is displayed in the System Tray on the Windows task bar.

- **Incoming Calls - Display the main window for incoming calls** - When this check box is enabled and a call is received, the main window is displayed in front of any other application windows that are currently open.

- **Incoming Calls - Flash window for incoming calls** - When this check box is enabled, the title of the main window in the task bar flashes when a call is incoming. This behavior resembles selection and de-selection of the window.
External Number Format panel

Note:
The first three controls in this panel are automatically disabled if you have set your dialing properties for the United States. The controls are only available for those countries outside of the United States.

For countries outside the United States, information must be provided in this panel regarding the format of telephone numbers within the country. Using this panel, you can set the maximum and minimum length of telephone numbers used within the country, including city codes. This information determines when the code for another country should be added to a telephone number so that the number can be stored in the correct format.

The External Number Format panel contains the following items:

- **Maximum number of digits in city code** - Specify the number of digits that are dialed for telephone numbers that use a code to identify a city.

- **Minimum number of digits in phone number, including city code** - Specify the fewest number of digits that can be used to dial an external call. This number should also include the code used to identify a city.

- **Maximum number of digits in phone number, including city code** - Specify the largest number of digits that can be used to dial an external call. This number should also include the code used to identify a city.

- **Enable 7 digit dial plan for internal calls** - Enable this check box if your contact center uses a seven-digit dial plan. Dial plans of more than five digits are available only through MultiVantage or Communication Manager systems. When this check box is enabled, Avaya IP Agent treats a dialed number consisting of seven digits as an internal extension.
Event Logging panel

The Event Logging panel contains the following items:

- **Enable logging for IP Agent** - When this check box is enabled, all associated program activity is recorded. Avaya support personnel use this information to determine the cause of any problems with Avaya IP Agent.

- **View Log** - Select this button to display the Avaya IP Agent log file.

- **Monitor** - Select this button to display the Events Monitor window. This window displays all Avaya IP Agent events that are recorded with the logging feature. This window displays information only if the Enable logging for IP Agent check box is enabled.
Greetings Options panel

The **Greetings Options** panel contains the following items:

- **Location field** - This field displays the path where Avaya IP Agent stores agent greetings for the Road Warrior, Telecommuter (with Avaya Switcher II), and CallMaster VI configurations.

- **Default** - Select this button to change to the location that was set during installation.

- **Change** - Select this button to open a browse window where you can select the directory where Avaya IP Agent uses and stores agent greetings. You can store agent greetings on the local PC or in a network location.

**Note:**

If you have recorded agent greetings in another location, those greetings will not be moved if you change the location.
Voice Message Number panel

The options on this dialog determine what action is taken when you click the voice message icon in the System Tray.

**Note:**

This icon is displayed only when voice messages exist for an extension.

The **Voice Message Number** panel contains the following items:

- **Do nothing** - Avaya IP Agent does not initiate any action when you click the icon.

- **Dial this number** - Select this option and provide a telephone number or extension to dial in the associated field. When you click the icon, Avaya IP Agent dials the number in this field.

- **Use Application** - Select this option and provide the path and filename of an executable program file for Avaya IP Agent to run when you click the icon.

- **Goto URL** - Select this option and provide a Uniform Resource Locator (URL) address that will be opened when you click the icon.
Phone Settings panel

Note:
The Phone Settings panel is only visible for CallMaster VI configurations.

The Phone Settings panel contains the following items:

**Headset**
- **Off** - Select this button to deactivate the CallMaster headset. When the headset is deactivated, you cannot use it for calls. Deactivation of the headset is primarily used in the process of recording agent greetings.
- **On** - Select this button to activate the CallMaster headset.
- **Volume** - Use this slider control to adjust the volume of the audio output heard through the headset.

**Ring**
- **Pattern** - Use this field to select one of the eight distinctive audio signals that notify you when a call is waiting to be answered.
- **Volume** - Use this slider control to adjust the volume of the CallMaster ringing pattern.
- **Test** - Select this button to cause the CallMaster to ring according to the current settings in the Pattern and Volume fields.
Important:
In order for the **Disable Modification** feature to function properly, an administrative password must be set through the **Set Password** button. If a password is not set, the **Disable Modification** check box can have a check mark placed in it, but it cannot restrict users from modifying any options because a password must be used for validation.

Use the **Feature Access** panel to restrict users from administering or making changes to the various features of Avaya IP Agent. When any changes are made to these feature areas, you must restart Avaya IP Agent for these restrictions to take effect.

The **Feature Access** panel contains the following items:

- **Feature List** - Each of the Avaya IP Agent areas listed in this box can be protected from modifications. To select a feature area, click on the feature in this list.

- **Disable Access** - When this check box is enabled, users are restricted from accessing the specified feature panel. This option is not available for the **Program Options** feature. When access to a feature is disabled, the feature does not appear in the menus on the menu bar of the main window.

- **Disable Modification** - When this check box is enabled, users cannot alter the feature.

- **Disable Selection** - When this check box is enabled, users cannot activate a screen pop by double-clicking it in the **Screen Pops** window.

- **Set Password/Enter Password** - Select this button to display the Change Password... dialog box. When you enter a password, the options for the **Feature Access** dialog box cannot be changed until the proper password is entered.
Note:

The **Event Logging** panel is always available, even if you have restricted access to all features. In this manner, agents can activate logging without administrator intervention. You should need to record event logs only if they are requested by Avaya technical support personnel.
Login Settings dialog box

Use the Login Settings dialog box to specify the necessary data for Road Warrior, Telecommuter, IP Telephone, and Avaya Telephone configurations. This dialog box is accessed by pressing the Settings button on the Login window that is used to register with an Avaya communication server.

This section contains the following topics:

- Login tab on page 229
- Call Server tab on page 230
- Audio tab on page 231
- Emergency tab on page 232
- Advanced tab on page 233

Note:
If you are using the IP Telephone configuration, only the Login tab will be displayed. For Avaya Telephone configurations, the Audio tab is removed.
Login tab

The Login tab of the Login Settings dialog box contains the following controls:

- **Extension** - The extension number used in conjunction with Avaya IP Agent.
- **Password** - The numeric password associated with the specified extension number.
- **Remember password for next login session** - When this check box is enabled, the Login window retains the password used to register this extension number with the Avaya communication server. If you are concerned about the possibility of unauthorized persons assuming this identity, leave this check box blank.
- **Automatically login if possible when application restarts** - When this check box is enabled, logging in to the Avaya communication server is attempted automatically when Avaya IP Agent is started.
- **Dialing Location** - Specify the dialing configuration that Windows should use when making telephone calls. For example, an agent using a notebook computer may have one configuration that dials 9 for an outside line when in the office, and a separate configuration that does not dial 9 when the notebook computer is used in other locations.
- **Properties** - Select this button to display or modify the configuration specified in Dialing Location list.
The **Server** tab of the **Login Settings** dialog box contains the following controls:

- **Primary Server Address** - This field contains the domain name or IP address of the Avaya communication server that this extension will connect to.

- **Alternate Server Addresses** - This list box is automatically populated after registration of the Avaya communication server, specified in the **Primary Server Address** field, completes successfully. If communication with the primary Avaya communication server fails after Avaya IP Agent successfully registers with it, Avaya IP Agent attempts to use the other Avaya communication servers in this field.

- **Number of alternate servers** - This area displays the number of communication servers that are available in the **Alternate Server Addresses** field.

- **Add** - This button allows manual addition of an Avaya communication server to the list of alternate Avaya communication servers.

- **Remove** - Select this button to remove the currently highlighted communication server in the Alternate Server Addresses list. Removing an Avaya communication server from the list in this manner affects only the current Avaya IP Agent session. If you log off from the Avaya communication server or shut down Avaya IP Agent and then reconnect, this list of alternate server addresses is again refreshed from the list kept on the Avaya communication server.
Audio tab

The **Audio** tab of the **Login Settings** dialog box contains the following controls:

- **Road Warrior (Voice over IP)** - Select this option to specify that both the data channel and the voice channel are routed through the personal computer using Internet Protocol.

- **Bandwidth Setting** - Select the rate at which data is transmitted and received in the Road Warrior configuration.

- **Telecommuter** - Select this option to specify that the data channel is routed through the personal computer using Internet Protocol and that voice communications are conducted through a telephone. This is the only option available for the Windows Terminal Services version of Avaya IP Agent.

- **Telephone at** - Enter or select the telephone number through which voice communications are to be conducted.
The **Emergency** tab of the **Login Settings** dialog box contains the following controls:

- **Enable Emergency Call Handling feature** - When this check box is enabled, Avaya IP Agent notifies the Avaya communication server that this endpoint supports this feature and that emergency calls placed from this endpoint should transmit the specified telephone or extension number to emergency services.

- **Your extension number** - Select this option if you want your extension number to be transmitted to emergency services personnel when an emergency call is made.

- **Telephone number** - Select this option if you want a specific telephone number to be transmitted to emergency services personnel when an emergency call is made. Enter the telephone number in the associated field. See [Configuring the Emergency Call Handling Service](#) on page 92 for more information regarding this feature.
Advanced tab

Note:
This set of features is not supported for the Windows Terminal Services version of Avaya IP Agent.

The Advanced tab of the Login Settings dialog box contains the following controls:

- **Use the following IP address (as displayed by the VPN client)** - Select this option if you need to replace the IP address of this personal computer with a different IP address so that transmissions from this personal computer are recognized by the VPN. The VPN information must be provided before registering with the Avaya communication server.

  Note:
  The IP address cannot be 0.0.0.0.

- **Choose from the following port range to communicate with the server** - When this check box is enabled, Avaya iClarity IP Audio will use the port range that you specify in the associated fields. This feature is used to restrict the Avaya iClarity IP Audio to a limited range of ports with which to communicate through a network firewall. Avaya iClarity IP Audio uses the UDP and TCP/IP protocols in association with this range.

  Note:
  The range specified must cover a range of at least 100 ports.

- **Lowest port number** - Enter the lowest port that Avaya iClarity IP Audio will use. The minimum for this field is 1025.
· **Highest port number** - Enter the highest port that Avaya iClarity IP Audio will use. The maximum for this field is 65535.

### Audio Port Range Administration

On the Avaya communication server, use the **UDP Port Range** fields on the **IP Network Region** administration screen to configure the port selections for an IP endpoint. Prior to administering the audio port range values, you must set the IP network region with which the endpoint will be associated. See the documentation for your Avaya communication server for information on network regions.

![IP Network Region](image)

It is important that the intersection of the audio port ranges set for Avaya iClarity IP Audio and for the Avaya communication server overlap by at least 100 ports. In the event that the overlap is less than 100, the range reported by the Avaya communication server is ignored.

For example, if the port range is set to 51000-51100 and the Avaya communication server reports an audio port range of 50950-51005, then the overlap is 5 and Avaya iClarity IP Audio ignores the range reported by the Avaya communication server.

**Note:**

The Avaya communication server may require that you enable ports 1719 and 1720 on your firewall for proper communication.
Agent Greetings settings

The Agent Greetings dialog boxes are used to configure a single agent greeting. Through these settings, you configure the criteria that will cause this agent greeting to be played.

This section contains the following topics:

- [Greeting Description settings](#) on page 235
- [ANI settings](#) on page 236
- [VDN settings](#) on page 237
- [Prompted Digits settings](#) on page 238

Greeting Description settings

The Greeting Description dialog box contains the following controls:

- **Greeting** - Enter the title of this Agent Greeting.
- **Description** - Enter text in this field to provide more information for this agent greeting, such as purpose or usage.
- **Auto-play only for Agent ID** - If this option is selected, this agent greeting is played for incoming calls only if the currently logged in agent ID matches the ID entered in the associated field to the right of this option button.
- **Auto-play only when an agent is logged in** - If this option is selected, this agent greeting is played for incoming calls only if the agent is logged in to the ACD.
Dialog Reference

- **Auto-play greeting for all incoming calls** - If this option is selected, this agent greeting is played for all incoming calls, even if the agent is not currently logged in to the ACD.

- **Auto-play only in active agent mode** - If this check box is enabled, this agent greeting is played only if the agent is in the Auto-In or Manual-In work mode.

---

### ANI settings

The ANI (Automatic Number Identification) dialog box contains the following controls:

- **Auto-play only for this ANI** - When this check box is enabled, this agent greeting is played only if the ANI string contains the digits that you specify in the accompanying field to the right of this check box.

- **Partial Matching** - When this check box is enabled, this agent greeting is played if the digits in the **Auto-play only for this ANI** field appear anywhere within the ANI string.

- **Look for the digits from the** - If you enable the **Partial Matching** check box, you must also select the location in the ANI string where the digits are to be found. For example, if you select the **Left** option, the digits specified in the **Auto-play only for this ANI** field must be the first digits in the ANI string.

- **Starting at** - This field is displayed only if the **Look for the digits from the** field is set to **Middle**. Use this field to specify how many digits from the left side of the string should be ignored before attempting to match the digits specified in the **Auto-play only for this ANI** field.

The field at the bottom of this dialog box displays the current settings and how those settings are applied in the comparison of an ANI string.
VDN settings

The VDN dialog box contains the following controls:

- **Auto-play only for this VDN** - When this check box is enabled, this agent greeting is played if the VDN on which the call is received matches the numeric string in the associated field to the right of this check box.

- **Partial Matching** - When this check box is enabled, this agent greeting is played if the digits in the **Auto-play only for this VDN** field appear anywhere in the VDN string.

- **Look for the digits from the** - If you enable the **Partial Matching** option, you must also select the location in the VDN string where the digits are to appear. For example, if you select the **Right** option, the digits specified in the **Auto-play only for this VDN** field must match the final digits in the VDN number for this agent greeting to be played.

- **Starting at** - This field is displayed only if you set the **Look for the digits from the** field to **Middle**. Use this field to specify how many digits from the left side of the string should be ignored before the system attempts to match the digits specified in the **Auto-play only for this VDN** field.

The field at the bottom of this dialog box displays the current settings and how those settings are applied in the comparison of a VDN string.
The **Prompted Digits** dialog box contains the following controls:

- **Auto-play only for these prompted digits** - When this check box is enabled, this agent greeting is played if the digits entered by the caller during vector processing match the digits in the associated field.

- **Partial Matching** - When this check box is enabled, this agent greeting is played if the digits in the **Auto-play only for these prompted digits** field appear anywhere within the string of prompted digits.

- **Look for the digits from the** - If you enable the **Partial Matching** option, you must also select the location in the prompted digits string where the digits can be found. For example, if you select the **Middle** option, the digits specified in the **Auto-play only for these prompted digits** field must be present in the string, at the position specified in the **Starting at** field, for this agent greeting to play.

- **Starting at** - This field is displayed only if the **Look for the digits from the** field is set to **Middle**. Use this field to specify how many digits from the left side of the string should be ignored before the system attempts to match the digits specified in the **Auto-play only for these prompted digits** field.

The field at the bottom of this dialog displays the current settings and how those settings are applied in the comparison of the string of prompted digits.
Audio settings

This section provides descriptions of the Audio Options and Audio Tuning Wizard dialog boxes. Both of these dialog boxes are available for Road Warrior (VoIP) configurations. The Telecommuter configuration uses only the Audio Tuning Wizard dialog box.

This section contains the following topics:

- Audio Options dialog box on page 239
- Audio Monitor dialog box on page 241
- Volume and Ringer Settings dialog box on page 242
- Audio Tuning Wizard on page 243

Audio Options dialog box

The Audio Options dialog box contains the following items:

- **Headset or Handset** - Select this option button if you are using a headphone or a handset to speak to and hear the other party on a call. This option button is disabled if the Audio Tuning Wizard identifies a half-duplex sound card in your personal computer.

- **PC Microphone and PC Speakers** - Select this option button if you are using a microphone and personal computer speakers to speak to and hear the other party on a call.
- **Automatic Acoustic Echo Cancellation** - This feature is not available in this release of iClarity.

- **Half-Duplex Sound Card** - Select this option if you have a half-duplex sound card in your personal computer. This option button is disabled if the Audio Tuning Wizard identified a full-duplex sound card in your personal computer. If you are using Avaya IP Agent in the Road Warrior (VoIP) configuration, it is highly recommended that you use a full-duplex sound card for maximum audio quality. A list of supported sound cards is available on the Internet at [http://support.avaya.com](http://support.avaya.com).

- **Bandwidth Setting** - Select how your personal computer connects to the Avaya communication server. Avaya IP Agent uses the bandwidth setting to determine which codec to use with the Avaya communication server. This field contains the following options:
  - **28800 bps or faster modem** - For a 28800 bps or better mode connection, the G.723 codec may be used. This codec is used for low-speed connections.
  - **Cable, xDSL or ISDN**
    - G.729a - Use this codec for mid-speed connections.
    - G.723 - Use this codec for low-speed connections.
  - **Local Area Network**
    - G.711 u-law (CCITT u-law) - Use this codec for high-speed connections.
    - G.711 A-law (CCITT A-law) - Use this codec for high-speed connections.
    - G.729a - Use this codec for mid-speed connections.
    - G.723 - Use this codec for low-speed connections.

- **Jitter Buffer** - Displays the size of the jitter buffer, which stores packets to ensure a consistent delivery of voice to your speakers or headset so that the voice stream you hear does not contain gaps. The larger the jitter buffer, the longer the delay receiving audio from the other party. Generally, a maximum of 200 milliseconds is considered acceptable. Avaya recommends that you use the **Automatic** setting so that Avaya iClarity IP Audio changes the setting as necessary. If this setting does not provide adequate audio quality, contact Avaya technical support for assistance.

⚠️ **Important**: Do not disable the jitter buffer or set the jitter buffer to none. This will cause problems for any Voice-over-IP communications.

- **Receive Gain** - Use the slider control to set the gain for incoming sound during a call. The default value is 1.00.

- **Transmit Gain** - Use the slider control to set the gain for outgoing sound during a call. The default value is 0.25.

- **Audio Receive Clarity** - Enter a value to adjust the quality of incoming sound during a call. The default value is 1. If you experience popping and clicking noises with the audio received through Voice-over-IP, you should increase this value. This value can range
between 1 and 100. You should use the lowest possible value that eliminates the quality problems. Increase the value by 1 until the problem no longer occurs.

- **Always use this value** - Enable this check box if you do not want Avaya iClarity IP Audio to automatically adjust this value through the Audio Tuning Wizard.

- **Comfort Noise** - Sets whether you want Avaya iClarity IP Audio to generate noise when the other party is not speaking. This noise indicates to you that the call is still active.

- **Restore** button - Select this button to use the values for the settings that were present when this dialog box was opened.

- **Reset** button - Select this button to set all values to the default product values.

**Note:**
You cannot restore or reset settings while you are logged in to the server.

---

**Audio Monitor dialog box**

The **Audio Monitor** dialog box displays the current statistics for your Voice-over-IP (VoIP) communications. These statistics are available only during an active call. If the quality of your VoIP communications degrades, use this dialog box to determine which areas are problematic and which settings in the **Audio Options dialog box** should be changed.
The **Volume and Ringer Settings** dialog box contains the following items:

- **Playback**
  - **Volume** - Use this slider to adjust the volume for all sound output through your personal computer speakers or headphones.
  - **Mute** - Enable this check box to eliminate all sound output through your speakers or headset.

- **Sidetone**
  - **Volume** - Use this slider to adjust the volume of your voice as heard through your headset or PC speakers.
  - **Mute** - Enable this check box to eliminate hearing your own voice through your headset or PC speakers.

- **Record**
  - **Volume** - Use this slider to adjust the volume of all sound transmitted through a microphone to your personal computer.
  - **Mute** - Enable this check box to eliminate sound being sent to your personal computer through the microphone.

- **Ringer**
  - **Volume** - Use this slider to adjust the volume of the sound that is played through your speakers or headset that occurs when you receive an incoming call.
  - **Mute** - Enable this check box to eliminate any sound that indicates an incoming call.

- **Play ringing through the internal PC speaker** - Enable this check box to play the sound associated with an incoming call through the speakers of your personal computer and your headset simultaneously. If your personal computer does not have an internal speaker, this option will have no effect.
The **Audio Tuning Wizard** is a feature that detects the hardware and software settings for your personal computer. It will also have you test the levels for your microphone and speakers for optimum performance. See [Initializing IP Endpoint configurations](#) on page 103 for information and descriptions for the Audio Tuning Wizard interface.
Appendix A: Shortcut keys

This section contains quick reference information for shortcut keys.

Shortcut keys refer to key combinations that you can use to invoke a particular command. For example, to place a call on hold, you can press Ctrl + H. Some of the most commonly used shortcut keys are shown in this section. In order for shortcut keys to work as documented, the Avaya IP Agent window must have focus as the current application.
Shortcut key functions

This section contains the shortcut keys that can be used when the Avaya IP Agent is the currently selected window on your desktop. These shortcut keys are divided into the following categories:

- **Call features** on page 246
- **Agent features** on page 246
- **Avaya IP Agent features** on page 247
- **Windows features** on page 247

### Call features

<table>
<thead>
<tr>
<th>To...</th>
<th>Press...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Place a call on hold</td>
<td>Ctrl + H</td>
</tr>
<tr>
<td>Transfer a call</td>
<td>Ctrl + T to dial the number and then again to transfer the call</td>
</tr>
<tr>
<td>Conference another party</td>
<td>Ctrl + F to dial the number and then again to conference the call</td>
</tr>
</tbody>
</table>

### Agent features

<table>
<thead>
<tr>
<th>To...</th>
<th>Press...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log in</td>
<td>Ctrl + Ins</td>
</tr>
<tr>
<td>Log out</td>
<td>Ctrl + Del</td>
</tr>
<tr>
<td>Change to After Call Work (ACW) mode</td>
<td>Ctrl + W</td>
</tr>
<tr>
<td>Change to Auxiliary Work (AUX) mode</td>
<td>Ctrl + A</td>
</tr>
<tr>
<td>Change Available mode assignment to automatic (Auto-In)</td>
<td>Ctrl + I</td>
</tr>
<tr>
<td>Change Available mode assignment to manual (Manual-In)</td>
<td>Ctrl + M</td>
</tr>
</tbody>
</table>
## Shortcut key functions

<table>
<thead>
<tr>
<th>To...</th>
<th>Press...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Request supervisor assistance (Assist)</td>
<td>Ctrl + S</td>
</tr>
<tr>
<td>Mark an event log entry</td>
<td>Ctrl + E</td>
</tr>
</tbody>
</table>

Use this key combination to place an identifier on a line in the event log. This can be used to indicate when you notice a problem. This feature is only available when the event logging feature is enabled.

---

## Avaya IP Agent features

<table>
<thead>
<tr>
<th>To...</th>
<th>Press...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display the <strong>Call menu</strong> for an incoming call</td>
<td>Alt + C</td>
</tr>
<tr>
<td>Display the <strong>Call History</strong> window</td>
<td>Alt + H</td>
</tr>
<tr>
<td>Display the <strong>Phone Directory</strong> window</td>
<td>Alt + D</td>
</tr>
<tr>
<td>Display the <strong>Search Public Directory</strong> window</td>
<td>Alt + S</td>
</tr>
<tr>
<td>Display online help</td>
<td>F1</td>
</tr>
<tr>
<td>Exit Avaya IP Agent or close the current active window</td>
<td>Alt + F4</td>
</tr>
</tbody>
</table>

View the Properties of the selected item in the **Search Public Directory**, **Screen Pops**, or **Phone Directory** windows.

<table>
<thead>
<tr>
<th>To...</th>
<th>Press...</th>
</tr>
</thead>
<tbody>
<tr>
<td>View the Properties of the selected item in the <strong>Search Public Directory</strong>, <strong>Screen Pops</strong>, or <strong>Phone Directory</strong> windows.</td>
<td>Alt + Enter</td>
</tr>
</tbody>
</table>

---

## Windows features

<table>
<thead>
<tr>
<th>To...</th>
<th>Press...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alternate between running applications</td>
<td>Alt + Tab</td>
</tr>
<tr>
<td>Cut selected text to the clipboard</td>
<td>Ctrl + X</td>
</tr>
<tr>
<td>To...</td>
<td>Press...</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Copy the selected text to the clipboard</td>
<td>Ctrl + C</td>
</tr>
<tr>
<td>Paste clipboard contents to the selected area</td>
<td>Ctrl + V</td>
</tr>
</tbody>
</table>
Appendix B: Language support

This section contains quick reference information for supported languages.
Untranslated components

The following Avaya IP Agent components are provided only in English:

- Installation
- Event log
- Avaya IP Agent internal files
- Shortcut keys
- readme.txt file
- Uninstall program
Supported languages for Avaya IP Agent

There are nine languages supported with Avaya IP Agent:

- English (US)
- Italian
- French
- German
- Portuguese (Brazilian)
- Spanish
- Japanese
- Korean
- Chinese (Simplified)

The English version of Avaya IP Agent can be installed on supported operating systems using the languages specified above. Other language versions of Avaya IP Agent can be installed only on supported operating systems using that language. For example, the German version of Avaya IP Agent can be installed only on supported operating systems using German.
Language support
Appendix C: Troubleshooting

This section contains information used for troubleshooting problems with Avaya IP Agent. It is divided into the following topic areas so that it is easy for you to locate the information that you need:

- **Login** on page 254
- **Voice-over-IP** on page 257
- **Making and receiving calls** on page 261
- **Other** on page 263
- **Alternative solution possibilities** on page 267
## Login

This section lists those problems associated with registering with the Avaya communication server and logging in as an agent.

<table>
<thead>
<tr>
<th>Problem</th>
<th>What to do</th>
</tr>
</thead>
</table>
| Cannot register with the Avaya communication server. | Check for a valid configuration:  
  - Avaya IP Agent has limited support for firewalls and Virtual Private Networks (VPN). See [Advanced tab](#) on page 233 for more information on configuring Avaya IP Agent for use with VPNs.  
  - An Avaya communication server earlier than DEFINITY R10 cannot be used for Avaya IP Agent. MultiVantage and Communication Manager servers are fully supported.  
  - Ensure that the network connection from the personal computer is operating normally.  
  - Ensure that the integrated firewall feature of Windows XP is disabled. If this feature is enabled, iClarity IP Audio cannot function properly. |
| Agents cannot log in to EAS.                      | Ensure that the following administration items have been addressed:  
  - Feature Access Codes are administered.  
  - If you are using a Road Warrior (VoIP) configuration, ensure that an IP Media Processor has been properly configured so that Road Warrior (VoIP) configurations can operate properly.  
  - If the Avaya communication server has the station set for Auto-answer, ensure that Avaya IP Agent has the **Enable support for auto-answer** option enabled in the **Program Options** window.  
  - Ensure that the station is configured for an AUX button. Without this button, agents cannot log in correctly if the Avaya communication server is configured so that agents must enter AUX work mode when logging in to EAS. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>What to do</th>
</tr>
</thead>
<tbody>
<tr>
<td>You changed your login extension but the Avaya communication server does not recognize your login.</td>
<td>Restart your personal computer and attempt the login procedure again.</td>
</tr>
<tr>
<td>The phone download for the Avaya CallMaster VI failed.</td>
<td>Enter the PASTE code again for the Avaya CallMaster VI so that the Avaya communication server sends the updates to the station. Select <strong>Tools &gt; Program Options</strong> and enter the number in the <strong>PASTE Feature Access Code:</strong> field. <strong>Note:</strong> Avaya communication servers can transmit only eight PASTE downloads simultaneously. To ensure that you do not encounter this download failure in the future, agents in the contact center should leave Avaya IP Agent running after logging off when shifts are completed.</td>
</tr>
</tbody>
</table>
| The agent does not seem to be logged in because all of the icons are still disabled. | Verify the following configuration items:  
  - On the Avaya communication server, verify that the station has the following work mode features assigned to buttons. If these buttons are not assigned to the station, Avaya IP Agent cannot enable the work modes on Agent toolbar:  
    - Auto-in or Manual-in  
    - After Call Work (ACW) (optional)  
    - Auxiliary Work (AUX).  
  - On the Avaya communication server, verify that the first **AUX work mode** button assigned to the station has a blank reason code or a reason code of 0. |
| The agent logs in but is immediately logged out.                       | If the station or agent is administered as **auto-answer** on the Avaya communication server, you must activate **Enable support for auto-answer** in the **Program Options** for Avaya IP Agent. After changing this setting in Avaya IP Agent, you must restart Avaya IP Agent for the change to take effect. |
### Problem
Agents are logged off repeatedly from EAS or the Avaya communication server.

### What to do
- Ensure that the network is not having stability problems or failures in service.
- On the Avaya communication server, ensure that the **Auto-In** field for the agent is set to **station** and not **aux**. Also, ensure that the **Enable automatic login** option in the **Program Options** dialog for Avaya IP Agent is activated.
- If you are using Avaya CallMaster VI stations or emulation, a PASTE code is required on the Avaya communication server.
This section lists those problems that are associated with Road Warrior (VoIP) configurations.

<table>
<thead>
<tr>
<th>Problem</th>
<th>What to do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent cannot be heard by other party.</td>
<td>● Ensure that a defective sound card or microphone is not being used.</td>
</tr>
<tr>
<td></td>
<td>● Ensure that the sound card is configured properly through Windows.</td>
</tr>
<tr>
<td></td>
<td>● Ensure that excessive background or personal computer noises are not</td>
</tr>
<tr>
<td></td>
<td>preventing voice transmission.</td>
</tr>
<tr>
<td></td>
<td>● Adjust the transmit gain level when using full-duplex mode in a noisy</td>
</tr>
<tr>
<td></td>
<td>environment.</td>
</tr>
<tr>
<td></td>
<td>● Ensure that the microphone or headset is not muted.</td>
</tr>
<tr>
<td>Transmit and Receive lights on the status bar are red.</td>
<td>The selected bandwidth setting cannot be supported. To change bandwidth</td>
</tr>
<tr>
<td></td>
<td>settings, log out of the ACD and the Avaya communication server, select</td>
</tr>
<tr>
<td></td>
<td>Settings from the Login window, and select a lower bandwidth setting on</td>
</tr>
<tr>
<td></td>
<td>the Audio tab.</td>
</tr>
<tr>
<td>There is excessive bandwidth usage when an agent is not</td>
<td>On the Avaya communication server, change the Service Link Mode: for this</td>
</tr>
<tr>
<td>actively on calls.</td>
<td>extension from permanent to as-needed.</td>
</tr>
<tr>
<td>Agents cannot establish calls.</td>
<td>● Ensure that an improper codec is not in use.</td>
</tr>
</tbody>
</table>
|                                                               | ● Ensure that the network can support the bandwidth required for Voice-over-IP.
## Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>What to do</th>
</tr>
</thead>
</table>
| The voice quality of the agent is poor when using Voice-over-IP (Road Warrior). | - Check to see if the iClarity Status screen displays a high number of dropped packets and a low number of discarded packets. This indicates an inadequate sound card in the personal computer.  
- Check to see if the iClarity Status screen displays an equal number of dropped and discarded packets. This indicates problems with network bandwidth.  
- If the iClarity Status screen displays the correct information, run the Tuning Wizard again. The Tuning Wizard cannot be run while the transmit and receive channels are active. To deactivate the transmit and receive channels, you can either log the extension out of the Avaya communication server or change the extension settings from the Avaya communication server to use the as-needed option for the Service Link Mode field instead of permanent.  
- Ensure that your personal computer has enough system resources to handle VoIP communications in addition to the applications being used. See Voice-over-IP considerations on page 33.  
- If you are experiencing problems while using Internet Explorer, disable the Play Sounds feature of Internet Explorer. |
| The voice quality of the other party is poor when using Voice-over-IP (Road Warrior). | - Lower the gain setting on the microphone.  
- Set the Jitter Buffer in the Audio Options dialog box to Automatic.  
- Ensure that your personal computer has enough system resources to handle VoIP communications in addition to the applications being used. See Voice-over-IP considerations on page 33.  
- If you are experiencing problems while using Internet Explorer, disable the Play Sounds feature of Internet Explorer. |
<p>| Agent hears his or her own voice (Road Warrior).                        | Lower the Transmit Gain in the Audio Options dialog box.                                                                                                                                                 |
| Caller hears his or her own voice (Road Warrior).                      | Lower the Receive Gain in the Audio Options dialog box.                                                                                                                                                 |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>What to do</th>
</tr>
</thead>
</table>
| Receiving and transmitting audio is delayed using the Road Warrior     | ● Ensure that your Avaya communication server is optimized to handle “shuffling” and “hairpinning” for Voice-over-IP. Consult your Avaya communication server documentation for more information.  
● Lower the Jitter Buffer in the Audio Options dialog box.  
● If you are using the Windows Quality of Service (QoS) feature in conjunction with a firewall, the range of ports for QoS set up on the Avaya communication server must overlap the range of firewall ports specified in Avaya IP Agent by 100 ports. If these ranges do not overlap by 100 ports, QoS is not used by iClarity IP Audio, and transmissions are done within the range of firewall ports.  
● Ensure that your personal computer has enough system resources to handle VoIP communications in addition to the applications being used. See Voice-over-IP considerations on page 33  
● If you are experiencing problems while using Internet Explorer, disable the Play Sounds feature of Internet Explorer. |
| There is echo and poor voice quality while using Voice-over-IP (Road    | ● If you are using speakers and a microphone instead of a headset, change to half-duplex in the Audio Options dialog box. Using separate speakers and a microphone can cause feedback.  
● Ensure that your personal computer has enough system resources to handle VoIP communications in addition to the applications being used. See Voice-over-IP considerations on page 33  
● If you are experiencing problems while using Internet Explorer, disable the Play Sounds feature of Internet Explorer. |
## Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>What to do</th>
</tr>
</thead>
</table>
| You do not know how to stop the transmit and receive audio traffic.    | - If the **Service Link Mode** for this station is set to **permanent** on the Avaya communication server, the transmission and receiving of audio over the network is inactive only when the agent first logs in. The first call that occurs for this extension will cause the audio traffic to begin and remain active until the extension is logged off of the Avaya communication server.  
- If the **Service Link Mode** for this station is set to **as-needed**, the audio link will become inactive 10 seconds after the release of a call. |
| The **Audio Tuning Wizard** does not run when you attempt to start it. | The **Audio Tuning Wizard** cannot be run while the audio transmit and receive channels are active. If you are on an active call, wait until the call has been completed, log out of Avaya IP Agent, and log out of the Avaya communication server. You must then re-register your extension with the Avaya communication server, run the Audio Tuning Wizard, and then log in as an agent through Avaya IP Agent. |
## Making and receiving calls

This section lists problems that are associated with placing outgoing calls and receiving incoming ACD calls through Avaya IP Agent.

<table>
<thead>
<tr>
<th>Problem</th>
<th>What to do</th>
</tr>
</thead>
</table>
| Agents cannot place calls. | ● Ensure that the agent is logged in.  
● Check the Windows Dialing Properties to rule out improper number formatting. Dialing rules must conform to the dialing rules of the country in which the Avaya communication server resides.  
● Ensure that calling cards are not being used. |
| In Telecommuter mode, picking up the handset does not automatically answer the incoming call displayed in the Avaya IP Agent window. | ● Ensure that the Service Link Mode: for the station is set to as-needed.  
● Ensure that the Enable support for auto-answer option is disabled. This option is found in the Program Options in Avaya IP Agent. If this option is enabled, disable it and then reboot your personal computer.  
● The auto-answer feature must be configured in Avaya IP Agent and for the station definition on the Avaya communication server. |
## Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>What to do</th>
</tr>
</thead>
</table>
| In the Telecommuter or IP Telephone configurations, the Avaya IP Agent main window does not display that a call is incoming until the second or third ring. The main window is very slow in displaying the Call Information Panel for an incoming call. | - The processor of the personal computer is being used too heavily. To resolve this problem, close one or more applications to decrease the load on the processor.  
- A virus scanning program is monitoring and validating the activity of the executable files for Avaya IP Agent and any log files. To resolve this problem, configure the virus scanning application to not scan the directory where Avaya IP Agent was installed. By default, this location is as follows:  
  C:\Program Files\Avaya\Avaya IP Agent  
  Alternatively, you can configure your virus scan program to scan instances only where program files are written to instead of all file types. This will decrease the necessity of your virus program to scan the log files that are modified in Avaya IP Agent when a call is received.  
- Ensure that there is enough network bandwidth for Avaya IP Agent to receive the data channel information in a timely manner. |
This section lists general problems that one might encounter with Avaya IP Agent.

<table>
<thead>
<tr>
<th>Problem</th>
<th>What to do</th>
</tr>
</thead>
</table>
| Collected digit information is not displayed.     | ● You must have a **callr-info** button assigned for non-CallMaster telephones so that collected digit information is displayed. Buttons are configured for extensions through the `change station` command on the Avaya communication server.  
  ● Ensure that VuStats is deactivated. This can be done by double-clicking on the **Normal Mode** button in the **Phone Features** window. |
<p>| User-to-User-Information (UUI) is not being displayed. | On the Avaya communication server, ensure that the <strong>UUI IE Treatment</strong> field in the <strong>Trunk-Group definition</strong> form is set to <code>service-provider</code>. |
| The Call Information Panel (CIP) is not displaying any data. | This problem can occur if you are emulating a phone type that is normally configured to display 40 characters of information and it is currently in use because of VuStats, Q-call, or if it is already busy with information from another incoming call. You can either change the phone type emulation to one that displays 80 characters of information or disable VuStats so that the call information panel is not committed to displaying this information. See <a href="#">Compatible telephone types for Avaya IP Agent</a> on page 21 for telephones that support 80 character displays. |
| In Telecommuter mode, touch-tones are not sent when the agent presses the buttons of the number pad on the telephone. | This situation occurs because the data portion of the Telecommuter configuration is sent through Avaya IP Agent on the personal computer and not the telephone. Use the <strong>Dial Pad</strong> or the personal computer keyboard to enter numbers where Dual Tone Multi-Frequency (DTMF) signals are needed. |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>What to do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Avaya IP Agent is reacting slowly.</td>
<td>The Event Logging feature of Avaya IP Agent can inhibit product performance. If you are not working with Avaya support personnel to solve a problem with Avaya IP Agent, this feature should be disabled.</td>
</tr>
</tbody>
</table>
| The settings for one Avaya IP Agent installation were exported, but the import did not seem to work on another workstation. | ● Ensure that you are not trying to use exported settings from an Avaya IP Agent installation on another operating system. Setting exports from an operating system, such as Microsoft Windows 2000, cannot be imported on a different operating system, such as Microsoft Windows XP. Also, if one Avaya IP Agent installation is configured for Avaya CallMaster VI, those settings cannot be imported to an Avaya IP Agent installation with an IP Endpoint configuration.  
● If you are renaming items from the **Phone Features** or **Personal Phone Features** windows, you must use the **Rename (All Extensions)** option. Otherwise, the name change only occurs for the specific extension number. |
| The button feature assignments were changed for this extension, but the assignments either are not displayed in Avaya IP Agent or they fail to work. | Do the first item in the following list. If the first item does not correct the problem, use the subsequent items that are appropriate for your configuration.  
● Select **Tools > Phone Features** from the main window and then select **Rebuild All** from the menu bar on the **Phone Features** window.  
● Refresh the phone features for your Avaya CallMaster VI by selecting **Settings > Phone Configuration** from the menu bar.  
● For IP Endpoint configurations, exit and restart Avaya IP Agent. |
<p>| <strong>Phone Feature</strong> buttons do not work or are performing a different function. | If you are logging in as a different extension than the one that was just used with Avaya IP Agent, you must reboot the personal computer and log in again to regain these functions.                                                                                      |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>What to do</th>
</tr>
</thead>
<tbody>
<tr>
<td>The agent was in Auto-In mode, received a call, and selected the After Call Work mode. When the call was finished, the work mode changed back to Auto-In.</td>
<td>If the agent needs to use the After Call Work mode consistently, use the Manual-In work mode instead of the Auto-In work mode.</td>
</tr>
</tbody>
</table>
| The agent is unable to record greetings.                                | • For Avaya CallMaster VI configurations, check to see if the headset button in the Agent Greetings window is activated. If so, click on the button to deactivate it and try to record the greeting again. The headset can also be deactivated through the headset button on the Avaya CallMaster VI unit.  
  • For Road Warrior (VoIP) configurations, the recording of agent greetings can be done only when the transmit and receive audio connections are inactive. You can log off and restart Avaya IP Agent to record agent greetings, but the first call instance that occurs will once again disable the ability to record agent greetings.  
  • For Telecommuter (without Avaya Switcher II), IP Telephone, and Avaya Telephone configurations, agent greetings are not supported. |
| The folders in the Phone Features window are not in the appropriate language. | This problem occurs when multiple languages are installed for Avaya IP Agent. When first opened, the Phone Features window displays the names of the folders in the language version of Avaya IP Agent that is currently running. However, if you change to a different language version, the folders in this window retain the language used when the window was first opened. To reset the folders to the current language, select File > Rebuild All from the menu bar on the Phone Features window. This action will reset all folders and features. Any customization you may have made to feature names will be lost. |
| How to remove the call timer                                           | The call timer can be removed from Call Information Panels by editing the following entry in the Registry:  
[HKKEY_LOCAL_MACHINE\SOFTWARE\Avaya\Avaya IP Agent\Config\Settings]  
"HideCallTimer"=dword:00000001 |
# Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>What to do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fatal errors are occurring when the <strong>Call History</strong> window is opened.</td>
<td>This could be a sign that the Avaya IP Agent database is corrupt. To resolve this problem, uninstall and reinstall Avaya IP Agent. Any data stored in the database previous to this action is lost.</td>
</tr>
<tr>
<td>When <strong>Play greetings using Avaya Switcher II</strong> is enabled in the Audio Tuning Wizard, the <strong>Agent Greetings</strong> item does not appear in the <strong>Tools</strong> menu.</td>
<td>After you have enabled this feature, you must restart Avaya IP Agent for the <strong>Agent Greetings</strong> menu item to be displayed.</td>
</tr>
</tbody>
</table>
Alternative solution possibilities

If the information in this section did not solve your problem, it is possible that areas other than Avaya IP Agent are at fault. You can investigate the following areas for solutions:

- Firewall configurations
- Network configurations and available bandwidth
- Speed and available resources of the personal computer being used with Avaya IP Agent
- Problems with the Central Office (your telephone service provider)
- Network failures (WAN/LAN)
- Problems occurring in the other party’s telephone system
- VPN software problems (timeouts, configuration)
- Avaya communication server configuration problems
Troubleshooting
<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Abbreviated Dial Feature</strong></td>
<td>Allows the agent to store telephone numbers, that the agent selects, for quicker and easier dialing by selecting a single button. Each number can be a complete or partial telephone number, an extension number, or a trunk or feature code.</td>
</tr>
<tr>
<td><strong>ACD</strong></td>
<td>See <a href="#">Automatic Call Distribution (ACD)</a>.</td>
</tr>
<tr>
<td><strong>Active Call</strong></td>
<td>A call appearance state where the voice (talk) path between two parties has been connected.</td>
</tr>
<tr>
<td><strong>ACW</strong></td>
<td>See <a href="#">After Call Work (ACW)</a>.</td>
</tr>
<tr>
<td><strong>Add/Remove Programs</strong></td>
<td>A Microsoft Windows feature that allows you to remove programs that have been installed on your computer. The Add/Remove Programs component is found in the Control Panel.</td>
</tr>
<tr>
<td><strong>After Call Work (ACW)</strong></td>
<td>An ACD agent work mode in which agents are performing tasks related to a previously completed call. In this mode, the agents are unavailable to receive ACD calls.</td>
</tr>
<tr>
<td><strong>Agent</strong></td>
<td>A person who receives calls that are delivered from a split or skill.</td>
</tr>
<tr>
<td><strong>Agent greetings</strong></td>
<td>Recorded messages played by Avaya IP Agent when a call is received by an agent. This feature is used to eliminate the need for an agent to repeat the same statement for every call.</td>
</tr>
<tr>
<td><strong>Agent Mode</strong></td>
<td>An agent logs into an Avaya communication server with a specific agent ID, which is associated with certain assigned skills and configuration settings. Do not confuse this with registering as an extension with the Avaya communication server as an agent must first register as an extension before logging in with an agent ID. Logging in as an agent enables the Agent toolbar in the main window.</td>
</tr>
</tbody>
</table>
Agent Skill

Agent Skill
A centrally-defined attribute that is associated with an EAS ACD agent ID, which represents a certain ability or assignment for that agent. An agent can be assigned up to 20 skills. The meaning of each Agent Skill is customizable. Examples of what could be considered skills are: the ability to speak a particular language or the expertise to handle a certain product.

Agent work mode
A feature of agent call handling. Agent work modes are the different call work modes and call states an agent can be in (logins, logouts, After Call Work, AUX, and so forth). Data about these states is displayed in the history log.

Agent toolbar
A toolbar that provides buttons for agent login and logout and agent modes, such as Auto-In, Manual-In, and After Call Work.

Alternate Gatekeeper
A feature of Avaya communication servers that notifies IP endpoints of all IP addresses for a network region. If communication fails with an IP address on the Avaya communication server, Avaya IP Agent attempts to reconnect with another IP address within the same network region.

Alternate User Interface
Avaya IP Agent interfaces that use much less space on the Desktop than the main window.

Assist
Allows an agent to request assistance (whether on an active ACD call or not) from the split or skill supervisor by pressing the Assist button or by putting the call on hold and dialing the Assist feature access code, followed by the split group number. The agent must be logged into the split or skill.

Auto-answer
An Avaya communication server feature where calls directed to an agent are connected without any action required on the part of the agent. An agent can begin conversing with the other party without having to accept the call by activating a call appearance or releasing the switch hook.

Autodial
A telephone feature where a single button is used to dial a complete telephone number.

Auto-In
An ACD work mode. In the Auto-In mode, when an agent disconnects from a call, that agent is automatically available to receive another ACD call.

Automatic Call Distribution (ACD)
A method of call distribution where EAS agents are placed in groups called skills. An EAS agent can be logged into up to 20 skills simultaneously. EAS distributes calls to the extension of an agent that possesses the necessary skill.

Automatic Number Identification (ANI)
A service that provides the telephone number of an incoming call.
AutoPlay: A Microsoft Windows feature that causes an application on a CD-ROM to run without any user interaction as soon as the CD-ROM is inserted into the drive.

AUX: See Auxiliary Work (AUX) mode.

AUX RC: See Auxiliary Reason Code (AUX RC).

Auxiliary Reason Code (AUX RC): A numeric code that describes the reason for entering the AUX work mode, such as lunch or meetings. This Expert Agent Selection (EAS) feature enables a contact center to track the time of an agent more precisely.

Auxiliary Work (AUX) mode: An ACD agent work mode indicating that the agent is unavailable (for example, observing a pre-defined period of inactivity or in training) to receive an ACD call.

Available: An agent state in which the agent is able to accept an ACD call. This is a sub-state of the Auto-In and Manual-In modes.

Avaya communication server: A DEFINITY, MultiVantage, or Communication Manager system. These systems receive and distribute communications throughout a contact center.

Avaya IP Softphone: Avaya IP Softphone is an Avaya product that enables you to log in to an Avaya communication server as an extension. Avaya IP Softphone does not support agent login and cannot co-reside with Avaya IP Agent.

Avaya Switcher II: A type of headset unit that provides connections to a telephone and to the soundcard of a PC. This headset allows you to record and play agent greetings in the Telecommuter mode for PC-based installations of Avaya IP Agent.

Avaya Telephone (DCP/IP): An Avaya IP Agent configuration where calls are conducted through a Digital Communication Protocol (DCP) or Internet Protocol (IP) telephone. Avaya IP Agent does not take over, but shares control with the telephone. Any action can be done through either the physical telephone or through Avaya IP Agent. This configuration does not require the creation of a second extension for use with Avaya IP Agent.

Bandwidth: The maximum number of digital bits that can pass through a communications channel every second. For example, Ethernet 10BaseT has a maximum bandwidth of 10 megabits per second.
Basic Conference

A mode of joining multiple parties to the same call. Up to five parties can be added, for a total of six on a call. The agent selects Conference, dials the number through the keyboard, talks to the party, and selects Conference again. See also Enhanced Conference.

Basic Transfer

A transfer mode that sends the current call to another telephone number or extension. The agent remains on the line until the call is answered and can announce the call. See also Enhanced Transfer and Unsupervised Transfer.

Call appearance

A call connected to an extension. Most telephone types can support multiple call appearances simultaneously. Each call appearance is represented with a Call Information Panel in the main window.

Call Information Panel (CIP)

A single panel (40-character display) that displays information about a single call, such as caller name, call duration, status icon, and control buttons, such as Answer/Release and Reconnect.

Call Prompting

An Avaya communication server feature that routes incoming calls based on information entered by the calling party, such as an account number. The caller is prompted to select options from those listed in an announcement. See Prompted digits for related information.

CallMaster VI

A special telephone produced by Avaya. This telephone connects to a personal computer through a serial cable. This telephone and telephone type (606A1) are fully supported by Avaya IP Agent.

Call Work Code

A numeric sequence, up to 16 digits, entered by an agent that identifies the type of call received by the agent. These codes are user-defined and administered on the Avaya communication server.

CIP

See Call Information Panel (CIP).

Circuit pack

Expansion modules that can be used to expand a DEFINITY, MultiVantage, or Communication Manager server. For Avaya IP Agent, the required circuit packs are related to IP communications.

Comma-separated values

Fields and records in a text file that are delimited by commas. This is a simple form of a database.

Communication Manager

The software used in Avaya communication servers. Communication Manager systems succeed and surpass DEFINITY and MultiVantage systems.

Communication server

A general term for Avaya DEFINITY, MultiVantage, and Communication Manager systems.
Conference

See Basic Conference or Enhanced Conference.

Connected

A trunk state in which a caller and an agent are able to converse on an ACD call.

Contact center

A location where communications are received and placed. These communications can be telephone calls, e-mail, Web-based instant messaging, and others.

DDE

See Dynamic Data Exchange (DDE).

DEFINITY ECS

DEFINITY Enterprise Communications Server (ECS). The DEFINITY ECS is a telecommunications system that routes voice and data information between various endpoints, such as telephones, terminals, and computers. It provides highly robust networking capabilities and includes an extensive set of standard features, such as Attendant Consoles, Voice Processing Interface, Call Coverage, DS1/E1 Connectivity, Hospitality Support, Recorded Announcement, and Trunk-to-Trunk Transfer. It also allows for the addition of optional features and upgrades to the system as business needs change.

Delimited text file

A file containing fields, records, and values that are separated by commas, tabs, semicolons, or other characters.

Dial Pad

An Avaya IP Agent dialog box that displays the 12 characters available on a telephone.

Dial Number button

A button on the Dial Number toolbar that an agent uses to go off-hook and initiate a dial tone or to dial the digits previously entered in the Number text box.

Dial Number toolbar

A toolbar that provides a number text box, access to the phone directory, call history, speed dial, and recent calls list. When an agent enters a string (for example, lan) followed by Enter, a popup menu displays with a list of the directory entries that start with that string. If the first character of the number is a letter, the title of the field will be changed from Number to Name.

Dial Plan

The configuration of an Avaya communication server that determines how extensions, external telephone numbers, and server features are contacted or activated. For example, a dial plan might determine that all internal extensions can be reached by dialing a five-digit number. Dial plans are configured through an Avaya communication server.
Digital Communications Protocol (DCP)

A communication protocol used to transmit voice and data between Avaya telephone sets and an Avaya communication server.

DNS

See Domain Naming System (DNS).

Domain

For Windows networking, a domain is a subnetwork comprised of a group of clients and servers under common control.

For the Internet, a domain is the highest subdivision of a domain name. For example, .com, .org, and .net are domains.

Domain Naming System (DNS)

An Internet mechanism where Uniform Resource Locator (URL) addresses are translated to Internet Protocol (IP) addresses. For example, www.avaya.com translates to a series of numbers that use the format 123.123.123.123. DNS servers can exist inside private networks that are separated from the Internet.

Drop

An agent uses this feature to disconnect from a call and place another call or to disconnect the last person added to a conference call.

Dynamic Data Exchange (DDE)

A form of communication between Windows applications that allows the exchange of data, information, and commands.

EAS

See Expert Agent Selection (EAS).

Emergency Call Handling (ECH)

An Avaya communication server feature that determines the location of IP endpoints that place a call to emergency services, such as 911 in the United States.

Enhanced Conference

A feature that allows you to add up to six telephone numbers to a call. See also Basic Conference.

Enhanced Transfer

A transfer option that sends the present call to another phone number or extension. See also Basic Transfer and Unsupervised Transfer.

Expert Agent Selection (EAS)

An optional Avaya communication server feature that builds on the power of the Call Vectoring and ACD features to send a particular call to an agent who has at least one of the skills that the caller requires.

FAC

See Feature Access Code (FAC).
Feature Access Code (FAC)  A 1-to-4 digit number with an optional leading * or # that is assigned during Avaya communication server administration to invoke features. For example, *81 may invoke Service Observing Listen Only. FACs require an available call appearance with dial tone before the FAC can be sent to the Avaya communication server. Assigned FACs may not be available to all users on an Avaya communication server based on class of restrictions and whether the feature has been enabled in the Avaya communication server.

Feature button  A button that can be assigned to any one of a number of Avaya communication server features. Feature buttons are assigned to an extension during station administration on the Avaya communication system.

Firewall  Hardware, software, or a combination of the two that provide a boundary between two or more networks. Firewalls can be implemented on different devices with differing levels of security and access.

Graphical User Interface (GUI)  An environment where icons, dialog boxes, windows, buttons, fields, and other controls are presented through the use of program functions supplied by the operating system. You can interact with the interface with a pointing device, such as a mouse, and, usually, the keyboard.

GUI  See Graphical User Interface (GUI).

H.323  A specification that defines packet standards for multimedia communications over IP networks that interact with telephony networks.

Hold  A feature that allows an agent to leave a telephone call without disconnecting it. You can return to the call at any time.

HTML  See HyperText Markup Language (HTML).

Hypertext  A word or series of words in a software application that can be used to access information through user interaction.

HyperText Markup Language (HTML)  A structured language used in the authoring and presentation of information. See also Hypertext.

iClarity IP Audio  An Avaya component that provides station registration and voice/data signalling with an Avaya communication server.

Installation folder  The directory on the personal computer that contains the Avaya IP Agent files.
Internet Protocol address (IP address)

A unique, 32-bit (4-byte) number that identifies a computer on a TCP/IP network and is used in the transmission and delivery of data packets. An IP address is represented in four, 8-bit (1 byte) values, separated by periods. For example, 128.10.10.1. From left to right, each byte represents greater detail about the logical location within the network.

IP Address
See Internet Protocol address (IP address).

IP Endpoint
A telephone extension that uses IP for data signaling, voice communication, or both. Extensions that use the Road Warrior, Telecommuter, IP Telephone, or Avaya Telephone configuration are considered IP Endpoints.

IP Telephone
A telephone set that uses an Ethernet connection to relay voice communication. This is also the name for the configuration by which control of the telephone is shared by Avaya IP Agent.

Jitter Buffer
A data area where Voice-over-IP packets are collected and assembled for the purpose of playing through an audio device. Because IP packets vary in receipt time, the jitter buffer assists in making audio quality consistent to the listener.

LAN
See Local Area Network (LAN).

LDAP

Lightweight Directory Access Protocol (LDAP)
A network protocol used over TCP/IP networks for querying and retrieving information from a hierarchical directory.

Local Area Network (LAN)
A private, interactive communication network through which computers can communicate over short distances at high data transfer rates.

Log
A record of activity.

Login
The process of identifying a user with a computer, device, or server so that the user can use resources or features. In regards to Avaya IP Agent, an agent must log in to the Avaya communication server to receive ACD calls.

Login ID
A number and that allows an EAS agent to log in to the Avaya communication server. Skills and other information are assigned to the login ID of the agent.

Logout
The act of a user that notifies a computer, device, or server that no further tasks will be performed by this user at this time and that no resources should be allocated for this specific user.
<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manual-In</td>
<td>An ACD work mode. In the Manual-In mode, the agent automatically enters the ACW mode when the agent disconnects from an ACD call. To become available to receive another ACD call, the agent must manually select the Auto-In or Manual-In mode.</td>
</tr>
<tr>
<td>Media Encryption</td>
<td>Communications between Avaya iClarity IP Audio and the Avaya communication server are encoded so that the information cannot be deciphered by unauthorized recipients.</td>
</tr>
<tr>
<td>MultiVantage</td>
<td>A line of next-generation communication servers offered by Avaya. MultiVantage systems succeed and surpass DEFINITY systems.</td>
</tr>
<tr>
<td>Network</td>
<td>A group of devices that are connected in such a way that data or communications can be transmitted and received between the devices.</td>
</tr>
<tr>
<td>Off-Hook</td>
<td>The voice path to your telephone is active.</td>
</tr>
<tr>
<td>On-Hook</td>
<td>The voice path to your telephone is inactive.</td>
</tr>
<tr>
<td>PC Application Software Translation Exchange (PASTE)</td>
<td>A feature of an Avaya communication server where data for a call is passed to a CallMaster VI telephone set, which can then send the data through a serial connection to a program, on the personal computer, that can interpret the data.</td>
</tr>
<tr>
<td>Phone display</td>
<td>A 40-character display that is located in the status bar of the Avaya IP Agent main window. This display area receives information from the Avaya communication server so that you can see call and non-call related information, such as call prompted digits and VuStats.</td>
</tr>
<tr>
<td>Prompted digits</td>
<td>One or more numbers entered by a caller that indicate responses to automated questions posed when the call first enters the contact center.</td>
</tr>
<tr>
<td>PSTN</td>
<td>See Public Switched Telephone Network (PSTN).</td>
</tr>
<tr>
<td>Public Directory</td>
<td>A database that can be accessed through the Lightweight Directory Access Protocol (LDAP) protocol. A Public Directory usually contains information on people or personnel within some unit of organization, such as a business, educational facility, and so forth.</td>
</tr>
<tr>
<td>Public Switched Telephone Network (PSTN)</td>
<td>The worldwide voice telephone network.</td>
</tr>
</tbody>
</table>
### Quality of Service (QoS)

**Quality of Service (QoS)**  
A technology used to prioritize real-time communications over data transmissions. Real-time communications can include multimedia, Voice-over-IP, video, and others. Some operating systems, network devices, and network software support QoS.

**RC**  
See [Reason Code (RC)](#).

**Read-only**  
A folder or file that can be read, but not modified, updated, or deleted.

**Reason Code (RC)**  
A numeric code that describes the reason that an agent enters the AUX work mode or logs out of the system.

**Registry**  
The system-wide repository of information supported and used by Windows.

**Release**  
Disconnects the current call.

**Response file**  
See [Silent install](#).

**Right-To-Use (RTU)**  
A licensing mechanism used in Avaya communication servers. In some situations, multiple RTUs can be used by a single extension so that data and voice signaling are supported.

**Road Warrior**  
An Avaya IP Agent configuration where calls are conducted through a personal computer with a sound card and a network connection by using Voice-over-IP (VoIP). No telephone set is required for this configuration.

**Screen Pop**  
The automatic display of information on the screen of the personal computer from other sources, such as databases or Web pages. Screen Pops are activated by triggering criteria.

**Silent install**  
A method of installing software where no graphical user interfaces are presented and no user interaction is required. This is accomplished through the use of a response file. The response file is a record of selections made during a normal installation of the software. Silent installs that use this response file behave as though the same installation selections were made on the target PC.

**Skill**  
An attribute that is assigned to an ACD Agent. Agent Skills can be thought of as the ability for an Agent with a particular set of skills to handle a call that requires one of those skills.

**Softphone**  
A software application that enables you to control telephone calls, both incoming and outgoing, directly from your computer, where communication is done through Voice-over-IP.
Split
A group of extensions that receives special-purpose calls in an efficient, cost-effective manner. Normally, calls to a split arrive primarily over one or a few trunk groups.

Station Login
The process of registering as an extension of an Avaya communication server. With Avaya IP Agent, a station login must be completed before an agent login can occur.

Switch
A private call-handling system providing voice-only or voice and data communications services, including access to public and private networks, for a group of terminals within a premises. See also Communication server.

System Tray
The area of the Windows task bar where applications can display an icon for simplified access to special features. Avaya IP Agent displays an icon in the System Tray.

TAPI Assisted Dialing
Avaya IP Agent supports telephony-enabled applications, such as Microsoft Scheduler. This support provides the ability for telephony-enabled Windows applications to originate a call and have the call reflected in the Avaya IP Agent application.

Telecommuter
An Avaya IP Agent configuration where voice communications are performed through a telephone and data communications are sent through the network to a personal computer. In this configuration, calls to an extension can be routed to any telephone number.

Telephone type
Avaya produces many different models of telephone sets with differing capabilities. Each model supported by Avaya IP Agent is considered a telephone type. Telephone types are identified by the unique number associated with each model.

Toll quality
A term used to compare audio quality and reliability of voice communications to that of telephone calls placed over the PSTN.

Toolbar
A row of buttons used to activate various functions of Avaya IP Agent through the main window.

Toolips
Brief descriptions that are displayed when the mouse pointer is over a toolbar button or control in the application interface.

Transfer
See Basic Transfer, Enhanced Transfer, or Unsupervised Transfer.

Unsupervised Transfer
A call transfer option that lets an agent send the present call to another phone number or extension. The agent does not talk to the party receiving the transferred call. See also Basic Transfer and Enhanced Transfer.
### User-to-User Information (UUI)

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>User-to-User Information (UUI)</td>
<td>A unique identifier that is added to an incoming call through an external application, such as Avaya ASAI.</td>
</tr>
<tr>
<td>VDN of Origin Announcement (VOA)</td>
<td>A short announcement that is assigned to a Vector Directory Number (VDN) through Avaya communication server administration. The VOA identifies the origin or purpose of a call for the call center agent who answers the call.</td>
</tr>
<tr>
<td>Vector</td>
<td>On a communication server, a list of steps that processes calls according to a configuration set by the administrator. The steps in a vector can send calls to splits or skills, play announcements and music, disconnect calls, give calls a busy signal, prompt callers for information, or route calls to other destinations.</td>
</tr>
<tr>
<td>Virtual Private Network (VPN)</td>
<td>A group of computers or network devices that can communicate privately and securely over a public IP network through the use of encryption and special protocols.</td>
</tr>
<tr>
<td>VOA</td>
<td>See <a href="#">VDN of Origin Announcement (VOA)</a>.</td>
</tr>
<tr>
<td>Voice-over-Internet Protocol (VoIP)</td>
<td>A technology where speech is converted to a digital signal and transmitted through Internet Protocol packets over the Internet or an intranet.</td>
</tr>
<tr>
<td>VuStats</td>
<td>An Avaya communication server feature that displays contact center activity and information on the display of a telephone set. For Avaya IP Agent, this information can be viewed in the status bar of the main window and the <strong>VuStats Monitor</strong> window.</td>
</tr>
<tr>
<td>Windows Terminal Server / Windows Terminal Services</td>
<td>A Windows-based server that allows client terminals, PCs, and other devices to use an environment and applications supplied by the server. Depending on the type of client, processing and storage can take place on the server or the client.</td>
</tr>
<tr>
<td>Zip Tone</td>
<td>A short dial tone that indicates that an ACD call is being connected to the agent.</td>
</tr>
</tbody>
</table>
Index

A
abbreviated dialing ........................................... 153
ACD Agent settings ........................................... 215
ACW work mode ................................................ 128
agent
  login ................................................................ 119
  non-EAS ............................................................ 119
  login (EAS) ......................................................... 117
  logout ............................................................... 121
toolbar ................................................................. 206
work mode, selecting ........................................... 128
Agent Greetings
  activating ........................................................... 158
  activation criteria .............................................. 159
  ANI settings ...................................................... 236
  creating ............................................................. 157
deleting ............................................................. 160
description .......................................................... 235
  options ............................................................. 223
overview ............................................................ 155
Prompted Digits settings
  recording ............................................................ 157
  selective play by ANI .......................................... 236
  selective play by prompted digits ......................... 238
  selective play by VDN ......................................... 237
settings ............................................................... 235
title, changing .................................................... 235
toolbar ................................................................. 207
VDN settings ....................................................... 237
Agent Information Panel ........................................ 209
Agent menu item .................................................. 201
alternate gatekeepers .......................................... 99
alternate playback device ..................................... 109
alternate user interfaces ...................................... 123
answering a call .................................................. 130
audio
  Audio Control toolbar ........................................ 208
  Audio menu item ............................................... 203
  Audio Monitor dialog box .................................... 241
  Audio Options dialog box .................................... 239
  Audio Tuning Wizard .......................................... 243
requirements ....................................................... 30
server ports ........................................................ 234
settings, iClarity ................................................... 231
audio settings, general .......................................... 239
auto-answer feature ............................................. 130
Auto-In .............................................................. 128
AUX work mode .................................................. 128
Avaya communication server
  alternate gatekeepers ........................................ 99
circuit packs, required ........................................ 64
  configuring for Avaya Telephone-DCP .................... 85
  configuring for Avaya Telephone-IP ....................... 79
  configuring for CallMaster VI .............................. 75
  configuring for IP Telephone ............................... 79
  configuring for Telecommuter and Road Warrior ....... 68
  configuring, overview ....................................... 63
load balancing .................................................... 100
Primary Server Address ....................................... 230
registering with ................................................ 113
validating Feature Access Codes ............................ 66
VuStats, configuration ......................................... 162
Avaya IP Agent
  Emergency Call Handling, configuring .................... 93
  exiting ............................................................ 122
  features .......................................................... 13
  installing ......................................................... 36
  login to non-EAS ............................................... 119
  logout of ........................................................ 121
  reinstalling ...................................................... 49
  removing ........................................................ 50
  running, overview ............................................ 101
  starting .......................................................... 102
  uninstalling ...................................................... 50
Avaya Telephone configuration
  definition ........................................................ 20
Avaya Telephone-DCP
  configuring stations ........................................ 87
  station settings, configuring .............................. 85
Avaya Telephone-IP
  configuration stations ....................................... 79

B
bandwidth setting for VoIP .................................... 239
Basic Transfer .................................................... 137
buttons
  Abbreviated Dial .............................................. 153
  Agent state ...................................................... 206
  Call History .................................................... 206

Issue 1.1 August 2004 281
Conference ............................................. 141, 205
Dial Pad .................................................. 206
Drop ....................................................... 136, 205
Hold ....................................................... 134, 205
Login ...................................................... 117
Logout ..................................................... 121
Phone Directory ........................................ 153, 206
Release .................................................... 135
Search Public Directory ................................ 206
Speed Dial ............................................... 151, 206
Transfer ................................................... 205

C

call
  abbreviated dialing .................................. 153
  answering .............................................. 130
  conferencing
    Basic Conference .................................... 141
    Enhanced Conference ................................ 143
dropping ............................................... 136
  holding ............................................... 134
  recent call list ....................................... 146
  releasing ............................................. 135
  speed dial list ...................................... 151
  transfer
    Basic Transfer ....................................... 137
    Enhanced Transfer ................................... 139
    overview ............................................ 137
    Unsupervised Transfer ............................... 138
  Call Handling options ................................ 216
  Call History options ................................ 217
  Call Information Display options ................. 218
  Call Information Panel .................................. 209
  Call menu item ........................................ 198
  CallMaster VI
    definition ........................................... 19
    ensuring Avaya communication server compatibility 75
    initializing .......................................... 112
    station settings, configuring ...................... 76
toolbar .................................................. 208
  volume settings ....................................... 225
  circuit packs
    descriptions ......................................... 64
    load balancing ....................................... 100
    required ............................................ 64
compatibility
  CallMaster VI ......................................... 75
  Telecommuter and Road Warrior ....................... 68
conference
  Basic mode ............................................ 141
  Enhanced mode ......................................... 143
configuration
  enhanced options ..................................... 91
  Configuration Wizard .................................. 103
  configure
    Avaya communication server, overview ........ 63
    Avaya Telephone-DCP ................................ 87
    CallMaster VI ........................................ 76
    Feature Access Codes ................................ 66
    IP Telephone ......................................... 81
    Road Warrior and Telecommuter .................... 70
CPU requirements ...................................... 30, 55

D

  Database Options ................................... 219
  Dial Number toolbar ................................ 206
  Dialog Reference ..................................... 195
  Drop button .......................................... 136
  Dynamic Data Exchange (DDE)
    Screen Pops ......................................... 179, 186

E

  Edit menu item ........................................ 198
  Emergency Call Handling ............................. 92
    Avaya IP Agent, configuring ...................... 93
  Emergency Call Handling (E911)
    settings ............................................. 232
  Enhanced Conference ................................ 143
  Enhanced Transfer .................................... 139
  Event Logging options ................................ 222
  exiting Avaya IP Agent ................................ 122
  External Number Format options ..................... 221

F

  Feature Access (security) options ................ 226
  Feature Access Codes
    validating on Avaya communication servers .... 66
    feature buttons toolbar ............................ 207
    features, Avaya IP Agent ........................... 13
    File menu item ...................................... 197
    Firewall port settings ............................. 233
    Full-duplex audio .................................. 239

G

  gain (VoIP)
    transmit and receive ................................ 239
  gatekeeper
    Avaya communication server ....................... 99
    load balancing ...................................... 100
General Settings options ............................... 213

H
Half-duplex audio .......................................................... 239
hard disk requirements .................................................. 30, 55
Headset toolbar ............................................................. 208
Help menu item ............................................................ 204
holding a call ................................................................. 134

iClarity
audio settings ............................................................... 231
Emergency Call Handling (E911) settings .................. 232
login tab ................................................................. 229
server address ............................................................ 230
VPN and Firewall .......................................................... 233
iClarity settings ............................................................ 228
installation ................................................................. 36
PC-based ................................................................. 27
prerequisites (PC) .......................................................... 28
prerequisites (Windows Terminal Services) .............. 54
reinstalling ................................................................. 49
silent ................................................................. 43
upgrading CentreVu Agent to Avaya IP Agent R5 .... 49
upgrading from V1 to R5 .............................................. 47
upgrading from V2 to R5 .............................................. 48
upgrading V3, R4 to R5 .................................................. 48
VoIP considerations ...................................................... 33
Windows Terminal Services ............................................. 53
IP Endpoints
Audio Tuning Wizard ..................................................... 243
initializing ................................................................. 103
load balancing ............................................................ 100
IP Telephone
configuring stations ...................................................... 79, 81
definition ................................................................. 19

J
jitter buffer ................................................................. 239

L
Lightweight Directory Access Protocol (LDAP)
see Public Directory ...................................................... 167
load balancing on Avaya communication server .......... 100
login
configuration ............................................................ 228
EAS ................................................................. 117
non-EAS ................................................................. 119

troubleshooting ......................................................... 254
Login button ............................................................... 117
Login Settings ............................................................ 228
logout of agent mode .................................................. 121

M
main window
Agent Information Panel ............................................... 209
alternate interface ...................................................... 123
Call Information Panel ................................................... 209
closing description ..................................................... 122
information panels ...................................................... 209
Phone Display Panel ..................................................... 209
Manual-In work mode ................................................... 128
memory requirements .................................................. 30, 55
menu bar, main ............................................................ 196
menus, main window .................................................. 196
microphone
status ................................................................. 208
volume ................................................................. 208

N
network requirements ................................................... 31
networking requirements ................................................ 55

O
options
audio ................................................................. 239
Avaya IP Agent ........................................................... 212
outgoing calls
abbreviated dialing ..................................................... 153
Phone Directory .......................................................... 150
Public Directory ........................................................... 170
recent calls list ........................................................... 146
speed dial list ............................................................ 151

P
Phone Buttons toolbar ................................................... 205
Phone Directory ............................................................ 147
Phone Display Panel ..................................................... 209
VuStats ................................................................. 163
Phone features toolbar ................................................... 207
Phone Settings dialog box .............................................. 225
port administration ...................................................... 234
station
configuring Avaya Telephone-DCP ...... 85, 87
configuring Avaya Telephone-IP ..... 79
configuring IP Telephone .......... 79, 81
configuring Road Warrior and Telecommuter .... 70
configuring settings for CallMaster VI .... 76
supported telephone types ........ 21
System Tray icon ........ 210

T
Telecommuter
configuring stations ........ 70
definition .......... 18
required server circuit packs .... 64
telephone types, supported .......... 21
Toolbars ........ 204
Agent .......... 206
Agent Greetings .......... 207
Audio Control .......... 208
CallMaster .......... 208
Dial Number .......... 206
Feature buttons .......... 207
Headset .......... 208
moving .......... 205
Phone Buttons .......... 205
Phone features .......... 207
Tools menu item .......... 202
transfer .......... 137
Basic Transfer .......... 137
Enhanced Transfer .......... 139
Unsupervised Transfer .......... 138
troubleshooting ........ 253
alternate causes ........ 267
calls ........ 261
login ........ 254
other ........ 263
registering with server ........ 254
Voice-over-IP (VoIP) ........ 257

V
VDN settings
Agent Greetings .......... 237
View menu item .......... 200
Voice Message Number .......... 224
Voice-over-IP (VoIP)
Audio Monitor .......... 241
Audio Tuning Wizard .......... 243
considerations .......... 33
troubleshooting .......... 257
Volume and Ringer Settings .......... 242
Volume and Ringer Settings .......... 242
VPN
configuring for .......... 95
registering through .......... 115
settings .......... 233
VuStats .......... 161
extension configuration .......... 162
overview .......... 161
refresh .......... 164
time intervals .......... 164
viewing data in main window .......... 163

W
Windows Terminal Services
installation .......... 53
work mode
ACW .......... 128
Auto-In and Manual-In .......... 128
AUX .......... 128
selecting .......... 128
User Interface Options .......... 220
user interfaces, alternate .......... 123